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Thank you for purchasing the Konica Minolta bizhub C300.

The bizhub C300 is equipped with an integrated printer controller that allows 
you to print directly from Windows-compatible computers or Macintosh 
computers.

This User’s Guide describes the printing functions, operations, usage, and 
safety precautions of the printer controller. In order to ensure that this ma-
chine is used efficiently, carefully read this manual before using the machine. 
In order to ensure that this machine is used safely, carefully read “Installation 
and Operation Precautions” in the User’s Guide [Copy Operations] before 
using the machine.

The illustrations used in this User’s Guide may differ from the actual model.

Trademarks and copyright
- KONICA MINOLTA, the KONICA MINOLTA logo, and The essentials of 

imaging are registered trademarks of KONICA MINOLTA HOLDINGS, 
INC.

- PageScope and bizhub are registered trademarks of KONICA MINOLTA 
BUSINESS TECHNOLOGIES.

- Netscape Communications, the Netscape Communications logo, Net-
scape Navigator, Netscape Communicator, and Netscape are trade-
marks of Netscape Communications Corporation.

- Novell and Novell NetWare are registered trademarks of Novell, Inc.
- Microsoft, Windows, and Windows NT are registered trademarks of Mi-

crosoft Corporation.
- IBM is a registered trademark of International Business Machines, Inc.
- Apple, Macintosh, and Mac are registered trademarks of Apple Compu-

ter, Inc.
- Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and the 

PostScript logo are either registered trademarks or trademarks of Adobe 
Systems Incorporated.

- Ethernet is a registered trademark of Xerox Corporation.
- PCL is a registered trademark of Hewlett-Packard Company Limited.
- All other product and brand names are trademarks or registered trade-

marks of their respective companies or organizations.
- This machine and PageScope Box Operator are based in part on the 

work of the Independent JPEG Group.
- Compact-VJE

Copyright 1986-2003 VACS Corp.
- RC4® is a registered trademark or trademark of RSA Security Inc. in the 

United States and/or other countries.
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- RSA® is a registered trademark or trademark of RSA Security Inc. RSA 
BSAFE® is a registered trademark or trademark of RSA Security Inc. in 
the United States and/or other countries.

License information

This product includes RSA BSAFE Cryptographic software 
from RSA Security Inc.

OpenSSL statement

OpenSSL license

Copyright © 1998-2000 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright no-

tice, this list of conditions and the following disclaimer in the documen-
tation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgment:
“This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used 
to endorse or promote products derived from this software without prior 
written permission. For written permission, please contact openssl-
core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor 
may “OpenSSL” appear in their names without prior written permission 
of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following ac-
knowledgment:
“This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCURE-
MENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
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PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@crypt-Soft.com). This product includes software written by Tim Hud-
son (tjh@cryptsoft.com).

Original SSLeay license

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@crypt-
soft.com).
The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the fol-
lowing conditions are aheared to. The following conditions apply to all code 
found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just 
the SSL code.
The SSL documentation included with this distribution is covered by the 
same copyright terms except that the holder is Tim Hudson (tjh@crypt-
soft.com).
Copyright remains Eric Young’s, and as such any Copyright notices in the 
code are not to be removed. If this package is used in a product, Eric Young 
should be given attribution as the author of the parts of the library used. This 
can be in the form of a textual message at program startup or in documen-
tation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list 

of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright no-

tice, this list of conditions and the following disclaimer in the documen-
tation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgement:
“This product includes cryptographic software written by Eric Young 
(eay@crypt-soft.com)”
The word ‘cryptographic’ can be left out if the rouines from the library be-
ing used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from 
the apps directory (application code) you must include an acknowledge-
ment:
“This product includes software written by Tin Hudson (tjh@crypt-
soft.com)”
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THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EX-
PRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AU-
THOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCI-
DENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILI-
TY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

The licence and distribution terms for any publically available version or de-
rivative of this code cannot be changed. i.e. this code cannot simply be cop-
ied and put under another distribution licence [including the GNU Public 
Licence.]

Copyright

© 2006 Konica Minolta Business Technologies, Inc. All Rights Reserved.

Note
- This User’s Guide may not be reproduced in part or in full without permis-

sion.
- Konica Minolta Business Technologies, Inc. will not be held liable for any 

incidents caused by using this printing system or User’s Guide. 
- Information included in this User’s Guide is subject to change without no-

tice.
- Konica Minolta Business Technologies, Inc. maintains the copyright of 

the printer drivers.
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SOFTWARE LICENSE AGREEMENT

This package contains the following materials provided by Konica Minolta 
Business Technologies, Inc. (KMBT): software included as part of the printing 
system, the digitally-encoded machine-readable outline data encoded in the 
special format and in the encrypted form (“Font Programs”), other software 
which runs on a computer system for use in conjunction with the Printing 
Software (“Host Software”), and related explanatory written materials (“Doc-
umentation”). The term “Software” shall be used to describe Printing Soft-
ware, Font Programs and/or Host Software and also include any upgrades, 
modified versions, additions, and copies of the Software.

The Software is being licensed to you under the terms of this Agreement.

KMBT grants to you a non-exclusive sublicense to use the Software and 
Documentation, provided that you agree to the following:
1. You may use the Printing Software and accompanying Font Programs for 

imaging to the licensed output de-vice(s), solely for your own internal 
business purposes.

2. In addition to the license for Font Programs set forth in Section 1 (“Print-
ing Software”) above, you may use Roman Font Programs to reproduce 
weights, styles, and versions of letters, numerals, characters and sym-
bols (“Typefaces”) on the display or monitor for your own internal busi-
ness purposes.

3. You may make one backup copy of the Host Software, provided your 
backup copy is not installed or used on any computer. Notwithstanding 
the above restrictions, you may install the on any number of computers 
solely for use with one or more printing systems running the Printing Soft-
ware.

4. You may assign its rights under this Agreement to an assignee of all of 
Licensee’s right and interest to such Software and Documentation (“As-
signee”) provided you transfer to Assignee all copies of such Software 
and Documentation Assignee agrees to be bound by all of the terms and 
conditions of this Agreement.

5. You agree not to modify, adapt or translate the Software and Documen-
tation.

6. You agree that you will not attempt to alter, disassemble, decrypt, re-
verse engineer or decompile the Software.

7. Title to and ownership of the Software and Documentation and any re-
productions thereof shall remain with KMBT and its licensor.

8. Trademarks shall be used in accordance with accepted trademark prac-
tice, including identification of the trademark owner’s name. Trademarks 
can only be used to identify printed output produced by the Software. 
Such use of any trademark does not give you any rights of ownership in 
that trademark.
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9. You may not rent, lease, sublicense, lend or transfer versions or copies 
of the Software Licensee does not use, or Software contained on any un-
used media, except as part of the permanent transfer of all Software and 
Documentation as described above.

10. IN NO EVENT WILL KMBT OR ITS LICENSOR BE LIABLE TO YOU FOR 
ANY CONSEQUENTIAL, INCIDENTAL INDIRECT, PUNITIVE OR SPE-
CIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVING, 
EVEN IF KMBT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. KMBT OR ITS 
LICENSOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THE 
SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITA-
TION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD 
PARTY RIGHTS. SOME STATES OR JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTIAL, CONSEQUENTIAL 
OR SPECIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT AP-
PLY TO YOU.

11. Notice to Government End Users: The Software is a “commercial item,” 
as that term is defined at 48 C.F.R.2.101, consisting of “commercial com-
puter software” and “commercial computer software documentation,” as 
such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 
12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Govern-
ment End Users acquire the Software with only those rights set forth 
herein.

12. You agree that you will not export the Software in any form in violation of 
any applicable laws and regulations regarding export control of any 
countries.
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About this user’s guide

This User’s Guide contains information for using the printing functions of the 
Konica Minolta printer controller. For details on the copy functions, scanning 
functions, box functions, and fax functions, refer to the respective User’s 
Guide.

This User’s Guide is aimed at users who already have a basic knowledge of 
computer and copier operations. For Windows or Macintosh operating sys-
tem and application operations, refer to the operation manual of the respec-
tive product.

C300 User’s Guides

The User’s Guides for this machine are divided by function and consist of the 
following:

Notations

Screen images in this user’s guide

Unless stated otherwise, the printer driver functions are described using the 
printer driver for Windows XP.

User’s guide Details

Print Operations This User’s Guide. Read this guide when using this ma-
chine as a printer.

Print Operations Quick Guide Read this guide when using this machine as a printer.

Network Scanner Operations Read this guide when using this machine as a scanner.

Box Operations Read this guide when using this machine’s box functions.

Facsimile Operations Please read this guide when using this machine’s fax func-
tions.

Network Facsimile Operations Read this guide when using this machine’s network fax (In-
ternet fax, SIP fax, IP address fax) functions.

Product name

KONICA MINOLTA C300
This machine

This machine, copier, or printer

Integrated network controller Network controller

Printer controller, including this 
machine, and printing system

Printing system

Microsoft Windows Windows
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Using this user’s guide

(The page shown above is an example only.)

Various Printing Methods 4

C300 4-1

4 Various Printing Methods

4.1 Printing Operations

For Windows

Data can be printed from an application.

Print jobs are specified from the application  software.

1 Open the data in the application , “File”, and then cl ick “Pri nt”.

2 Check that the printer name has been selected.

If the printer is not selected, click the [ ] and select the printer.

3 Specify the page range and the number of copies to print.

Note 
The Print dialog box differs d epending on the applicat ion.

Subject titles

Explains the operation 
procedure.

Windows, dialog boxes, 
icons, and function names 
displayed on the screen 
are enclosed in     .

Button names displayed 
on the screen are 
enclosed in     .

Contents displayed on 
a screen.

Additional explanation 
of the text is given.
C300 x-19



Welcome
C300 x-20



Overview 1
1 Overview

1.1 Printer controller

The printer controller is a device for performing printing functions and net-
work printing functions with this machine.

Role of the printer controller

The printer controller is built into the machine.

You can print from applications on the computer connected to the printing 
system. When using this machine as a network printer, you can print from 
applications on the computer.

Available printer controller functions

The printer controller provides the following functions.
- Printing from a computer (using the PCL printer driver or PS printer driver)
- Support of network protocols including TCP/IP, NetBEUI, IPX/SPX, and 

AppleTalk
- Direct printing over a network using SMB (Windows), LPR, and IPP print-

ing
- Access to settings for this machine and the printer controller from a client 

computer over the network (using a Web browser)
- Control of the number of pages printed (“User Authentication” and “Ac-

count Track” functions)
- Fax operations using a computer (fax transmission)

2
Note 

To perform fax operations, optional fax kit FK-502 is required.

Printing system
Machine

Printer
controller

Computer
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Machine modes

The printer driver settings are mainly set using a computer, however, the font 
list can be printed, and the printer controller settings and default print set-
tings can be set using the control panel of this machine. In addition, fax and 
scanning operations can be used by switching the mode.

To switch between modes, press the mode keys on the control panel.

[Copy]

This machine can be used as a copier.

[Scan]

This machine can be used as a scanner.

[Fax]

This machine can be used for faxing.

[Box]

This machine can be used to store jobs and as a document folder for for-
warding data to a computer over the network. 

2
Note 

You can use this machine as a printer in all modes.

Change the default print settings in the Utility mode.

Power Save Box

Access ABC DEF

JKLGHI MNO

TUVPQRS WXYZMode Memory

Mode Check

Utility/Utility/
Counter

Fax Scan Copy Reset

Interrupt

Power

Stop

Proof Copy

Start

Data Main Power

HelpHelp

AccessibilityAccessibility

Enlarge Display

Contrast
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Printing flow

When using this printing system as a printer, the flow of the main process is 
described below.

Print commands transmitted from the application are received by the printer 
driver.

Data is transmitted to this machine over a parallel interface (IEEE 1284) when 
this machine is used as a local printer, over a USB interface when this ma-
chine is used as a USB printer, or over an Ethernet interface (TCP/IP, IPX/
SPX, AppleTalk) when this machine is used as a network printer. The data is 
then delivered from this machine to the printer controller, which performs im-
age rasterization (development of output characters and images to bitmap 
data). Finally, this data is printed from this machine.

2
Note 

The parallel and USB interfaces cannot be used simultaneously.

Original documents can be scanned in the copy function or network scan 
function while this machine is operating as a printer.
To use this machine as a copier, press the [Copy] key on the control panel.

Computer

Used as a local 
printer

Used as a USB 
printer

Application Application Application

Used as a 
network printer

Printer driver Printer driver Printer driver

Parallel interface 
(IEEE 1284) USB Ethernet (TCP/IP, IPX/

SPX, or AppleTalk)

Machine

Print

Printer controller

PS/PCL processing (rasterizing)
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When a print job is received during copying, the data is stored in the memory 
of this machine. When copying is complete, the print job is automatically 
printed.

Flow of the computer faxing operation

Conventionally, faxes are sent by loading an original into a fax machine and 
sending it.

With computer faxing, you can send a fax directly from your computer with-
out using any paper.

Transmission commands sent from the application are received by the print-
er driver.

Data is transmitted to this machine over a parallel interface (IEEE 1284) when 
this machine is used as a local printer, over a USB interface when this ma-
chine is used as a USB printer, or over an Ethernet interface (TCP/IP, IPX/
SPX, AppleTalk) when this machine is used as a network printer. The data is 
then delivered from this machine to the printer controller, which performs im-
age rasterization (development of output characters and images to bitmap 
data). Finally, this data is stored in the memory of this machine and transmit-
ted like a conventional fax job.

Used as a local 
printer

Used as a USB 
printer

Application Application Application

Used as a 
network printer

Printer driver Printer driver Printer driver

Parallel interface 
(IEEE 1284) USB Ethernet (TCP/IP, IPX/

SPX, or AppleTalk)

Machine

Print

Printer controller

PS/PCL processing (rasterizing)

Computer
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1.2 Operation environment

The system requirements for using this printing system and the interfaces 
used for connection are explained below.

Compatible computers and operating systems

Check that the computer being connected meets the following conditions.

Windows

Macintosh

Item Operating environment

Operating System Windows 98 Second Edition, Windows Me, Windows NT 4.0 
(Service Pack 6a or later), Windows 2000 Professional (Serv-
ice Pack 4 or later), Windows XP Home Edition/Windows XP 
Professional (Service Pack 2 or later), or Windows Server 2003

Processor Pentium or higher

Memory Capacity recommended for the operating system
With sufficient memory resources in the operating system and 
application being used

Drive CD-ROM

Web Browser (when using Pag-
eScope Web Connection)

Microsoft Internet Explorer 6 or later recommended (JavaS-
cript enabled, Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when us-
ing Internet Explorer 5.5.
Netscape Navigator 7.02 or later (JavaScript enabled, Cook-
ies enabled)
Macromedia® Flash® (If “Flash” is selected in View Mode, ver-
sion 7.0 or later plugin is required.)

Item Operating environment

Operating System Mac OS 9.2, Mac OS X 10.2, Mac OS X 10.3, or Mac OS X 
10.4

Processor PowerPC, Intel Processor

Memory Capacity recommended for the operating system

Drive CD-ROM

Web Browser (when using Pag-
eScope Web Connection)

Netscape Navigator 7.02 or later (JavaScript enabled, Cook-
ies enabled)
Macromedia® Flash® (If “Flash” is selected in View Mode, ver-
sion 7.0 or later plugin is required.)
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Compatible interfaces

The various interfaces that can be used to connect this printing system to a 
computer are described below.

Ethernet interface

Connect when using this printing system as a network printer.

Supports 10Base-T and 100Base-TX standards. In addition, the Ethernet in-
terface supports the TCP/IP (LDP/LPR, peer-to-peer), IPX/SPX (NetWare), 
and AppleTalk (EtherTalk).

Parallel interface (optional)

Connect when using this printing system as a local printer.

A computer running Windows and an IEEE 1284 parallel cable are required 
for connection. Use a parallel cable that uses a terminal with an Amphenol 
36-pin male connector.

The parallel interface supports the compatible, nibble, and ECP modes.

USB interface (optional)

Connect when using this printing system as a network printer.

The USB interface can be connected to a computer running Windows. A 
USB cable is required for connection. Use a type A (4 pin, male) or type B (4 
pin, male) USB cable. A USB cable measuring 3 meters or less is recom-
mended.

The parallel and USB interfaces cannot be used simultaneously. You can 
switch the interfaces in the administrator mode.
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Connection diagram

The printer cables can be connected to each port at the back of this ma-
chine.

Machine (rear view)

USB 

Parallel Ethernet 
(10Base-T or 
100Base-TX)

Parallel 
cable port

cable
USB port
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1.3 Setting up the system

In order to use this printing system, it must first be set up.

Setup consists of connecting this machine to a computer and installing the 
printer driver onto the computer being used.

To set up the printing system

Setup of the printing system as described below.

1 Connect this machine to a computer. (Refer to “Compatible interfaces” 
on page 1-6.)

2 Install the printer driver. (Refer to “Installing the printer driver” on 
page 2-1.)

3 When using a network connection, set up the network. (Refer to “Set-
ting up network printing” on page 3-1.)

4 Check the setup by printing a test page. (Refer to “Test printing” on 
page 4-2.)

5 Install the screen fonts.

– The User Software CD-ROM and the PostScript Printer Driver CD-
ROM contain the Latin TrueType fonts as screen fonts.

– Install the screen fonts after adding the operating system standard 
fonts.

– For details, refer to Help of the operating system.
– The CD-ROM “Screenfont” or “Screenfonts” folder contains the 

screen fonts.
– The Macintosh fonts are compressed. Install the fonts after decom-

pressing them.

Installation of the printer driver may differ depending on the connection 
method used with this machine in addition to the operating system of the 
computer and the type of printer driver being used.

!
Detail 

For details on connecting this machine to a computer, refer to “Compat-
ible interfaces” on page 1-6.
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2
Note 

To update an existing printer driver, delete the existing printer driver first. 
For details, refer to “Uninstalling the printer driver” on page 2-14 and 
page 2-23.

As necessary, set the interface timeout settings and parallel interface 
mode (Compatible, Nibble, or ECP) in the Utility mode on the control pan-
el. For details, refer to “Printer settings in Administrator mode” on 
page 10-23.

When using the parallel or USB local port, you must select the port being 
used. For details, refer to “IEEE 1284/USB” on page 10-30.
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2 Installing the printer driver

2.1 Printer drivers and supported operating systems

In order to use this printing system, the printer driver must be installed. The 
printer driver is a program that controls the processing of data for output. In-
stall the printer driver onto the computer from the provided CD-ROM.

The printer drivers included on the CD and the supported computer operat-
ing systems are listed below. Install the required printer driver.

* The User Software CD-ROM contains the PCL printer driver, and the PostScript Printer Driver 
CD-ROM contain the PostScript driver.

Printer driver Page description 

language

Supported operating systems

Konica Minolta PCL 
Driver 

PCL
(PCL XL)

Windows 98 Second Edition, Windows Me, 
Windows NT 4.0 (Service Pack 6a), 
Windows 2000 Professional (Service Pack 4 or 
later), Windows XP Home Edition/Professional 
(Service Pack 2 or later), and Windows Server 
2003

Konica Minolta 
PostScript Driver

PostScript 3
Emulation

Windows NT 4.0 (Service Pack 6a), 
Windows 2000 Professional (Service Pack 4 or 
later), Windows XP Home Edition/Professional 
(Service Pack 2 or later), Windows XP Profes-
sional x64, Windows Server 2003, and Win-
dows Server 2003 x64

PostScript PPD Driver Windows 98 Second Edition, Windows Me

Mac OS 9.2 or later, Mac OS X 10.2, Mac OS X 
10.3, and Mac OS X 10.4
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2.2 When used with Windows

The installation procedure for the Windows printer driver differs depending 
on how this machine is connected to the computer and depending on which 
printer driver is used. The installation method also differs depending on the 
version of Windows that you are using. Refer to the table below for the ap-
propriate procedure for installing the printer driver on your computer.

2
Note 

For details on installing the printer driver in a network environment, refer 
to “Setting up network printing” on page 3-1. Because it is necessary to 
specify other network settings in advance when installing the printer driv-
er using a network connection, install it using a local connection at this 
time.

To install the printer driver under Windows XP, Windows Server 2003, 
Windows 2000, or Windows NT 4.0, log on using a user name that is au-
thorized by the administrator.

To connect this machine to a computer using a parallel connection or a 
USB connection, the optional local interface kit is required.

Printer driver Connection method Refer to

Konica Minolta 
PCL Driver
Konica Minolta 
PostScript 
Driver

All connection methods “Automatic installation using the installer” on 
page 2-3

Konica Minolta 
PCL Driver
Konica Minolta 
PostScript 
Driver
PostScript PPD 
Driver

Network connection “Installing the printer driver using the Add Printer 
Wizard” on page 2-6
“For Windows 98SE/Me/2000/NT 4.0” on 
page 2-9
“For Windows XP/Server 2003” on page 2-6

Parallel connection “Installing the printer driver using Plug and Play” 
on page 2-11
“For Windows 98SE” on page 2-11
“For Windows Me/2000” on page 2-12
“For Windows XP/Server 2003” on page 2-13

“Installing the printer driver using the Add Printer 
Wizard” on page 2-6
“For Windows 98SE/Me/2000/NT 4.0” on 
page 2-9
“For Windows XP/Server 2003” on page 2-6

USB connection “Installing the printer driver using Plug and Play” 
on page 2-11
“For Windows 98SE” on page 2-11
“For Windows Me/2000” on page 2-12
“For Windows XP/Server 2003” on page 2-13
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Automatic installation using the installer

With the installer, this machine is detected to determine whether it is con-
nected by USB or is on the same TCP/IP network as the computer, and then 
the required printer driver is automatically installed. You can also manually 
specify the printer driver to be installed.

2
Note 

Since this machine is automatically detected with a network connection, 
be sure to set the IP address of this machine before connecting it. For de-
tails on specifying the settings, refer to “Setting the IP address for this 
machine” on page 3-5.

When installing on Windows NT 4.0, 2000, XP, or Server 2003, adminis-
trator permissions are required.

If the wizard starts up in order to add new hardware with a USB or parallel 
connection, click [Cancel].

For IPP printing, it is not necessary to install the printer driver at this time 
since IPP printing setup is performed when the printer driver is installed. 
For further details on IPP printing, refer to “IPP printing (Windows 2000/
XP/Server 2003)” on page 3-16.

Installer operating environment

* With Windows NT 4.0, in order to install a machine that is connected directly to a network using 
the TCP/IP protocol, Windows TCP/IP Printing Services must first be installed on the computer 
being used.

Item Operating environment

Operating System Windows 98 Second Edition, Windows Me, Windows NT 4.0 (Serv-
ice Pack 6a or later)*, Windows 2000 Professional (Service Pack 4 or 
later), Windows XP Home Edition/Windows XP Professional (Service 
Pack 2 or later), or Windows Server 2003

Processor Pentium 300 MHz or higher recommended

Memory 64 MB or more (128 MB or more recommended)
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To install the printer driver

1 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– For the User Software CD-ROM (for a PCL driver), check that the 
installer starts up, and then continue with step 2.

– For the PostScript Printer Driver CD-ROM (Win) (for a PS driver), 
double-click “UserInst.exe” in the Driver folder on the CD-ROM, 
and then continue with step 3.

2 Click “Printer Install”.

The installation of the printer driver starts.

3 Click the [AGREE] button if you agree with all terms and conditions of 
the license agreement.

– If you do not agree with the terms and conditions of the license 
agreement, the software cannot be installed.

– You can change the display language of the installer box in the low-
er-left corner.

4 When the setup selection dialog box appears, click the “Install printers/
MFPs” button, and then click the [Next] button.

The connected printers and copiers are detected.
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5 Select this machine and proceed with the installation.
Follow the on-screen instructions to complete the installation.

– If the connection of this machine cannot be recognized or for par-
allel connections, the machine will not be listed. When this occurs, 
select “Specify the Printer/MFP Except for the Above. (IP Address, 
Host Name)”, and then specify this machine directly.
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Installing the printer driver using the Add Printer Wizard

2
Note 

For IPP printing, it is not necessary to install the printer driver at this time 
since IPP printing setup is performed when the printer driver is installed.

For further details on IPP printing, refer to “IPP printing (Windows 2000/
XP/Server 2003)” on page 3-16.

2
Note 

For details on installing the printer driver in a network environment, refer 
to “Setting up network printing” on page 3-1. Because it is necessary to 
specify other network settings in advance when installing the printer driv-
er using a network connection, install it using a local connection at this 
time.

For Windows XP/Server 2003

1 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

2 Click the [Start] button, and then click “Printers and Faxes”. 

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.
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3 For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

– For Windows Server 2003, double-click the “Add Printer” icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 Select “Local printer attached to this computer”, and then click the 
[Next] button.

– Clear the “Automatically detect and install my Plug and Play print-
er” check box.

6 The Select Printer Port dialog box appears. Select “LPT1” here, and 
then click the [Next] button.

Windows XP Windows Server 2003
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7 Click the [Have Disk] button.

8 Click the [Browse] button.

9 Specify the folder on the CD-ROM that contains the printer driver for 
the operating system that you are using, and then click the [OK] button.

– Konica Minolta PCL Driver: User Software CD-ROM
“Driver\bizhubC352” folder

– Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM “Driver\bizhubC352” folder

10 Click the [OK] button.

– The “Printers” list appears.

11 Click the [Next] button.

12 Follow the on-screen instructions.

– When the Digital Signature message appears, click the [Continue] 
button.

– When using a network connection, perform a test print after the net-
work settings have been specified.

13 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers and Faxes window.

14 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
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For Windows 98SE/Me/2000/NT 4.0

1 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

2 Click the [Start] button, point to “Settings”, and then click “Printers”. 

The Printers window appears.

3 Double-click the “Add Printer” icon.

The Add Printer Wizard starts up.

4 Follow the on-screen instructions.

5 On the screen for selecting the printer connection, select “Local Print-
er”.

6 Click the [Next] button.

7 Click the [Have Disk] button.

8 Click the [Browse] button.
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9 Specify the directory on the CD-ROM that contains the printer driver for 
the operating system that you are using, and then click the [OK] button.

– For Windows 98SE/Me
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
PostScript PPD driver: PostScript Printer Driver CD-ROM 
“Driver\PS-PPD” folder

– For Windows 2000
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM “Driver\bizhubC352” folder

– For Windows NT 4.0
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM “Driver\bizhubC352” folder

10 Click the [OK] button.

The “Printers” list appears.

11 Click the [Next] button.

12 Specify the connection port. Select “LPT1” here.

13 Follow the on-screen instructions.

– When using a network connection, perform a test print after the net-
work settings have been specified.
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14 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers window.

15 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

Installing the printer driver using Plug and Play

For Windows 98SE

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn on the computer.

– Do not disconnect or connect the cable while the computer is start-
ing up.

2 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

3 Turn the main power of this machine on.

The Add New Hardware Wizard starts up.

4 Click the [Next] button.

5 Select “Search for the best driver for your device (Recommended)”, 
and then click the [Next] button.

6 Select “Specify a location”, and then click the [Browse] button.

7 Specify the folder on the CD-ROM that contains the printer driver for 
the operating system that you are using, and then click the [OK] button.

– Konica Minolta PCL Driver: User Software CD-ROM 
“Driver\bizhubC352” folder

– PostScript PPD driver: PostScript Printer Driver CD-ROM 
“Driver\PS-PPD” folder

8 Click the [Next] button, and then follow the on-screen instructions.
If using a parallel connection, proceed to step 10.

9 The Add New Hardware Wizard dialog box appears again. Repeat 
steps 4 through 8.
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10 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers window.

11 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

For Windows Me/2000

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn on the computer.

– Do not disconnect or connect the cable while the computer is start-
ing up.

2 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

3 Turn the main power of this machine on.

– For Windows Me 
The Add New Hardware Wizard starts up.

– For Windows 2000 
The Found New Hardware Wizard starts up.

4 Select “Search for a suitable driver for my device (recommended)” (for 
Windows Me, select “Automatic search for a better driver (Recom-
mended)”), and then click the [Next] button.

5 For Windows 2000, select “Specify a location”, and then click the 
[Next] button.
For Windows Me, select “Specify a Location”, and then click the 
[Browse] button.

6 Specify the folder on the CD-ROM that contains the printer driver for 
the operating system that you are using, and then click the [OK] button.
Printer drivers that can be selected:

– For Windows Me
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
Postscript PPD: PostScript Printer Driver CD-ROM 
“Driver\PS-PPD” folder
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– For Windows 2000
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM 
“Driver\bizhubC352” folder

7 Click the [OK] button (for Windows Me, click the [Next] button), and 
then follow the on-screen instructions.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers window.

10 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

For Windows XP/Server 2003

1 After using a parallel cable or a USB cable to connect this machine to 
a computer, turn on the computer.

– Do not disconnect or connect the cable while the computer is start-
ing up.

2 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

3 Turn the main power of this machine on.

The Found New Hardware Wizard starts up.
If the Add New Hardware Wizard does not appear, turn the power of 
this machine off, then on again.
When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait at 
least 10 seconds before turning the power on again; otherwise, this 
machine may not function properly.

4 Select “Install from a list or specific location (Advanced)”, and then 
click the [Next] button.

5 Under “Search for the best driver in these locations”, select “Include 
this location in the search”, and then click the [Browse] button.
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6 Depending on the operating system and printer driver that you are us-
ing, specify the folder on the CD-ROM that contains the printer driver, 
and then click the [OK] button.

– Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder

– Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM “Driver\bizhubC352” folder

7 Click the [Next] button, and then follow the on-screen instructions.

– When the Digital Signature dialog box appears, click the [Continue] 
button.

8 Click the [Finish] button.

9 When installation is complete, make sure that the icon of the installed 
printer appears in the Printers and Faxes window.

10 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

Uninstalling the printer driver

If it becomes necessary to delete the printer driver, for example, when you 
want to reinstall the printer driver, follow the procedure below to delete the 
driver.

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to 
“Settings”, and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 In the Printers window (for Windows XP/Server 2003, Printers and Fax-
es window), select the icon of the printer that you want to delete.

3 Press the [Delete] key on the computer keyboard to delete the printer 
driver.
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4 Follow the on-screen instructions.

When the printer driver has been deleted, the printer icon will disappear 
from the Printers window (for Windows XP/Server 2003, Printers and 
Faxes window).
For Windows 98 Second Edition/Me/NT 4.0, this completes the unin-
stallation procedure.
For Windows 2000/XP/Sever 2003, delete the driver from the server 
properties.

5 Click the “File” menu, and then click “Server Properties”.

6 Click the Driver tab.

7 Select the printer driver to be deleted from the Installed Printer Drivers 
list, and then click [Delete].

8 On the Deletion Confirmation dialog box, click the [Yes] button.

9 Close the Print Server Properties dialog box and Printers window (for 
Windows XP/Server 2003, “Printers and Faxes” window).

10 Restart the computer.

This completes the uninstallation procedure.

2
Note 

Even if the printer driver is deleted using the method described above, 
the model information file will remain in the computer. Therefore, the driv-
er may not be able to be overwritten when reinstalling the same version 
of the printer driver. When installing the same version of the printer driver, 
be sure to also delete the files described below.

Check the “C:\WINDOWS\system32\spool\drivers\w32x86” folder and 
delete the folder of the corresponding model if it is available. If the Konica 
Minolta PCL driver and Konica Minolta PostScript driver are both in-
stalled, the model information of both drivers is deleted. If one driver is 
remaining, do not delete it.

Delete the “oem*.inf” and “oem*.PNF” files in the “C:\WINDOWS\inf” 
folder. (The asterisk (*) in the file name displays a number, and the 
number varies according to the environment of the computer.) Before de-
leting the files, open the INF file, check that the model name is described 
in the last several lines, and then check that the file of the corresponding 
model is available.

The PNF file is the same number as the INF file.
C300 2-15



Installing the printer driver 2
2.3 When used with Macintosh

The installation procedure for the Macintosh printer driver differs depending 
on the Mac OS version and printer driver being used. Refer to the table below 
for the appropriate procedure for installing the printer driver on your Macin-
tosh computer.

Installing the printer driver

For Mac OS X

1 Turn the Macintosh computer on.

2 Insert the Macintosh printer driver CD-ROM into the Macintosh com-
puter’s CD-ROM drive.

– Quit all running applications that may have started when the Mac-
intosh computer was turned on.

3 Open the “OS10_2_X” or “OS10_3_X” folder from “English”—“Driver” 
on the CD-ROM.

4 Select the Mac OS version being used, and then copy the drive file onto 
the desktop.
Mac OS X 10.2: KONICAMINOLTA_C352_102.pkg
Mac OS X 10.3: KONICAMINOLTA_C352_103.pkg
Mac OS X 10.4: KONICAMINOLTA_C352_103.pkg

5 Double-click the file copied onto the desktop.

– Enter the requested administrator’s name and password.
– For the administrator’s name and password, ask your network ad-

ministrator.
– To quit the installation, click the [Cancel] button.

6 Click the [Continue] button and follow the on-screen instructions until 
the Installation dialog box appears.

Mac OS Printer driver Refer to

Mac OS X 10.2, 
Mac OS X 10.3, and 
Mac OS X 10.4

PostScript PPD “Installing the printer driver” on page 2-16

Mac OS 9.2 or later PostScript PPD “Selecting a printer” on page 2-18
C300 2-16



Installing the printer driver 2
7 On the Installation dialog box, click the [Install] button.

– From the second time the printer driver is installed and thereafter, 
the [Install] button may appear as the [Upgrade] button.

The printer driver is installed onto the Macintosh computer. When in-
stallation is complete, a message appears.

8 Click the [Close] button.

This completes the printer driver installation.
Next, select the printer.
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Selecting a printer

2
Note 

If connecting using AppleTalk, the AppleTalk settings on this machine 
must be specified. For specifying the AppleTalk settings, refer to “Print-
ing with Macintosh” on page 3-29.

If connecting using Bonjour with Mac OS X 10.4, the Bonjour settings 
must be specified on this machine. For specifying the Bonjour settings, 
refer to “Printing with Macintosh” on page 3-29.

If connecting using Rendezvous with Mac OS X 10.3, the Bonjour set-
tings must be specified on this machine. For specifying the Bonjour set-
tings, refer to “Printing with Macintosh” on page 3-29.

For Mac OS X

After connecting this machine to a Macintosh computer, it can be used as a 
printer by selecting it in Print Center or the Printer Setup Utility as the printer 
to be used.

1 Open Print Center or Printer Setup Utility, located in “Applications”—
“Utilities” of “Hard Disk”.

2 When the Add Printer dialog box appears, click the [Add] button. When 
the printer list appears, click the [Add] button.

– For Mac OS X 10.4, proceed to step 3.
– For Mac OS X 10.2 and Mac OS X 10.3, proceed to step 4.
– If usable printers have already been set up, the Add Printer dialog 

box does not appear.

3 If this machine appears as a printer of a Bonjour connection, select 
“KONICA MINOLTA” from the “Print Using” drop-down list, select 
“KONICA MINOLTA C352/C300 PS(P)” in the model list, and then click 
the [Add] button.

– If the selected printer is registered in the printer list, this completes 
the setting procedure.
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– When connecting with AppleTalk and this machine does not appear 
as a printer, click the [More Printers] button, and then proceed to 
step 4.

4 Select the applicable connection method and printer name.

– To specify an AppleTalk zone for an AppleTalk connection, select 
“Local AppleTalk Zone”.

– When “IPP” is selected as the protocol in IP Printer, the text box for 
entering the queue name appears. 
For Mac OS 10.3, leave the queue name text box empty. 
For Mac OS 10.4, enter “ipp” in the queue name text box.

5 Select “KONICA MINOLTA” from the “Printer Model” drop-down list.
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6 Select “KONICA MINOLTA C352/C300 PS(P)”, and then click the [Add] 
button.

– The selected printer is registered in the printer list.
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For Mac OS 9.2

After connecting this machine, it can be used as a printer by selecting “Post-
Script printer” under “Chooser” and by specifying the printer description 
(PPD) file.

First, copy the printer description (PPD) file onto the Macintosh computer.

1 Insert the Macintosh printer driver CD-ROM into the Macintosh com-
puter’s CD-ROM drive.

2 Open the “OS 9_x” folder in “English”—“Driver” on the CD-ROM.

3 Select PPD file “KONICAMINOLTAC352UVxxx.ppd”, and then copy it 
into the “Printer Descriptions” folder in “System Folder”—“Extensions” 
of “Hard Disk”.

– Next, select a printer.
The printer driver can use a standard Macintosh LaserWriter.

4 On the Apple menu, click “Chooser”.

5 Make sure that “AppleTalk” is set to “Active”, and then click the “La-
serWriter” icon.

6 From the “Select a PostScript Printer” list, click the applicable printer 
for the printing system, and then click the [Create] button.

– If a different PPD file has already been selected, click the [Setup] 
button, and then click the [Select PPD] button from the screen that 
is already displayed.

The PostScript printer description (PPD) file selection screen appears.
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7 Select the applicable PPD file, and then click the [Select] button or the 
[Open] button.

The setting screen for adding Options appears.

8 Select the option that is installed on this machine from Options In-
stalled 1 and Options Installed 2.

9 Click the [OK] button.

The Chooser window appears again.

10 Close the Chooser window.
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Uninstalling the printer driver

If it becomes necessary to delete the printer driver, for example, when you 
want to reinstall the printer driver, follow the procedure below to delete the 
driver.

2
Note 

Quit all running applications that may have started when the Macintosh 
computer was turned on.

For Mac OS X

1 Open Print Center or Printer Setup Utility, located in “Applications”—
“Utilities” of “Hard Disk”.

2 Select the name of the printer to be deleted, and then click the [Delete] 
button.

The selected printer is deleted.

3 Close the printer list.

4 Drag the following file, which is located in “Library”—“Printers”—
“PPDs”—“Contents”—“Resources”—“en.lproj” of “Hard Disk”, to the 
“Trash” icon.

– “KONICA MINOLTA C352.gz”

5 Delete the unnecessary files from “Library”—“Printers”.

6 For Mac OS 10.3 and Mac OS 10.4, drag the “***c352” file, which is lo-
cated in “Library”—“Printers”—“KONICAMINOLTA”—“filter”, and the 
following files, which are located in “Library”—“Printers”—“KONI-
CAMINOLTA”—“PDEs”, to the “Trash” icon.

– KONICAMINOLTAC352 Finishing.plugin
– KONICAMINOLTAC352 ImageLayout.plugin
– KONICAMINOLTAC352 Security.plugin
– KONICAMINOLTAC352 Setup.plugin

7 For Mac OS 10.2, drag the following files, which are located in “Li-
brary”—“Printers”—“PPD Plugins”, to the “Trash” icon.

– KONICAMINOLTAC352 Finishing.plugin
– KONICAMINOLTAC352 ImageLayout.plugin
– KONICAMINOLTAC352 Security.plugin
– KONICAMINOLTAC352 Setup.plugin
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Enter “/usr” in “Go”-“Go to Folder” to move to the “/usr” folder, and 
then drag the “pstokm352” folder, which is located in “libexec”-
“cups”-“filter”, to the “Trash” icon.

8 Restart the Macintosh computer.

This completes the uninstallation procedure.

For Mac OS 9.2

1 Drag PPD file “KONICAMINOLTAC352UVxxx.ppd”, which is located in 
“System Folder”—“Extensions”—“Printer Descriptions” of “Hard 
Disk”, to the “Trash” icon.

The related printer driver files are deleted.

2 Restart the Macintosh computer.

This completes the uninstallation procedure.
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3 Setting up network printing

3.1 Overview of network functions

Network functions

By connecting this machine to a network through the Ethernet port, this 
printing system can be used as a network printer.

This printing system supports 10Base-T and 100Base-TX standards. In ad-
dition, the Ethernet interface supports the TCP/IP (LDP/LPR, IPP, SMB), Net-
BEUI (SMB), IPX/SPX (NetWare), and AppleTalk (EtherTalk) protocols.

2
Note 

When setting up the network, the administrator password is required to 
enter Administrator mode.

Ask the administrator of this machine for the administrator password.

Printing system
This machine Ethernet

Network

Hub
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Features of the network functions

This printing system is equipped with the following network functions to flex-
ibly support various network environments.
- Automatic selection of 10Base-T or 100Base-TX (Fast Ethernet)
- Obtains the IP address automatically from DHCP or BOOTP
- Printing with SMB printing (Windows 98SE/Me/2000/XP/Server 2003)

You can print in Windows 98SE, Windows Me, Windows 2000, Windows 
XP, or Windows Server 2003 using SMB.

- Printing with LPR printing (Windows NT 4.0/2000/XP/Server 2003)
You can print with LPD/LPR using Windows NT 4.0, Windows 2000, Win-
dows XP, or Windows Server 2003. Windows 98SE and Windows Me 
cannot be used. 
LPR (Line Printer Request): This print request system can be used under 
Windows NT 4.0, Windows 2000, Windows XP, or Windows Server 2003. 
Enter the queue name as [Print].

- Printing with Port 9100 (Windows 98SE/Me/2000/XP/Server 2003)
You can print (Raw print) using Port 9100 under Windows 98 Second Edi-
tion, Windows Me, Windows 2000, Windows XP, or Windows Server 
2003. 
When using a Port 9100 connection under Windows 98 Second Edition 
or Windows Me, it may be necessary to install the Peer to Peer Printing 
Tool.
To obtain the Peer to Peer Printing Tool, consult the dealer where you 
purchased this machine.

- Supports Novell NetWare Pserver and Rprinter (Nprinter)
- Supports the Novell NetWare print server functions and supports both 

bindery mode and Novell Directory Service (NDS)

With NetWare

The Novell NetWare 4.x—6 print server functions are supported.

You can connect this printing system to a network using Novell NetWare 
4.x—6 as the network operating system and send print jobs from the client 
to the print server (network controller). The three modes supported are as fol-
lows:
- Nprinter
- Pserver
- NDS/NDPS

2
Note 

For details on the NetWare functions, refer to the NetWare operation 
manual.
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With Macintosh

You can print from your Macintosh computer using LPR, AppleTalk, or Bon-
jour/Rendezvous.

You can connect this printing system to a print server in an AppleTalk or a 
Bonjour/Rendezvous environment and send print jobs from the Macintosh 
computer to this machine.

Network connection methods that can be selected in each Windows op-

erating system

This chapter describes the settings that must be specified for network print-
ing.

Setting procedures differ depending on the method of networking printing 
used (SMB, LPR, or IPP printing). Select the best method of network printing 
for your Windows environment.

Network printing from a Windows operating system

* When using Port 9100 printing under Windows 98 Second Edition or Windows Me, the Peer to 
Peer Printing Tool must be installed. For the details, refer to the table below.

Conditions when the Peer to Peer Printing Tool must be installed while using 
Port 9100

Proto-

col used

Win-

dows 98 

Second 

Edition

Win-

dows 

Me

Win-

dows 

2000

Win-

dows XP

Win-

dows NT 

4.0

Win-

dows 

Server 

2003

SMB Print-
ing

TCP/IP, 
NetBEUI

o o o o o

LPR Printing TCP/IP o o o o

IPP Printing TCP/IP o o o

Port 9100 
Printing

TCP/IP +* +* o o o

Operating System

Windows 98SE/Me Windows 2000/XP/2003

Driver type Using installer Not using 
installer

Using installer Not using 
installer

Konica Minolta PCL Not required*1 Required Not required*4

Konica Minolta 
PostScript

- *2

PostScript PPD - *3 Required - *2
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*1 If the printer driver is installed using the installer while this machine is con-
nected to the network, the required Peer to Peer Printing Tool is also installed 
automatically, and Port 9100 is created.
*2 The printer driver is not compatible with the operating system.
*3 Installing the printer driver using the installer is not applicable.
*4 Not required since standard operating system functions are used.

To obtain the Peer to Peer Printing Tool, consult the dealer where you pur-
chased this machine.

To specify the driver settings when installing the Peer to Peer Printing Tool, 
refer to “Port 9100 Printing (Windows 98SE/Me/2000/XP/Server 2003)” on 
page 3-13.

When using SMB printing, you can perform network printing without install-
ing the Peer to Peer Printing Tool software. For details, refer to “SMB print-
ing” on page 3-8.

2
Reminder 

Before setting up network printing, install the printer driver. For details on 
installing the printer driver, refer to “Installing the printer driver” on 
page 2-1.

To perform network printing, change the printer port for the installed 
printer driver to one for a network connection, and then change the set-
tings on this machine as necessary. For an IPP connection, it is neces-
sary to install the printer driver first.

Network printing in a NetWare environment

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery Pserver/Nprinter

NetWare 5.x/6 IPX NDS Pserver

TCP/IP NDPS(lpr)
C300 3-4



Setting up network printing 3
3.2 Setting the IP address for this machine

Use this machine’s control panel to assign an IP address to this machine.

2
Reminder 

When specifying network settings, follow the instructions of the network 
administrator.

Setting the IP address

1 Press the [Utility/Counter] key on this machine’s control panel, touch 
[Administrator Setting], and then enter the administrator password.

– The administrator password is required in order to enter Adminis-
trator mode. Ask the administrator of this machine for the adminis-
trator password.

2 Touch [Network Setting], then [TCP/IP Setting].

3 Touch [ON].

The next screen appears.
If the next screen does not appear automatically, touch [Fwd.].

4 Specify “Manual Input” under “IP Address Setting Method”.
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5 Specify settings for the following:

IP Address: Set the IP address of this machine.
Subnet Mask: Set the subnet mask for the network to which you are 
connecting.
Default Gateway: Set the default gateway address for the network to 
which you are connecting.

6 Touch [OK].

7 To apply the settings, restart this machine (turn it off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

Turn this machine back on to apply the IP address.

!
Detail 

Although a fixed IP address is entered without using the DHCP server in 
the procedure described here, it is also possible to automatically assign 
the IP address from the DHCP server. When “IP Address Setting Method” 
is specified as “Auto Input” and “DHCP Setting” is set to “ON” on the set-
ting screen that is displayed, the IP address, subnet mask, and gateway 
address settings are automatically assigned from the DHCP server on the 
network, so it is not necessary to assign them manually. However, note 
the following when setting “DHCP Setting” to “ON”. 

Check with the network administrator that the DHCP server exists. If the 
DHCP server does not exist, be sure to specify settings for “IP Address”, 
“Subnet Mask”, and “Default Gateway”.

If the settings for the IP address and other items have been assigned us-
ing the DHCP server, there is a possibility that they may be automatically 
changed. When the settings for the IP address and other items are 
changed, if the IP address has been used to specify a printer on the net-
work for printing, there is a possibility that printing may not be possible 
because this machine cannot communicate with the network. If “DHCP 
Setting” has been set to “ON”, it is recommended that the IP address as-
signed to this machine be fixed in the DHCP server settings.
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3.3 Accessing PageScope Web Connection

Setting the IP address for this machine enables you to access PageScope 
Web Connection.

Use your Web browser to directly access PageScope Web Connection.

To access PageScope Web Connection

1 Start up the Web browser.

2 In the “Address” bar, enter the IP address for this machine as shown 
below, and then press the [Enter] key.

– http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

The initial page of PageScope Web Connection appears.

For further details on PageScope Web Connection, refer to “Using Page-
Scope Web Connection” on page 10-32.

2
Note 

If the user authentication function is enabled, you must enter a user name 
and password.
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3.4 SMB printing

You can use SMB printing (Windows printing) to print directly over the Micro-
soft network from computers running Windows 98SE or Windows Me.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP address for this machine” on page 3-5.

In PageScope Web Connection, specify the settings described below for 
Windows printing.

1 Start up PageScope Web Connection.

– To log out if the login page does not appear, click the [Logout] but-
ton.

2 In the login page, select [Administrator], and then click the [Login] but-
ton.

3 Enter the administrator password, and login to the Administrator mode.

4 On the Network tab, click “SMB”, and then click “Print” in the sub-
menu that appeared.
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5 Specify settings for the following:

SMB Print: Set whether to use the SMB printing service. Select “ON” 
here.
NetBIOS Name: Specify the NetBIOS name (up to 15 characters, in-
cluding - only).
Print Service Name: Specify the printing service name (up to 12 char-
acters, excluding / \).
Work Group: Specify the work group name (up to 15 characters, ex-
cluding " \ ; : , * < > | + = ?).

6 To apply the settings, restart this machine (turn it off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.
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Printer driver settings

For Windows 98SE/Me

1 Click the [Start] button, point to “Settings”, and then click “Printers”. 

2 Right-click the icon of the installed printer, and then click “Properties”.

3 On the Details tab, click the [Add Port] button.

4 Select “Network”, and then click the [Browse] button. In the network 
configuration window that appears, select the appropriate printer icon.

For Windows 2000/XP/Server 2003

1 For Windows 2000, click the [Start] button, point to “Settings”, and 
then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 Click the [Add Port] button on the Ports tab, double-click “Local Port” 
or select “Local Port” and click the [New Port] button, and then enter 
“\\<NetBIOS_name>\<printing_service_name>”.

– Enter the same NetBIOS name and printing service name that you 
entered in PageScope Web Connection. For the setting procedure, 
refer to “Operations on this machine” on page 3-8.

4 Click the [Close] button to apply the setting.
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3.5 LPR printing

The LPR print service is supported as standard in Windows 2000, Windows 
XP, Windows NT 4.0, and Windows Server 2003. TCP/IP is used as the net-
work protocol.

Operations on this machine

% Set the IP address for this machine.
– For the setting procedure, refer to “Setting the IP address for this 

machine” on page 3-5.

Printer driver settings

For Windows 2000/XP/Server 2003

1 For Windows 2000, click the [Start] button, point to “Settings”, and 
then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 On the Ports tab, click the [Add Port] button.

4 In the “Available Printer Ports” list, select “Standard TCP/IP Port”, and 
then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the 
[Next] button.

6 In the “Name of printer or IP address” box, enter the IP address for this 
machine, and then click the [Next] button.

7 Select “Custom”, and then click the [Settings] button.

8 Select “LPR”, enter “Print” in the “Queue Name” box, and then click the 
[OK] button.
The capital letters and lowercase letters must be entered correctly.

9 Click the [Next] button, and then click the [Finish] button to apply the 
setting.
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For Windows NT 4.0

1 Click the [Start] button, point to “Settings”, and then click “Printers”. 

2 Right-click the icon of the installed printer, and then click “Properties”.

3 On the Ports tab, click the [Add Port] button.

4 In the “Available Printer Ports” list, select “LPR Port”, and then click the 
[New Port] button.

– If “LPR Port” is not in the list, click the [Start] button, point to “Con-
trol Panel”, and then click “Network”. Then, on the Service tab, click 
the [Add] button and install the Microsoft TCP/IP Printing service.

5 In the “Name or address of server providing lpd” box on the Add LPR 
Compatible Printer dialog box, enter the IP address for this machine.

6 In the “Name of printer or print queue on that server” box, enter “Print”.
The capital letters and lowercase letters must be entered correctly.

7 Click the [OK] button to apply the setting.
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3.6 Port 9100 Printing (Windows 98SE/Me/2000/XP/Serv-
er 2003)

The Port 9100 print service is supported as standard in Windows 2000, Win-
dows XP, and Windows Server 2003. TCP/IP is used as the network proto-
col. When using Port 9100 printing under Windows 98 Second Edition or 
Windows Me, it may be necessary to install the Peer to Peer Printing Tool. 
For details on the conditions when the Peer to Peer Printing Tool must be in-
stalled, refer to “Network printing from a Windows operating system” on 
page 3-3.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP address for this machine” on page 3-5.

Printer driver settings (Windows 2000/XP/server 2003)

When using Port 9100 to print, change the printer driver port to the Port 9100 
port.

1 For Windows 2000, click the [Start] button, point to “Settings”, and 
then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 On the Ports tab, click the [Add Port] button.

4 In the “Available Printer Ports” list, select “Standard TCP/IP Port”, and 
then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the 
[Next] button.

6 In the “Name of printer or IP address” box, enter the IP address for this 
machine, and then click the [Next] button.

7 Select “Custom”, and then click the [Settings] button.

8 Click [RAW], and then enter the RAW port number (the default setting 
is “9100”) in the Port Number box.
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9 Click the [Next] button, and then click the [Finish] button to apply the 
setting.

2
Note 

If the RAW port is not specified to be used in the TCP/IP setting, printing 
cannot be performed.

Installing the Peer to Peer Printing Tool to connect using Port 9100 (Win-

dows 98SE/Me)

To connect using Port 9100 and to obtain the Peer to Peer Printing Tool, con-
sult the dealer where you purchased this machine.

To connect to the network using Port 9100, specify the driver settings de-
scribed below after installing the Peer to Peer Printing Tool.

!
Detail 

To uninstall the Peer to Peer Printing Tool, delete the printer driver using 
the Peer to Peer port first, and then delete the Peer to Peer Tool in “Add 
or Remove Programs” in the “Control Panel”.

2
Note 

If multiple printer drivers are connected to the network and use the Peer 
to Peer Printing Tool, all printer drivers connected to the network with the 
Peer to Peer Printing Tool can no longer be connected to the network if 
the Peer to Peer Printing Tool is uninstalled.

Printer driver settings when installing the Peer to Peer Printing Tool to 

connect using Port 9100 (Windows 98SE/Me)

After the Peer to Peer Printing Tool is installed to connect using Port 9100 
under Windows 98 Second Edition or Windows Me, the printer driver port 
must be changed to the Peer to Peer port.

1 Click the [Start] button, point to “Settings”, and then click “Printers”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 On the Details tab, click the [Add Port] button.
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4 Click “Others”, select “KONICA MINOLTA Peer to Peer Port” from the 
list, and then click the [OK] button.

The Peer to Peer setup dialog box appears. The printer connected to 
the network is automatically detected.

5 Select the printer from the device list, enter the port number, and then 
click the “Add Port” button.

– The port is added. Skip to step 8.
– If the desired printer does not appear in the device list, proceed to 

step 6.

6 Click the [Manual setup] button.

7 Enter the TCP/IP or IPX setting for the network being connected, and 
then click the “Add Port” button.

– The port is added. Skip to step 8.

8 Click the [OK] button when the confirmation message appears.

The port is added.

9 Click the [OK] button to complete the operation.
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3.7 IPP printing (Windows 2000/XP/Server 2003)

The IPP (Internet Printing Protocol) print service is supported as standard in 
Windows 2000, Windows XP, and Windows Server 2003. TCP/IP is used as 
the network protocol.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP address for this machine” on page 3-5.

Also, specify the IPP printing settings in PageScope Web Connection. (Print-
ing can be performed with the default settings.)

1 Start up PageScope Web Connection.

– To log out if the login page does not appear, click the [Logout] but-
ton. 

2 In the login page, select [Administrator], and then click the [Login] but-
ton.

3 Enter the administrator password, and Log in to the Administrator 
mode.
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4 On the Network tab, click “IPP Setting”.

5 Specify settings for the following:

IPP Setting: Set whether to perform IPP printing. Select “ON” here.
Printer Name: Specify the printer name (up to 127 alphanumeric char-
acters).
Printer Location: Specify the printer location (up to 127 alphanumeric 
characters).
Printer Information: Specify the printer manufacturer details (up to 127 
alphanumeric characters).
Printer URI: The URl of the printer that can be used for IPP printing is 
displayed.
Support Operation: Specify print operations supported by IPP. 
Accept IPP Job: Set whether to use the IPP reception function.
IPP Authentication Setting: Specify the authentication method, user 
name, and password for the IPP connection.
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Installing the printer driver

For IPP printing, reinstall the printer driver.

1 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

– Konica Minolta PCL Driver: User Software CD-ROM
– Konica Minolta PostScript Driver: PostScript Printer Driver CD-

ROM

2 For Windows 2000, click the [Start] button, point to “Settings”, and 
then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

3 For Windows 2000/Server 2003, double-click the “Add Printer” icon.
For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

The “Add Printer Wizard” starts up.

4 Click the [Next] button.

5 In the Local or Network Printer dialog box, select “Network printer”, 
and then click the [Next] button.

6 In the Locate Your Printer dialog box, select “Connect to a printer on 
the Internet or on your intranet”.

7 In the “URL” field, enter the URL for this machine in the following for-
mat, and then click the [Next] button.

– http://<IP_address_for_this_machine>/ipp
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/ipp

8 When the confirmation dialog box appears, click the [OK] button.

9 Click the [Have Disk] button.
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10 Click the [Browse] button, specify the folder on the CD-ROM that con-
tains the printer driver, and then click the “OK” button.

Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
Konica Minolta PostScript driver: PostScript Printer Driver CD-ROM 
“Driver\bizhubC352” folder

11 Check that the printer name is displayed in the “Printers” list, and then 
click the [Next] button.

12 Select whether to set the printer as the default printer, and then click 
the [Next] button.

13 Click the [Finish] button to exit the Add Printer Wizard.

Once the settings for the printer have been specified, you can use the printer 
in the same way as a default local printer. Also, if you set up the printer for 
sharing in Windows, it can be used as a network printer by other Windows 
computers over the network.
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3.8 Printing with NetWare

The printer controller supports the following environments.

Network printing in a NetWare environment

2
Note 

Before using bindery emulation, check that bindery emulation is compat-
ible with the NetWare server.

For Remote Printer mode with NetWare 4.x Bindery Emulation

1 From a client computer, log on with Supervisor permissions to access 
the NetWare server where the Pserver is registered.

2 Start up Pconsole.

3 From the “Available Options” list, select “Quick Setup”, and then click 
the [Enter] button.

4 Enter the appropriate names in the “Printer Server Name”, “Printer 
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select 
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

5 Click the [Esc] button to quit Pconsole.

6 Use the NetWare server console to load PSERVER.NLM.

7 For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare documentation, 
and specify settings as necessary.

NetWare version Protocol used Emulation Service mode

NetWare 4.x IPX NDS/Bindery Pserver/Nprinter

NetWare 5.x/6 IPX NDS Pserver

TCP/IP NDPS(lpr)
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8 In Administrator mode of PageScope Web Connection, select “Net-
Ware Setting” from the Network tab, and then specify the following set-
tings.

IPX Setting: Select “ON”.
Ethernet Frame Type: Select “Auto”. (Select the frame type according 
to the network environment.)
NetWare Print Mode: Select “Nprinter/Rprinter”.
Printer Name: Specify the printer name.
Printer Number: Specify the printer number (0-255). When 255 is spec-
ified, the setting is “Auto”.

9 Restart this machine (turn it off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

10 Use the NetWare server console to display the print server screen, and 
then check that the created printer is shown as “Waiting for Job” for 
the connected printer (0).
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For Print Server mode with NetWare 4.x Bindery Emulation

Before using bindery emulation, check that bindery emulation is compatible 
with the NetWare server.

1 From a client computer, log on with Supervisor permissions to access 
the NetWare server where the Pserver is registered.

2 Start up Pconsole.

3 From the “Available Options” list, select “Quick Setup”, and then click 
the [Enter] button.

4 Enter the appropriate names in the “Printer Server Name”, “Printer 
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select 
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

5 Click the [Esc] button to quit Pconsole.

6 In Administrator mode of PageScope Web Connection, select “Net-
Ware Setting” from the Network tab, and then specify the following set-
tings.
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IPX Setting: Select “ON”.
Ethernet Frame Type: Select “Auto Detect”. (Select the frame type ac-
cording to the network environment.)
NetWare Print Mode: Select “Pserver”.
Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare 
server. (Displayed by “----”.)
Polling Interval: Specify “1”. (Change as necessary.)
Bindery/NDS Setting: Select “Bindery/NDS”.
File Server Name: Specify the name of the file server that connects to 
the Pserver.

7 Restart this machine (turn the main power off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

8 Use the NetWare server console to load MONITOR.NLM.

9 Select the connection information and, in the active connection col-
umn, check that the created Pserver is connected.

For NetWare 4.x Remote Printer mode (NDS)

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that of-
fers the print service, and then click “Print Services Quick Setup” on 
the “Tools” menu.

4 Enter the appropriate names in the “Printer Server Name”, “Printer 
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select 
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

5 For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare documentation, 
and specify settings as necessary.
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6 In Administrator mode of PageScope Web Connection, select “Net-
Ware Setting” from the Network tab, and then specify the following set-
tings.

IPX Setting: Select “ON”.
Ethernet Frame Type: Select “Auto Detect”. (Select the frame type ac-
cording to the network environment.)
NetWare Print Mode: Select “Nprinter/Rprinter”.
Printer Name: Specify the printer name.
Printer Number: Specify the printer number (0-255). When 255 is spec-
ified, the setting is “Auto Detect”.

7 Restart this machine (turn the main power off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

8 Use the NetWare server console to load PSERVER.NLM.

9 Use the NetWare server console to display the print server screen, and 
then check that “C300” (created printer) is shown as “Waiting for Job” 
for the connected printer (0).
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For NetWare 4.x/5.x/6 Print Server mode (NDS)

To use the Print Server mode, the IPX protocol must be loaded on the Net-
Ware server.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Select either the organization or organizational unit container that of-
fers the print service, and then click “Print Services Quick Setup (non-
NDPS)” on the “Tools” menu.

4 Enter the appropriate names in the “Printer Server Name”, “Printer 
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select 
“Other/Unknown” from the “Printer Type” field, and then click the [Cre-
ate] button.

5 For queue user privileges, printer notification option, assignment of 
multiple queues, and passwords, refer to the NetWare documentation, 
and specify settings as necessary.

6 In Administrator mode of PageScope Web Connection, select 
“NetWare Setting” from the Network tab, and then specify the following 
settings.
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IPX Setting: Select “ON”.
Ethernet Frame Type: Select “Auto Detect”. (Select the frame type ac-
cording to the network environment.)
NetWare Print Mode: Select “Pserver”.
Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare 
server. (Displayed by “----”.)
Polling Interval: Specify “1”. (Change as necessary.)
Bindery/NDS Setting: Select “NDS”.
NDS Context Name: Specify the name of the context that connects to 
Pserver.
NDS Tree Name: Specify the name of the tree that Pserver logs on to.

7 Restart this machine (turn the main power off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

8 Use the NetWare server console to load MONITOR.NLM.

9 Select the connection information and, in the active connection col-
umn, check that the created Pserver is connected.

For NetWare 5.x/6 Novell Distributed Print Service (NDPS)

Before specifying settings for NDPS, check that the NDPS broker and NDPS 
manager have been created and loaded.

Also, before performing the following procedure, check that the TCP/IP pro-
tocol has been set in the NetWare server, and check that the IP address has 
been set for this machine and that this machine is on.

1 Log on to NetWare as an administrator from a client computer.

2 Start up NWadmin.

3 Right-click the organization or organizational unit container where you 
will create the printer agent, and then click “NDPS Printer” on the “Cre-
ate” sub-menu.

4 In the “NDPS Printer Name” box, enter the printer name.

5 In the “Printer Agent Source” column, select “Create a New Printer 
Agent”, and then click the “Create” button.
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6 Check the printer agent name, and then in the “NDPS Manager Name” 
box, browse through the NDPS manager names, and register one.

7 In the “Gateway Types”, select “Novell Printer Gateway”, and then reg-
ister it.

8 In the Configure Novell PDS for Printer Agent window, select “(None)” 
for the printer type and “Novell Port Handler” for the port handler type, 
and then register the settings.

9 In “Connection type”, select “Remote (LPR on IP)”, and then register it.

10 Enter the IP address set for this machine as the host address, enter 
“Print” as the printer name, and then click the [Finish] button to register 
the settings.

11 The printer driver registration screen appears. Select “None” for each 
operating system to complete the registration.

2
Note 

For settings for the queue user rights, printer notification option, assign-
ment of multiple queues, and passwords, refer to the NetWare documen-
tation, and set them as necessary.

Setting up a client (Windows) settings when using the NetWare Server

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to 
“Settings”, and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 For Windows 98SE/Me/2000/NT 4.0/Server 2003, double-click the 
“Add Printer” icon.
For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

The “Add Printer Wizard” starts up.

3 In the port settings, browse the network, and specify the name of the 
created queue (or NDPS printer name).
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4 In the “Printer Model” list, specify the folder on the CD-ROM that con-
tains the printer driver for the operating system and printer driver to be 
used.

– For Windows 98SE/Me
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
PostScript driver: PostScript Printer Driver CD-ROM “Driver\PS-
PPD” folder

– For Windows NT4.0/2000/XP/Server 2003
Konica Minolta PCL driver: User Software CD-ROM
“Driver\bizhubC352” folder
PostScript driver: PostScript Printer Driver CD-ROM “Driv-
er\bizhubC352” folder

5 Follow the on-screen instructions to complete the installation.
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3.9 Printing with Macintosh

This section describes this machine’s settings and the Macintosh network 
settings.

Specify the printer network port settings after installing the printer driver and 
when selecting a printer. To select a printer, refer to “Selecting a printer” on 
page 2-18.

Operations on this machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP address for this machine” on page 3-5.

In PageScope Web Connection, specify the AppleTalk or Bonjour settings.

Specifying the AppleTalk settings

When connecting this machine to a Macintosh computer using AppleTalk, 
the AppleTalk settings must be specified.

1 Start up PageScope Web Connection.

– To log out if the login page does not appear, click the [Logout] but-
ton.

2 In the login page, select [Administrator], and then click the [Login] but-
ton. 

3 Enter the administrator password, and log in to the Administrator 
mode.
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4 On the Network tab, click “AppleTalk Setting”.

5 Specify settings for the following:

AppleTalk: Set whether to use AppleTalk. Select “ON” here.
Printer Name: Specify the printer name (up to 31 alphanumeric charac-
ters).
Zone Name: Specify the zone being connected to (up to 31 alphanu-
meric characters).

6 To apply the settings, restart this machine (turn it off, then on again).

– When turning the power off, then on again, be sure to turn the sub-
power switch off first, then the main power switch. In addition, wait 
at least 10 seconds before turning the power on again; otherwise, 
this machine may not function properly.

Specifying the Bonjour Settings

When connecting this machine to a Macintosh computer using Bonjour/Ren-
dezvous, the Bonjour settings must be specified.

1 Start up PageScope Web Connection.

– To log out if the login page does not appear, click the [Logout] but-
ton.
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2 In the login page, select “Administrator”, and then click the [Login] but-
ton.

3 Enter the administrator password, and login to the Administrator mode.

4 On the Network tab, click “Bonjour Setting”.

5 Specify settings for the following:

– Bonjour: Specify whether to use a Bonjour/Rendezvous connec-
tion. Select “ON” here.

– Bonjour Name: Specify the Bonjour name that is to appear as the 
connected device name (up to 63 alphanumeric characters and 
symbols).

6 To apply the settings, restart this machine (turn it off, then on again).

2
Note 

The Bonjour connection is a Mac OS X 10.4 function, it is the same func-
tion as the Rendezvous connection in Mac OS 10.3 or earlier.

When turning the power off, then on again, be sure to turn the sub-power 
switch off first, then the main power switch. In addition, wait at least 10 
seconds before turning the power on again; otherwise, this machine may 
not function properly.
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Setting the Macintosh computer

Use the Macintosh computer that is connected to specify the TCP/IP and 
AppleTalk settings.

2
Reminder 

For network settings, consult the network administrator.

For printer driver installation, refer to “Installing the printer driver” on 
page 2-1.

Since Bonjour (a Mac OS X 10.4 function) is always enabled, it is not re-
quired to change the settings. Bonjour/Rendezvous is a Mac OS X func-
tion. For Mac OS 9.2, connect using AppleTalk.

For Mac OS X

1 On the Apple menu, select “System Preferences”.

2 Click the “Network” icon.

3 From “Show”, select “Built-in Ethernet”.

4 Click the TCP/IP tab.

5 Select the items from “Configure” that correspond to the network set-
tings for the Macintosh computer that is connected to the network, and 
then set the IP address and subnet mask.

6 If using an AppleTalk connection, click the AppleTalk tab, and then 
check that the “Make AppleTalk Active” check box is selected.

7 Click the close button at the top left of the dialog box.

The “Apply configuration changes?” message appears.

8 Click the [Apply] button.

The changed settings are saved.
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For Mac OS 9.2

1 On the Apple menu, point to “Control Panel”, and then click “Apple-
Talk”.

2 From the “Connect via” drop-down list, select “Ethernet”.

3 On the Apple menu, point to “Control Panel”, and then click “TCP/IP”.

4 From the “Connect via” drop-down list, select “Ethernet”.

5 Select the items from “Configure” that correspond to the network set-
tings for the Macintosh computer that is connected to the network, and 
then set the IP address and subnet mask.

6 Click the close button at the top left of the dialog box.

The “Save changes to the current configuration?” message appears.

7 Click the [Save] button.
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4 Various printing methods

4.1 Printing operations

For Windows

Data can be printed from an application.

Print jobs are specified from the application software.

1 Open the data in the application, “File”, and then click “Print”.

2 Check that the printer name has been selected in “Printer Name” or 
“Select Printer”.

– If the printer is not selected, click to select the printer.

3 Specify the page range and the number of copies to print.

– The Print dialog box differs depending on the application.
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4 Click the [Preferences] button or the [Properties] button to change the 
printer driver settings as necessary.

– By clicking the [Preferences] button or the [Properties] button on 
the Print dialog box, you can specify the settings of each model on 
the printer driver dialog box that appears. For details, refer to “Set-
ting up the PCL driver” on page 5-1, “Setting up the PostScript 
driver (Windows)” on page 6-1 or “Setting up the PPD driver (Win-
dows)” on page 7-1.
If the changed settings are not saved in the Print dialog box, the 
original settings are restored when the application is quit.

5 Click the [Print] button.

The Data indicator of this machine flashes.

Test printing

Printing is possible when the printer driver is installed and the network set-
tings have been specified. To check that connection has been made proper-
ly, you can print the standard Windows test page.

Print a test page from the printer driver Properties dialog box.

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to 
“Settings”, and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 Click the General tab, and then click the [Print Test Page] button or the 
[Print Test] button.

The test page is printed and the confirmation dialog box appears.

4 Check the printout, and then click the [OK] button or the [Yes] button.

2
Note 

If the test page is not printed properly, check that the printer driver has 
been installed properly and that the network settings are complete.
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For Macintosh

Printing is possible when the printer driver is installed and the network set-
tings have been specified. Print jobs are specified from the application soft-
ware.

For Mac OS X

1 Open the data in the application, “File”, and then click “Print”.

2 Check that the printer name has been selected.

3 Specify the print range and the number of copies to print, and then 
click the [Print] button.

The Data indicator of this machine flashes.

2
Note 

If the printer name does not appear in the list, select the printer in Print 
Center or the Printer Setup Utility. For details, refer to “Selecting a print-
er” on page 2-18.

The Print dialog box differs depending on the application.
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For Mac OS 9.2

1 Open the data in the application, “File”, and then click “Print”.

2 Check that the printer name has been selected.

3 Select “General”.

4 Specify the Pages and the number of copies to print, and then click the 
[Print] button.

The Data indicator of this machine flashes.

2
Note 

If the printer name does not appear in the list, select the printer from the 
Chooser window. For details, refer to “Selecting a printer” on page 2-18.

The Print dialog box differs depending on the application.

The settings can be saved by clicking the [Save Settings] button.
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4.2 Setting the printing functions

The functions of this machine such as sorting and folding can be set when 
printing from a computer. Depending on the operating system running on the 
connected computer, the setting procedure of this machine’s functions may 
differ.

Function list

The function list contains a summary of the main settings related to printing 
and printer driver support.

2
Note 

The function names in this list are based on those displayed by the PCL 
printer driver in Windows XP. In addition, the items and setting values dis-
played may differ depending on whether the options are installed or the 
settings are available.

Function Overview Printer driver

PCL Post

Script

PPD

Orientation Selects the original document paper 
orientation.

o o o

Original Size Specifies the size of the original document. o o

Output Size Specifies the output paper size. o o o

Zoom Prints enlarged or reduced. o o o

Paper Source Selects the paper source for printing. o o o

Paper Type Settings Specifies the paper type of the paper 
source.

o o o

Binding Position Selects the binding position. o o o

Print Type Selects the print type (simplex, duplex, or 
booklet).

o o o

Combination Prints multiple pages on one page. o o o

File Margin Sets Margins for punch holes and staples. o

Staple Staples documents. o o o

Hole-Punch Punches holes in documents. o o o

Center Staple and 
Fold

Center staples printed documents. o o o

Output Method
(Job Management)

For non-conventional printing, selects the 
special output format for secured 
documents or saves data in a box.

o o (Mac 
OS X 
only)

Copies Specifies the number of copies to print. o o o
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Output Tray Selects the tray where to output the printed 
pages.

o o o

Collate Specifies whether to print multiple copies in 
sets.

o o o

Offset When printing multiple copies, shifts the 
output position of each set.

o o o

Skip Blank Pages Does not print blank pages in data. o

Front Cover Page Attaches a front cover page. o o o

Back Cover Page Attaches a back cover page. o o o

Transparency 
Interleave

Inserts interleaves between overhead 
projector transparencies.

o o o

Per Page Setting Switches the paper and trays per page. o

Chapter Specifies the page to be printed on the front 
side.

o

Overlay Prints the original document on top of form 
data that was created separately.

o

Watermark Prints a watermark (text stamp) on the page 
being printed.

o o

Distribution Number 
Stamping

Prints the number of the copy. o

Copy Protect Prints a special pattern and prevents 
copying.

o

Select Color Selects color printing and monochrome 
printing.

o (No 
two 
color 
selec-
tion)

(No 
two 
color 
selec-
tion)

Glossy Mode Prints using a gloss finish. o o o

Original Image Type Prints with a quality suitable for the selected 
original document.

o o o

Quality Adjustment Adjusts the image quality. o o o

Pattern Specifies the graphic pattern details. o

Use Printer Fonts Specifies the replacement of TrueType fonts 
with printer fonts.

o o o

FAX Sends data as a fax. o

User Authentication/
Account Track

Printing is performed after the registered 
user name and password are entered.

o o (Mac 
OS X 
only)

Account Track Performs account track operations. o o (Mac 
OS X 
only)

Function Overview Printer driver

PCL Post

Script

PPD
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Function overview

An overview of each function is summarized in this section.

Orientation

You can specify “Portrait” or “Landscape” as the orientation of the page be-
ing printed.

ABCD ABCDEF

Portrait Landscape

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Paper tab settings” on 
page 7-4

Mac OS X PostScript PPD “Page Attributes (basic settings)” on 
page 9-6

Mac OS 9.2 “Page Attributes (basic settings)” on 
page 8-6
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Original Size and Output Size

You can specify the original document size and the output paper size. By 
specifying each size, you can specify the enlargement and reduction ratio.

2
Note 

Only the output paper sizes can be specified with the PostScript PPD 
driver for Windows and the Macintosh.

Original size

Output size

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Paper tab settings” on 
page 7-4

Mac OS X PostScript PPD “Page Attributes (basic settings)” on 
page 9-6

Mac OS 9.2 “Page Attributes (basic settings)” on 
page 8-6
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Zoom (enlargement and reduction)

You can specify the enlargement or reduction ratio using numeric values.

ABCD

ABCD
ABCD

ABCD

ABC

Original

Reduced

Enlarged

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Graphics tab” on page 7-2

Mac OS X PostScript PPD “Page Attributes (basic settings)” on 
page 9-6

Mac OS 9.2 “Page Attributes (basic settings)” on 
page 8-6
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Input Tray (Paper Source)

You can select the input tray as the paper source for printing. When changing 
the paper type, you can select an input tray according to the paper type.

Paper Type

You can specify the paper type being printed.

2
Note 

With the Konica Minolta PCL driver for Windows, the paper type settings 
can be pre-set by specifying the paper type of the paper tray.

Tray

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Paper tab settings” on 
page 7-4

Mac OS X PostScript PPD “Paper Feed” on page 9-11

Mac OS 9.2 “General (basic settings)” on page 8-9

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Paper tab settings” on 
page 7-4
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Print Type (duplex printing/booklet printing)

You can print onto both sides of a page or in a booklet format (two facing 
pages or center binding). This comes in handy when you want to bind multi-
ple-page documents.

The binding area can be specified by specifying the binding position.

Duplex printing

Booklet printing

Print dataPrint data Printout

Left binding Top binding

Printout

Print data Printout

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Layout tab settings” on 
page 6-16

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5

Mac OS X PostScript PPD “Finishing” on page 9-14

Mac OS 9.2 “Printer specific options (Finishing Options 
1 to 4)” on page 8-11
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2
Note 

The duplex printing and booklet printing functions are available only 
when the optional ADU is installed.

Printing multiple pages on one page

You can print multiple document pages on one page. This comes in handy 
when you want to reduce the number of output pages.

1 2 1 2

3 4

1 2

4 5

3

6

1 2

4 5

3

6

7 8 9

1 2

5 6

3

7

9 10 11

4

8

12

13 14 15 16

2in1

4in1 6in1

9in1 16in1

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Layout tab settings” on 
page 6-16

PostScript PPD “Specifying the Layout tab settings” on 
page 6-16

Mac OS X PostScript PPD “Layout (printing multiple pages on one 
page)” on page 9-10

Mac OS 9.2 “Layout (printing multiple pages on one 
page)” on page 8-10
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Stapling and hole punching

Documents can be stapled together or holes can be punched into the docu-
ment.

By specifying the file margin, you can specify the margin for stapling or hole 
punching.

2
Note 

The staple function is available only when the optional finisher FS-514 is 
installed.

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.

ABCD ABCDEF ABCD ABCDEF

Stapling Hole punching

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Layout tab settings” on 
page 6-16

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5

Mac OS X PostScript PPD “Finishing” on page 9-14

Mac OS 9.2 “Printer specific options (Finishing Options 
1 to 4)” on page 8-11
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Output Method (Job Management)

You can select “Secured Print”, which requires a password to print, or “Save 
in User Box”, which saves documents in a document folder. 

Sorting (Collating) and Classifying (Offset)

You can print the complete document sets the specified number of times or 
each page the specified number of times.

By specifying offset, the output position can be shifted and output to the 
front and back for each copy. (Multiple paper sources are used when a shift-
ing finisher is installed and when no finisher is installed.)

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5

Mac OS X “Security” on page 9-11

ABCD
ABCD

1

ABCD

1

ABCD

1

ABCD

2

ABCD

2

ABCD

2

ABCD ABCD

Collate Offset

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5

Mac OS X PostScript PPD “Copies & Pages (general settings)” on 
page 9-9 and “Finishing” on page 9-14

Mac OS 9.2 “Copies & Pages (general settings)” on 
page 9-9 and “Printer specific options (Fin-
ishing Options 1 to 4)” on page 8-11
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Skip Blank Pages (saving paper)

Does not print blank pages in the data.

Front Cover, Back Cover, and Transparency Interleave

A front cover and back cover can be added and interleaves between over-
head projector transparencies can be inserted.

Per Page Setting

You can specify to have paper inserted between pages and specify simplex 
printing or duplex printing and the paper for printing for each page.

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

ABCDABCD
ABCD ABCD

Front cover Back cover

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Per Page Setting tab set-
tings” on page 5-19
“Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Per Page Setting tab set-
tings” on page 6-20

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5

Mac OS X PostScript PPD “Setup” on page 9-17

Mac OS 9.2 “Printer specific options (Finishing Options 
1 to 4)” on page 8-11

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Per Page Setting tab set-
tings” on page 5-19
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Chapter

You can specify the page that you want to print on the front side when duplex 
printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex 
printing or booklet printing, the specified page is moved and printed on the 
front side.

Overlay

Prints the original document on top of form data that was created separately.

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Per Page Setting tab set-
tings” on page 5-19

New Product New Product

Form data Created data

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Overlay tab settings” on 
page 5-22
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Watermark

Prints a watermark (text stamp) on the page being printed.

Copy Protect

You can print a special pattern on an entire page while printing.

When the pattern on the printed page is copied, the characters embedded in 
the pattern appear to prevent an illegal copy.

Quality Adjustment

Adjusts the image quality.

Con
fide

ntia
l

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Watermark tab settings” on 
page 5-26

Konica Minolta PostScript “Specifying the Watermark tab settings” on 
page 6-21

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Watermark tab settings” on 
page 5-26

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Quality tab settings” on 
page 5-30

Konica Minolta PostScript “Specifying the Quality tab settings” on 
page 6-23

PostScript PPD “Specifying the Device Options tab set-
tings” on page 7-5
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Use Printer Fonts (substitute fonts)

Specifies the replacement of TrueType fonts with printer fonts.

User Authentication

When the authentication settings have been applied on this machine, you 
must enter the required user name and password.

Account Track

Specifies when this machine is operating in Account Track.

Mac OS X PostScript PPD “Quality” on page 9-16

Mac OS 9.2 “Printer specific options (Finishing Options 
1 to 4)” on page 8-11

Operating system Printer driver Refer to

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Font tab settings” on 
page 5-32

Konica Minolta PostScript “Specifying the Quality tab settings” on 
page 6-23

PostScript PPD “Fonts tab” on page 7-3

Mac OS 9.2 PostScript PPD “PostScript Options” on page 8-8

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

Mac OS X PostScript PPD “Security” on page 9-11

Operating system Printer driver Refer to

Windows Konica Minolta PCL “Specifying the Setup tab settings” on 
page 5-5

Konica Minolta PostScript “Specifying the Setup tab settings” on 
page 6-7

Mac OS X PostScript PPD “Security” on page 9-11
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4.3 Specifying the printer driver basic settings

The settings specified for the functions of this machine when printing can 
only be applied while using the application. When the application is exited, 
the settings return to their default settings.

When registering the settings, change the printer driver basic settings (de-
fault settings) or use the function for saving settings.

For Windows

The functions of this machine that can be used when printing can be speci-
fied in the printer driver setup dialog box, which can be displayed from the 
Printers window (for Windows XP/Server 2003, Printers and Faxes window).

Settings specified in the printer driver setup dialog box displayed using the 
procedure described below will be applied when printing from any applica-
tion.

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to 
“Settings”, and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 For Windows 98SE/Me, right-click the icon of the installed printer, and 
then click “Properties”.
For Windows 2000/XP/Server 2003, right-click the icon of the installed 
printer, and then click “Printing Preferences”.
For Windows 4.0, right-click the icon of the installed printer, and then 
click “Document Default”.

The following printer driver setting dialog box appears.

For the settings that can be specified with each printer driver, refer to the fol-
lowing:
- Konica Minolta PCL Driver: “Setting up the PCL driver” on page 5-1
- Konica Minolta PostScript Driver: “Setting up the PostScript driver (Win-

dows)” on page 6-1
- PostScript PPD Driver: “Setting up the PPD driver (Windows)” on 

page 7-1
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PCL driver

PostScript driver
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PostScript PPD driver

2
Note 

Use each tab in the dialog box to set up the printer driver.

To specify custom settings, click Print in the application, and then click 
the [Properties] button or the [Preferences] button on the Print dialog box. 
The settings specified on the Print dialog box apply only to the current 
file.

For the function for saving settings, refer to the pages described below.
- Konica Minolta PCL driver: “Saving the driver settings” on page 5-49
- Konica Minolta PostScript driver: “Saving the driver settings” on 

page 6-28

For Macintosh

The functions of this machine that can be used when printing can be speci-
fied in the Print dialog box or the Page Setup dialog box.

The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their default settings.
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For Mac OS X

In the Print dialog box, save the settings from the “Presets” function.

For saving the settings, refer to “Saving the driver settings” on page 9-19.

In the Page Setup dialog box, save the settings by selecting “Save As De-
fault” from “Settings”.

2
Note 

For details on the items that can be specified in the printer driver, refer to 
“Setting up the PPD driver (Mac OS X)” on page 9-1.
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For Mac OS 9.x

In the Print dialog box, save the settings by clicking the [Save Settings] but-
ton.

2
Note 

The settings cannot be saved from the Page Setup dialog box.

“General” cannot be saved from the Print dialog box.

For details on the items that can be specified in the printer driver, refer to 
“Setting up the PPD driver (Mac OS 9.2)” on page 8-1.
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5 Setting up the PCL driver

5.1 Settings

Common settings

The following describes the common settings and buttons that are displayed 
on all tabs.

Button Function

OK Click this button to close the dialog box and apply any settings 
that have been changed.

Cancel Click this button to cancel any settings that have been changed 
and close the dialog box.

Help Click this button to display the help for each item on the cur-
rently displayed dialog box.

Save/Restore Setting Click this button to save the current settings and to view them 
at a later time.

Restore Defaults Click this button to return the settings to their defaults, which 
were selected when the driver was installed.
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2
Note 

To enable any installed options, you must specify the Option settings. For 
details, refer to “Specifying the Option tab settings” on page 5-47.

Setup tab

Per Page Setting tab

View When “Paper” is selected, a preview of the page layout as 
specified in the current settings is displayed and a preview im-
age of the print job can be checked.
When “Printer” is selected, a printer figure is displayed showing 
any options, such as the paper tray, that are installed on this 
machine.

Item Function

Paper Specifies the orientation of the original document, original 
size, output size, paper source, and paper type.

Binding Specifies the folding format such as the binding position, 
duplex printing, booklet printing, printing multiple pages 
on one page, file margin, stapling, or hole punching.

Output Specifies the output format such as the output method, 
number of copies, output tray, collate, or offset.

Item Function

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Per Page Setting Inserts paper between pages and switches simplex/du-
plex and paper for each page.

Chapter Specifies the page to be printed on the front side.

Button Function

Paper Printer
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Overlay tab

Watermark tab

Quality tab

Font tab

FAX tab

Item Function

Overlay Specifies overlay printing.

Item Function

Watermark Prints a watermark (text stamp) on the document being 
printed.

Distribution Number Stamping Prints the number of the copy.

Copy Protect Prints a special pattern and prevents copying.

Item Function

Select Color Specifies the color for printing.

Original Image Type Specifies the contents of the original document. Prints 
with a quality suitable for the original document.

Quality Adjustment Adjusts the image quality. You can select “Simple” to ad-
just entire documents and “Detailed” to adjust the charac-
ters, photos, and charts of each document.

Glossy Mode Prints using a gloss finish.

Pattern Selects the print pattern.

Item Function

Use Printer Fonts Selects whether to use TrueType fonts or the printer fonts 
when printing.

Download Font Format Selects whether the fonts are downloaded to the printer 
as bitmap or outline.

Item Function

Mode Selection Selects whether to print or send a fax.

Fax Mode Settings Specifies the fax resolution and transmission conditions.

FAX Cover Sheet Specifies the fax cover sheet.

Recipients Enters the recipient.

Phone Book Registers recipients in the Phonebook.
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Version tab

Option tab

2
Note 

To display the Option tab in Windows 2000/XP/NT 4.0/Server 2003, right-
click the icon of the installed printer, and then click “Properties”.

Recipients Displays registered numbers for the recipient or Phone-
book.

Item Function

Version Displays the version of the printer driver.

Item Function

Option Specifies the options that are installed on this machine.

Option Information Automatically specifies the printer driver option settings.

Model Specifies the model to be used.

Item Function
C300 5-4



Setting up the PCL driver 5
5.2 Specifying the Setup tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the 
output paper size.

1 Click the Setup tab.

2 From the “Original Size” and “Output Size” drop-down lists, select the 
desired settings.

– You can also specify any enlargement or reduction ration in the 
“Zoom” box.

2
Note 

If the paper size is other than the custom size, select the desired settings 
after specifying the settings in Custom Size.

When “W” is selected for each standard paper size in the printer driver, 
the data can be centered and printed. 
For example, if A4 size data is created and you want to center and print 
on A3 size paper, specify “A4 W” as the paper size in the printer driver 
and specify “Tray 1” or “Bypass Tray” as the paper source. 
To print, load A3 size paper in the tray (“Tray 1” or “Bypass Tray”) of this 
machine that is specified in the printer driver, and then specify the set-
tings described below from [Basic Screen (Paper)] — [Change Tray Set-
tings] — [Oversized Paper] on the control panel.
Select [A4W].
Enter the A3 paper size (420.0 × 297.0) in [Change Size].
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Saving a custom size

A custom size can be specified and saved in advance as described below.

1 From the “Original Size” or “Output Size” drop-down list, select “Cus-
tom Size Settings”.

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

List of Custom Sizes: Select the size for the custom size being set.
Custom Size Name: Input the name of the custom size being regis-
tered.
Size: Specify the width and length of the custom size according to the 
selected measurement units.

3 Click the [OK] button.

2
Note 

The custom size settings can only be specified from the printer driver set-
up dialog box, which can be displayed from the Printers window (for Win-
dows XP/Server 2003, Printers and Faxes window).

If using long paper, specify the size of the long paper in Custom Size. For 
details, refer to “Printing on banner paper” on page 10-119.
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Selecting the paper source

When changing the paper type, you can register it to an input tray and you 
will be able to select the input tray according to the desired paper type.

1 Click the Setup tab.

2 From the “Paper Source” drop-down list, select the paper tray that 
contains the paper to be used.

Setting the paper source of the paper type

Follow the procedure described below to assign a paper type to a paper tray.

1 Click the [Paper Type Settings] button.

2 Select the “Paper Source” being changed, and then click the [Edit Pa-
per Type] button.

3 Select the desired setting from the “Paper Type” drop-down list, and 
then click the [OK] button.
Only the paper types that can be selected in each input tray are dis-
played.
C300 5-7



Setting up the PCL driver 5
If “Transparency” is selected as the paper type, you can specify 
transparency interleaving.
When the “Transparency Interleave” check box is selected, the 
Transparency Interleave Settings dialog box appears, allowing you to 
select the source of the interleaf paper.
The Transparency Interleave Settings dialog box can also be displayed 
by clicking the [Settings] button.

2
Note 

Thick 1, Thick 2, and Thick 3 cannot be selected for Tray 2, Tray 3, and 
Tray 4 and LCT.

Letterhead paper can only be selected when optional ADU is installed.

Specifying duplex/booklet printing

You can print a document onto both sides of a page or in a booklet format 
(two facing pages). This comes in handy when you want to bind multiple-
page documents.

The duplex printing and booklet printing functions are available only when 
the optional ADU is installed.

1 Click the Setup tab.

2 From the “Print Type” drop-down list, select “Double-sided” or “Book-
let”.

2
Note 

The binding orientation can be specified from the “Binding Position” 
drop-down list.
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Printing multiple pages on one page (N in 1)

You can print multiple-page documents on one page. This comes in handy 
when you want to reduce the number of output pages.

1 Click the Setup tab.

2 Select the “Combination” check box.

3 From the “Combination” drop-down list, select the number of pages to 
be printed on one page.

To change the border line and printing order settings, select “Details”, 
and then change the settings in the dialog box that appears.

2
Note 

When printing a job that contains pages of different sizes and orienta-
tions, images may be missing or overlapping when the document is print-
ed.
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Setting the file margin

File margins are added to the document before it is printed.

1 Click the Setup tab.

2 Select the “File Margin” check box.

3 To set the width of the file margin, click the [Details] button, and then 
specify the desired settings in the File Margin Details dialog box that 
appears.

Front Side/Back Side: Sets the file margin values. By clearing the “Save 
Value for Front and Back Sides” check box, you can specify separate 
values for the front and back sides.
Shift Mode: To add a file margin, select how the image is to be shifted.

2
Note 

When “Double Sided” is selected in “Print Type” and “Auto Reduction” is 
specified in Shift Mode in the File Margin Details dialog box, the reduction 
ratio according to the larger value of the file margin width is used from the 
values specified in Front Side/Back Side.
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Stapling

Multiple-page documents can be stapled.

The staple function is available only when the optional finisher FS-514 is in-
stalled.

1 Click the Setup tab.

2 Select the “Staple” check box.

3 From the drop-down list, specify the number of staples and the sta-
pling position.

2
Note 

Depending on the selected Binding Position setting, different stapling po-
sitions are available.

Hole punching

Holes can be punched into the printed document.

The hole punch function is available only when optional finishers FS-514 and 
punch kit PK-510 are installed.

1 Click the Setup tab.

2 Select the “Hole-Punch” check box.

3 From the drop-down list, specify the number of punched holes.
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Fold & Staple

You can specify the center binding process of a document.

1 Click the Setup tab.

2 Select the “Fold & Staple” check box.

3 To specify the settings in “Fold & Staple”, click the [Details] button, and 
then specify the desired setting in the Fold & Staple Details dialog box 
that appears.

Fold & Staple: Specifies to fold and staple a printed document. You can 
specify “Fold & Staple” to fold and staple a document, “Center Staple” 
to staple a document in the center, or “Fold” to fold a document in half.

2
Note 

The Fold & Staple function is available only when saddle stitcher SD-503 
is installed on optional finisher FS-514.
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Selecting the output method

Not only can you print directly, but you can select “Secured Print”, which re-
quires a password to print, or “Save in User Box”, which saves documents 
in the document folder. 

1 Click the Setup tab.

2 From the “Output Method” drop-down list, select the output method.

– Print: Prints immediately.
– Secured Print: Saves the document to be printed in the secured 

document box of this machine. When printing, you are required to 
enter the user ID and password in this machine’s control panel. Se-
lect when printing highly confidential documents. (Up to 100 docu-
ments)

– Save in User Box: Saves the document to be printed in a box on this 
machine.

– Save in User Box and Print: Saves the document in a box and prints 
at the same time.

– Proof and Print: After part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting 
large print jobs.

Secured Printing

If “Secured Print” was selected, enter the ID and password in the dialog box 
that appeared.

2
Note 

To print the document, specify [Secured] in the Box mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print job 
management” on page 10-104.

For details on the box functions of this machine, refer to the User’s Guide 
[Box Operation].
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When password rules are enabled on this machine, the passwords that 
can be used for secured printing are limited and the jobs are deleted 
when a password that does not comply with the password rule is en-
tered. For the password rules, refer to User’s Guide [Copy Operations].
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Save in User Box

% When “Save in User Box” or “Save in User Box and Print” is selected, 
specify the file name and box number in the dialog box that appears for 
entering the file name and box number.

2
Note 

For details on the box functions of this machine, refer to the User’s Guide 
[Box Operations].

When the power rules are enabled on this machine, specify the box that 
is created on this machine.

Proof and printing

% When a print job is sent, this machine stops printing temporarily after 
part of the document has been printed. The remaining print job is 
stored in this machine as a print job. When printing multiple copies, you 
can print the remaining part of the print job after checking the print re-
sults.

2
Note 

To print the document, specify the document in the Job mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print job 
management” on page 10-104.
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Specifying user authentication settings

If user authentication settings have been specified on this machine, you must 
enter a user name and password.

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the “User Authentication” 
check box selected, the job is deleted without being authenticated by this 
machine.

When the user authentication settings are specified on this machine, the au-
thentication operation restriction function is in mode 2, and the authentica-
tion information is not entered correctly, the applicable user is locked and 
cannot be accessed.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the “User Authentication” check box, and then enter the user 
name and password.

4 Click the [OK] button.
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2
Note 

If this machine has been set to permit public users, the machine can be 
used without a user name and password.

If printing is not allowed, printing cannot be performed even when used 
by a registered user.

For user authentication settings, consult the administrator of this ma-
chine.

Specifying account track settings

If account track settings have been specified on this machine, you must en-
ter a department name and password.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the “Account Track” check box, and then enter the department 
name and password.

– A default password can be registered and used rather than entering 
a password for each job.

4 Click the [OK] button.
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2
Note 

If a print job is sent using a department name or password that is not a 
registered account on this machine or if a job is sent without the “Account 
Track” check box selected, the job is deleted without being authenticat-
ed by this machine.

When the account authentication settings are specified on this machine, 
the authentication operation restriction function is in mode 2, and the au-
thentication information is not entered correctly, the applicable account 
is locked and cannot be accessed.

If printing is not allowed, printing cannot be performed even when used 
by a registered account.
For the account track details, consult the administrator of this machine.
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5.3 Specifying the Per Page Setting tab settings

Printing documents with a front cover/back cover

1 Click the Per Page Setting tab.

2 Select the “Front Cover Page” and “Back Cover Page” check boxes.

3 To print on the front cover and back cover, select “Printed”. To only 
add a blank page, select “Blank”.

4 Select the input tray that contains the loaded paper for the front cover 
and back cover.
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Printing multiple pages

The “Per Page Setting” function comes in handy when you want to change 
the input tray during a print job when printing multiple pages.

Chapter

You can specify the page that you want to print on the front side when duplex 
printing or booklet printing.

Even if a specified page comes up to be printed on the back side in duplex 
printing or booklet printing, the specified page is moved and printed on the 
front side.

1 Click the Per Page Setting tab.

2 Select the “Chapter” check box.

3 Enter the page number of the page you want to print on the front side.

2
Note 

Enter the page number using single-byte numerals.

When entering multiple page numbers, separate the page numbers with 
commas such as “2, 4, 6” or enter a page range using a hyphen such as 
“6-10”.

Per Page Setting

You can specify the print type and input tray for each page.

1 Click the Per Page Setting tab.

2 Select the “Per Page Setting” check box.

3 From the “List Name” drop-down list, select the name of the desired 
list.

– When changing the list name, click the [Edit List Name] button after 
selecting the list name, and then apply the settings on the dialog 
box that appears.
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4 Click the [Add] button, and then specify the page number, print type, 
and paper source in the dialog box that appears.

2
Note 

For an existing list, click the [Edit] button to change the selected page 
settings, or click the [Delete] button to delete them.

Click [↑] or [↓] to change the page number starting with the smallest page 
number.
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5.4 Specifying the Overlay tab settings

Printing different original documents together (Overlay)

An original document can be printed on top of form data that was created 
separately. This function is handy for fax cover letters and form letters.

You must pre-register forms to be printed. For details, refer to “Editing 
forms” on page 5-24.

1 Create the print data using any application.

2 From the “File” menu, select “Print”.

3 Select the printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the Overlay tab.

5 Select “Print Overlay”.
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6 From the list, select the form that you want to print.

7 Select the file name, and then click the [OK] button.

– The Print dialog box appears again.

8 Click the [OK] button.

Overlay printing is performed.
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Editing forms

To use forms, the data for using forms must be pre-registered. To register a 
form, select the “Create Overlay” check box, and then specify the document 
that you want to register.

1 Create the form data using any application.

2 From the “File” menu, select “Print”.

3 Select the printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the Overlay tab.

5 Select the “Create Overlay”.

6 Click the [Browse Files] button.
C300 5-24



Setting up the PCL driver 5
7 Specify the storage location for the form data, and then enter the file 
name in the “File name” box.

8 Click the [Save] button.

9 Select the file, and then click the [OK] button.

– The Print dialog box appears again.

10 Click the [OK] button.

Instead of executing a print job, the form data is saved. The file exten-
sion is “.kmf”.

2
Note 

When the overlay data that was created consists of multiple pages, the 
first page of data is registered as an overlay.

From the Overlay tab, the selected form data can be deleted by clicking 
the [Delete Overlay File] button.
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5.5 Specifying the Watermark tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Watermark tab.

2 Select the “Watermark” check box.

3 From the drop-down list, select the watermark that you want to print.

4 Specify the desired settings for “Type” and “1st Page Only”.

Overwrite: The background of the watermark is printed in white.
Transparent: The background of the watermark is transparent.

Editing a watermark

You can change the fonts and position of the watermark and you can register 
a new one.

1 Click the Watermark tab.

2 Select the “Watermark” check box.

3 Click the [Edit] button.
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4 Specify settings for the following:

[Add]: Click to enter a new watermark in the watermark text box.
[Delete]: Click to delete the selected watermark.
Watermark Text: Enter the text to be printed as a watermark.
Font Settings: Specifies the font and font size.
Text Angle: Specifies the watermark print angle.
Position: Specifies the watermark position with the horizontal and ver-
tical scroll bars.
Text Color: Specifies the watermark text color.

Printing the document number

When printing multiple copies, you can print the number of each document.

1 Click the Watermark tab.

2 Select the “Distribution Number Stamping” check box.

3 Specify settings for the following:

Pages to Print: Specifies the pages where the numbering is to be print-
ed.
Starting Number: Specifies the starting number.
Color: Specifies the color of the number being printed.

2
Note 

The “Numbering” check box is not available if the “Collate” check box is 
not selected on the Setup tab.
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Copy Protect

You can print a special pattern on an entire page while printing.

When copying a printed page, the characters embedded in the pattern ap-
pear to prevent an illegal copy.

1 Click the Watermark tab.

2 Select the “Copy Protect” check box.

3 Click the [Edit] button.

4 Specify each setting, and then click the [OK] button.

Type of Copy Protect: Specify the pattern to be embedded with copy pro-
tection. You can specify multiple types from “Stamp/Character”, “Date/
Time”, and “Serial Number”.
- Stamp/Character: Embeds the selected character string in a pattern. A 

preregistered character string (common stamp) or a character string reg-
istered on this machine (registered stamp) can be specified.

- Date/Time: Embeds the selected date and time in a pattern.
- Serial Number: Embeds the serial number of this machine in a pattern.
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Detail Setting: Specifies the color and density pattern to be embedded with 
copy protection, and specifies the embedding method.
- Color: Select the pattern print color.
- Density: Select the pattern print density.
- Pattern: Select the pattern.
- Pattern Contrast: Select the pattern contrast.
- Pattern Size: Select the pattern size.
- Pattern Overwrite: Select whether to print the pattern over the text of a 

document or print in the blank spaces.
- Angle: Select the pattern angle.
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5.6 Specifying the Quality tab settings

Specifying settings

1 Click the Quality tab.

2 Specify settings for the following:

Item Function

Select Color Specifies the color for printing.
Color: Prints in color.
Grayscale: Prints in grayscale.
2 Color: Prints the two colors selected from the drop-down list.

Original Image Type Specifies the contents of the original document. Prints with a 
quality suitable for the original document.
Document: Prints with a quality suitable for documents with 
many characters.
Photo: Prints with a quality suitable for photos.
DTP: Prints with a quality suitable for documents produced us-
ing DTP.
WEB: Prints with a quality suitable to Web page printing.
CAD: Prints with a quality suitable for CAD data printing.

Quality Adjustment Adjusts the image quality.
Simple: Adjusts the entire document.
Detailed: Adjusts the text, photos, and charts of each object in 
a document.

Glossy Mode Prints using a gloss finish.

Pattern Selects the print pattern.
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To adjust the quality, select “Simple” or “Detailed”, and then click the 
[Settings] button beside the desired setting. In the Quality Adjustment 
Settings dialog box that appears, specify the brightness and color balance. 

To adjust the quality, select “Detailed”, and then click the [Settings] button 
beside “Figure/Table/Graph”. In the Quality Adjustment Settings dialog box 
that appears, you can specify the color settings and screen/smoothing set-
tings, and the corresponding text or photo settings.
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5.7 Specifying the Font tab settings

Specifying settings

You can replace the TrueType fonts used in Windows with the printer fonts 
of this machine.

1 Click the “Font” tab.

2 Select the “Use Printer Fonts” check box.

3 Select the TrueType font that you want to replace.

4 From the “Printer Font to Use” drop-down list, select the printer font to 
replace the TrueType font.

5 Click the [OK] button.

2
Note 

Using the printer fonts will shorten the printing time, however, there may 
be a difference in the screen display and the print results.

To download the TrueType fonts when not using the printer fonts, select 
the font type to be downloaded to the printer from the “Download Font 
Format” drop-down list.
C300 5-32



Setting up the PCL driver 5
5.8 Specifying the FAX tab settings

Sending a fax

You can send your created data by fax.

To use the fax function, you must install the optional fax kit onto this ma-
chine. In addition, you must enable the fax kit on the Option tab after instal-
lation. For details, refer to “Specifying the Option tab settings” on page 5-47.

1 Create the data you want to send using any application.

2 From the “File” menu, select “Print”.

3 Select the printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the “FAX” tab.

5 Under “Mode Selection”, select “FAX”.

– When “Custom Size” is selected from the “Output Paper” drop-
down list on the Setup tab, the fax function cannot be set up.

– For details on the fax functions of this machine, refer to the User’s 
Guide [Facsimile Operations].

A confirmation message appears.
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6 Check the information, and then click the [OK] button.

7 From the “Resolution” drop-down list, select the desired setting.

8 Click the Details button.

The [Fax Mode Details] dialog box appears.

9 To print a file after a fax is sent, select the “Print Recipient File” check 
box.

10 To set the time when the fax is to be sent, select the “Timer Send” 
check box, and then specify the time that you want the fax to be sent 
in the “Send Time” boxes.

– By clicking the [Reflect Current Time] button, the current time set 
on the computer is displayed in the “Send Time” boxes.

– When using “Timer Send”, check that the time set on the computer 
is synchronized with the time on this machine. If the transmission 
time is earlier than the current time of this machine, the fax is sent 
the next day.
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11 When transmitting a confidential fax, select the “Sub-Address” and 
“Send ID” check boxes, and then enter the sub address and 
transmission ID. It is possible to send confidential communications to 
another fax model using F codes.

– Up to 20 characters (numbers 0 through 9) can be entered in the 
“Sub Address” text box.

– Up to 20 characters (numbers 0 through 9, # and *) can be entered 
in the “Send ID” text box.

12 Click the [OK] button.

The Printing Preferences dialog box appears again.

13 Specify the fax destination.

You can directly enter the fax recipient or you can select one from the 
Phonebook.
To enter the fax recipient directly, continue with step 14. To select a fax 
recipient from the Phonebook, skip to step 15.

14 Under “Direct Entry”, enter the appropriate information in the “Name” 
and “FAX Number” text boxes, and then click the [Add Recipients] but-
ton.
You can save up to 100 recipients in the “Recipients” list. After entering 
the recipient information, skip to step 19.

– Up to 38 characters (numbers 0 through 9, hyphens (-), spaces, #, 
*, E, P, and T) can be entered in the “FAX Number” text box.
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15 Click the [Phone Book] button. 

– For details on registering recipients in the Phonebook, refer to 
“Registering a recipient in the phonebook” on page 5-42.

The Phonebook dialog box appears.

16 Select the recipient or group where the fax is to be sent.

17 Click the [Add Recipients] button.

The selected recipient is displayed in “Recipients” list.

18 Select the recipient and then click the [OK] button.

– If a group is selected, all the members of the group are displayed in 
the “Recipients” list.

The Printing Preferences dialog box appears again.

19 Check that the file recipient appears in the “Recipients” list.

– To delete a recipient, select the recipient to be deleted from in the 
“Recipients” list, and then click the [Delete] button.

– It is not necessary to change the settings for the “ECM”, “Interna-
tional Transmission Mode”, and “V.34” check boxes. For details, 
refer to the “User’s Guide [Fax Operations]”.
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20 When adding a cover sheet, select the “FAX Cover Sheet” check box.

– For setting up a fax cover sheet, refer to “Creating a cover sheet” 
on page 5-38.

21 Click the [OK] button.

The Print dialog box appears again.

22 Click the [OK] button.

The FAX Send Confirmation dialog box appears.

23 Click the [OK] button.

The fax is sent to the specified recipient.

2
Note 

When a fax transmission error occurs, a TX Report is automatically print-
ed. If you do not want the error report to be printed automatically, set “TX 
Report” to “OFF” in the Report Settings screen from this machine’s con-
trol panel.
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Creating a cover sheet

You can create a fax cover sheet and attach it to the fax message.

1 From the Printing Preferences dialog box, select the “FAX Cover 
Sheet” check box on the FAX tab.

2 Click the [Setting] button.

The FAX Cover Sheet Setting dialog box appears.

3 From the “Style” drop-down list, select the cover sheet format.

Styles include 00 to 03 (03 is for English).

4 Select the “Subject” check box, and then enter the subject of the doc-
ument being transmitted.

– Up to 64 characters can be entered in the “Subject” text box. In 
Windows 98SE/Me, you can enter up to 64 characters.

5 Under “Recipient Information”, you can specify the recipient informa-
tion, such as the person’s name, for the cover sheet that is to be includ-
ed. The information shown in the “Recipients” list on the FAX tab is 
entered on the cover sheet.

– Standard: Selects the standard recipient information. Select 
“Standard”, and then select from the drop-down list the text to be 
entered in the recipient information line. You can also enter charac-
ters.
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– Details: Specify the recipient information individually. Select “De-
tails”, and then select the “Company”, “Department”, “Name”, or 
“FAX Number” check box for the information to be entered in the 
recipient information line. By clicking the [Settings] button, you can 
select “Load with Joint Name”, “Change Each Recipient”, or “Load 
Set Information” in the Destination Information Settings dialog box.

– The first recipient cover sheet is displayed as a sample in the “Pre-
view” box.

– Up to 10 individual cover sheets can be created if “Change Each 
Recipient” is selected. When sending 11 or more faxes with “Load 
with Joint Name” or “Change Each Recipient” selected, the infor-
mation specified for “Standard” appears in the recipient information 
line.

– If “Change Each Recipient” is selected, “Print Recipient File” can-
not be selected from on the Fax Mode Details dialog box, displayed 
from the FAX tab.

– If “Destination” is not specified, “Load Set Information” cannot be 
selected.

– Depending on the type of characters entered and the settings spec-
ified with “Style”, all characters entered may not be displayed on 
the cover sheet. After entering the information, check that the infor-
mation is displayed properly in the image in the “Preview” box.

6 Select the “Company”, “Department”, “Name”, “Phone”, “FAX 
Number”, or “E-mail” check box under “Sender Information” for the in-
formation that you want to enter in the sender information line, and then 
click the [Settings] button to enter the main information to be sent on 
the cover sheet.
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– Depending on the type of characters entered and the settings spec-
ified with “Style”, all characters entered may not be displayed on 
the cover sheet. After entering the information, check that the infor-
mation is displayed properly in the image in the “Preview” box.

– Up to 40 characters can be entered for each item. In Windows 
98SE/Me, you can enter up to 40 characters.

The entered sender information appears in the image in the “Preview” 
box.

7 To enter the current date on the cover sheet, select the “Date” check 
box.

8 To enter the number of pages being sent, select the “Pages” check 
box, and then specify the number of pages.

9 To write a message on the cover sheet, enter the message in the “Com-
ment” text box.

– If more that 25 characters are entered per line, the characters may 
not be displayed correctly on the cover sheet. Check the text in the 
image in the “Preview” box, and then insert a return to adjust the 
number of characters per line. 

– Up to 640 characters can be entered in the “Comments” text box. 
In Windows 98SE/Me, you can enter up to 640 characters. A return 
is equivalent to two characters.
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10 To arrange cover sheets with a company logo, maps, or other images, 
select the “Image” check box, click the [Browse] button, and then 
specify the file.

– You can adjust the position of the image by specifying numerical 
values in the “X” and “Y” boxes, and you can adjust the image size 
between 50% and 800% by specifying a zoom ratio in the “Zoom” 
box.

11 Click the [Check] button to check the current settings.

The Check FAX Cover Sheet dialog box appears, and the cover sheet 
is displayed at a larger size.
Check the contents of the cover sheet and make any changes to the 
image as necessary.

12 Click the [OK] button.

The FAX Cover Sheet Setting dialog box appears again.

13 Select the cover sheet size in “Cover Size” drop-down list.

14 Click the [OK] button.

The Printing Preferences dialog box appears again.

2
Note 

To erase all of the changed settings, click the [Restore Defaults] button 
on the FAX Cover Sheet Setting dialog box.
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Registering a recipient in the phonebook

You can register the recipient of a fax message in the Phonebook.

Registering recipient information

1 In the Printing Preferences dialog box, click the [Phone Book] button in 
the FAX tab.

The Phonebook dialog box appears.

2 Click “PhoneBook1.csv”, and then click the [Personal] button.

The [Personal Information] dialog box appears.

3 Enter the appropriate information in the “Name”, “Fax No.”, “Compa-
ny”, and “Department” text boxes. You can enter titles in the “Name” 
text box.

– It is not necessary to change the settings for the “ECM”, “Int. Tx”, 
and “V.34” check boxes. For details, refer to the User’s Guide [Fac-
simile Operations].

– Up to 40 characters can be entered in the “Name”, “Company”, and 
“Department” text boxes.
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– Up to 38 characters (numbers 0 through 9, hyphens (-), spaces, #, 
*, E, P, and T) can be entered in the “Fax No.” text box.

4 Click the [OK] button.

The recipient is registered and appears in the “Recipient” list.

5 Click the [OK] button.

The Save As dialog box appears.

6 Specify the storage location and enter the file name.

7 Click the [Save] button.

The Phonebook is saved as a file.

2
Note 

By clicking the [Folder] button in step 2, you can create a folder and 
arrange the recipient information. To move the recipient into a folder, 
right-click the recipient name in the directory tree on the left-side of the 
dialog box, and then select “Copy” or “Cut”. Select the target folder, and 
then select “Paste” to register the recipient in the folder.

Up to 40 characters can be entered as the folder name.

A folder can be up to three layers deep.

To edit the recipient information and folder, select the desired data, and 
then click the [Edit] button.

To delete recipient information or a folder, select the recipient or folder 
being deleted, and then click the [Delete] button.
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When a recipient is registered in the Phonebook for the first time, the 
Save As dialog box, described in step 5, appears so that the Phonebook 
can be saved as a file. The Save As dialog box does not appear the next 
time that the Phonebook is changed since the Phonebook file is 
automatically overwritten.

The saved Phonebook file is automatically displayed the next time that 
you open the Phonebook. To open a different Phonebook, select “Open” 
from the “File” menu in the Phonebook dialog box. By saving multiple 
Phonebook files, you can switch between Phonebooks.

A new Phonebook can be created by clicking “New” in the “File” menu 
on the Phonebook dialog box. You can save a file under a different name 
by clicking “Save As” in the “File” menu.

The file extension for the Phonebook files is “.csv”.
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Registering a group

You can pre-register the recipients to which you want to send the same fax. 
This is called a “group”.

1 On the Phonebook dialog box, select the recipient to be registered in 
the group.

The selected recipient is highlighted.

2 Right-click the selected recipient, and then, from the “Add Group” sub-
menu, select the group where the recipient is to be registered.

The recipient is copied into the selected group.
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2
Note 

Ten groups have been set. You cannot add or delete any group.

A total of 100 recipients can be registered in all 10 groups.

When a recipient is registered in the Phonebook for the first time, the 
Save As dialog box appears so that the Phonebook can be saved as a 
file. For details, refer to “Registering a recipient in the phonebook” on 
page 5-42.

To change the group name, right-click the name of the group in the di-
rectory tree on the left-side of the dialog box, and then click “Edit”.

To delete a recipient from a group, click the group from which the recip-
ient is to be deleted, right-click the name of the recipient in the directory 
tree on the left-side of the dialog box, and then click “Delete from Group”.
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5.9 Specifying the Option tab settings

You can enable the options installed on this machine to be used from the 
printer driver by specifying whether the models or options are available.

2
Note 

If the installed options are not set from the Option tab, the option function 
cannot be used with the printer driver. When installing options, be sure to 
make the proper settings.

Specifying settings

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to 
“Settings”, and then click “Printers”. For Windows XP/Server 2003, 
click the [Start] button, and then click “Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.

2 Right-click the printer icon, and then click “Properties”.

3 Click the Option tab.

4 Select the model to be used from the “Model” drop-down list.
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5 Select the installed options from the drop-down lists in the Option dia-
log box.

2
Note 

To automatically set the installed options, enter the printer name or IP ad-
dress of this machine in the “Printer Name or IP Address” box under “Op-
tion Information”, and then click the [Gather Option Information] button.

The [Gather Option Information] button can only be used when the SNMP 
setting is enabled on this machine and the SNMP v1/v2c (IP) setting 
check box is selected.

When the Mail Bin Kit is installed, you can assign output tray 1 and output 
tray 2 as mail bins.

To assign the output destination of the mail bins, select “Bin Setting” 
from “Administrator Setting” - “System Setting” - “Output Setting” on the 
control panel.

If “Printer” is displayed when specifying the output destination in the 
printer driver, the mail bin that is selected is shown in the figure.
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5.10 Saving the driver settings

For PCL drivers, you can save the setting values of the changed driver and 
recall them as necessary. 

Saving the driver settings

1 Change the driver settings from the Setup tab and the Per Page Setting 
tab.

2 Click the [Save/Restore Setting] button, and then select “Save Current 
Setting”.

3 Enter the file name in the “Name” text box.
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4 Enter a message in the “Comment” text box as necessary.

5 Specify a folder in the “Save Location” box, and then click the [OK] but-
ton.

The settings are registered in a library.

2
Note 

The file extension is “.ksf”.

You can save up to 25 items in the library.

Up to 40 characters can be entered in the “Name” text box. In Windows 
98SE/Me, you can enter up to 40 characters.

Up to 512 characters can be entered in the “Comments” text box. In Win-
dows 98SE/Me, you can enter up to 512 characters.

Restore the settings

1 Click the [Save/Restore Setting] button on the Printing Preferences di-
alog box, and then select “Restore Saved Setting”.

2 From the “Library” list, select the desired settings file.

3 Click the [OK] button.

The setting values are recalled, and the Printing Preferences dialog box 
appears again.

Deleting the settings

1 Click the [Save/Restore Setting] button on the Printing Preferences di-
alog box, and then select “Edit Library”.

2 From the “Library” list, select the desired settings file to be deleted.

3 Click the [Delete] button.

2
Note 

Even if the settings file is deleted from the “Library” list, it will remain on 
the hard disk of your computer. By specifying the file name in “Save Set-
ting File in Library”, you can save it in the “Library” list.
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6 Setting up the PostScript driver (Win-

dows)

6.1 Settings

Common settings

The following describes the common settings and buttons that are displayed 
on all tabs.

Button Function

OK Click this button to close the dialog box and apply any settings 
that have been changed.

Cancel Click this button to cancel any settings that have been changed 
and close the dialog box.

Help Click this button to display the help for each item on the cur-
rently displayed dialog box.

Save Click this button to save the current settings and to view them 
at a later time.

Edit Click this button to change the saved settings.
C300 6-1



Setting up the PostScript driver (Windows) 6
2
Note 

To enable any installed options, you must specify the Option settings. For 
details, refer to “Specifying the Option tab settings” on page 6-25.

Setup tab

Default Click this button to return the settings to their defaults, which 
were selected when the driver was installed.

View When the [Paper View] button is clicked, a preview of the page 
layout as specified in the current settings is displayed and a 
preview image of the print job can be checked.
When the [Printer View] button is clicked, a printer figure is dis-
played showing any options, such as the paper tray, that are in-
stalled on this machine.

Item Function

Orientation Specifies the orientation of the image being printed on the paper.

Original Size Specifies the size of the original document.

Output Size Specifies the output paper size. Automatically enlarges or reduces 
when the Original Size setting is changed.

Zoom Specifies the enlargement and reduction ratio.

Paper Source Selects the paper source for printing.

Paper Type Selects the paper type for printing.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each set.

Button Function

Paper Printer
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Layout tab

Per Page Setting tab

Watermark tab

Output Tray Selects the tray where to output the printed pages.

Output Method Specifies output methods, such as “Secured Print” and “Save in 
User Box”.

User Authentication/
Account Track

Enters a user name, department name, and password for user man-
agement in the “User Authentication” and “Account Track”.

Item Function

Combination You can print multiple document pages on one page. Details can be 
specified in Combination Details.

Rotate 180 Prints the image rotated 180°.

Double Sides Specifies duplex printing.

Binding Position Specifies binding position.

Staple Specifies stapling.

Fold & Staple Specifies the center binding process.

Hole-Punch Specifies hole punching.

Item Function

Front Cover Page Attaches a front cover page.

Paper Source Selects the input tray for the front cover.

Back Cover Page Attaches a back cover page.

Paper Source Selects the input tray for the back cover.

Transparency Interleave Outputs and inserts interleaves when printing overhead projector 
transparencies.

Paper Source Selects the input tray for the transparency interleaves.

Item Function

Watermark Prints a watermark (text stamp) on the page being printed. Water-
marks can be added, changed, or deleted.

Transparent Prints the watermark with a transparent background.

1st Page Only Prints the watermark on the first page only.

Repeat Prints several watermarks on a single page.

Item Function
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Quality tab

Advanced tab

Device Settings tab

Item Function

Select Color Specifies the color for printing.

Original Image Type Specifies the contents of the original document.
Prints with a quality suitable for the original document.

Quality Adjustment Adjusts the image quality. You can select “Simple” to adjust the en-
tire document or “Detailed” to separately adjust the text, photos, 
and charts in the document.

Glossy Mode Prints using a gloss finish.

Download Fonts Selects the TrueType font type to download when downloading the 
TrueType fonts and not using the printer fonts.

Use Printer Fonts Select to enable the substitution setting of the printer fonts. If ena-
bled, the TrueType fonts to be substituted are not downloaded to 
the printer.

Item Function

Advanced Printing Fea-
tures

Specifies whether to enable detailed print functions (booklet).

PostScript Output Op-
tion

Specifies the PostScript file output format.

Send PostScript Error 
Handler

Specifies whether to print an error report when a PostScript error oc-
curs.

Mirrored Output Reverses horizontally, then prints.

PostScript Pass through Allows applications to print directly without using GDI (Graphics De-
vice Interface).

Item Function

Font Substitution Table Specifies the replacement of TrueType fonts with printer fonts.

Available PostScript 
Memory

Specifies the usable PostScript memory size.

Output Protocol Specifies the protocol for transmitting to the printer.

Send CTRL-D Before 
Each Job

Specifies whether to reset printer before printing.

Send CTRL-D After Each 
Job

Specifies whether to reset printer after printing.

Convert Gray Text to 
PostScript Gray

Specifies whether to convert gray text in a document to PostScript 
gray.

Convert Gray Graphics to 
PostScript Gray

Specifies whether to convert gray graphics in a document to Post-
Script gray.
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2
Note 

To display the Device Settings tab in Windows 2000/XP/NT 4.0/Server 
2003, right-click the icon of the installed printer, and then click “Proper-
ties”.

Option tab

2
Note 

To display the Device Information tab in Windows 2000/XP/NT 4.0/Server 
2003, right-click the icon of the installed printer, and then click “Proper-
ties”.

You cannot click the [Gather Option Information] button if you are not 
connected to or able to communicate with this machine.

Add Euro Currency Sym-
bol to PostScript Fonts

Specifies whether to convert the Euro currency symbol in a docu-
ment to PostScript fonts.

Job Timeout Printer stops printing when a print job is not completed within the 
specified time.

Wait Timeout Printer stops printing when the printer does not receive data within 
the specified time from when the job was sent. Minimum Font Size 
Downloaded as Outline.

Minimum Font Size to 
Downloaded as Outline

Specifies the minimum font size (pixels) when downloading Tru-
eType fonts as outline fonts. Fonts smaller than the minimum spec-
ified size are downloaded as bitmap fonts.

Maximum Font Size to 
Download as Bitmap

Specifies the maximum font size (pixels) when downloading Tru-
eType fonts as bitmap fonts. Fonts larger than the maximum spec-
ified size are downloaded as outline fonts.

Item Function

Option Specifies the options that are installed on this machine.

Gather Option Informa-
tion

Communicates with this machine and reads the status of the in-
stalled options.

PageScope Web Con-
nection

Starts up PageScope Web Connection.

Item Function
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Settings tab

2
Note 

To display the Settings tab in Windows 2000/XP/NT 4.0/Server 2003, 
right-click the icon of the installed printer, and then click “Properties”.

Item Function

Display Constraint Mes-
sage

Displays a message when you want to perform a function that can-
not be set when the printer driver is being used.

Use Print Server Proper-
ties Form

Uses the added registered paper in [Server Properties].
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6.2 Specifying the Setup tab settings

Printing to suit the paper size

You can enlarge or reduce documents created when printing to match the 
output paper size.

1 Click the Setup tab.

2 From the “Original Size” and “Output Size” drop-down lists, select the 
desired settings.

– You can also specify any enlargement or reduction ration in the 
“Zoom” box.
C300 6-7



Setting up the PostScript driver (Windows) 6
2
Note 

If the paper size is other than the custom size, select the desired settings 
after specifying the settings in Custom Size.

When “W” is selected for each standard paper size in the printer driver, 
the data can be centered and printed. 
For example, if A4 size data is created and you want to center and print 
on A3 size paper, specify “A4 W” as the paper size in the printer driver 
and specify “Tray 1” or “Bypass Tray” as the paper source. 
To print, load A3 size paper in the tray (“Tray 1” or “Bypass Tray”) of this 
machine that is specified in the printer driver, and then specify the set-
tings described below from [Basic Screen (Paper)] — [Change Tray Set-
tings] — [Oversized Paper] on the control panel.
Select “A4W”.
Enter the A3 paper size (420.0 × 297.0) in [Change Size].
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Saving a custom size

A custom size can be specified and saved in advance as described below.

1 From the “Original Size” and “Output Size” drop-down lists, select 
“Custom Size Settings”.

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

– Size: Specify the width and length of the custom size according to 
the selected measurement units.

3 Click the [OK] button.

If using long paper, specify the size of the long paper in Custom Size. 
For details, refer to “Printing on banner paper” on page 10-119.
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Selecting the output method

Not only can you print directly, but you can select “Secured Print”, which re-
quires a password to print, or “Save in User Box”, which saves documents 
in the document folder. 

1 Click the Setup tab.

2 From the “Output Method” drop-down list, select the output method.

– Print: Prints immediately.
– Secured Print: Saves the document to be printed in the secured 

document box of this machine. When printing, you are required to 
enter the user ID and password in this machine’s control panel. Se-
lect when printing highly confidential documents. (Up to 100 docu-
ments)

– Save in User Box: Saves the document to be printed a box on this 
machine.

– Save in User Box and Print: Saves the document in a box at the 
same time.

– Proof and Print: After a part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting 
large print jobs.
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Secured Printing

% If “Secured Print” was selected, enter the ID and password in the dialog 
box that appeared.

2
Note 

To print the document, specify [Secured] in the Box mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print job 
management” on page 10-104.

For details on the box functions of this machine, refer to the User’s Guide 
[Box Operation].

When password rules are enabled on this machine, the passwords that 
can be used for secured printing are limited and the jobs are deleted 
when a password that does not comply with the password rule is en-
tered. For the password rules, refer to User’s Guide [Copy Operations].
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Save in User Box

% When “Save in User Box” or “Save in User Box and Print” is selected, 
specify the file name and box number in the dialog box that appears for 
entering the file name and user box number.

2
Note 

For details on the box functions of this machine, refer to the User’s Guide 
[Box Operations].

When the power rules are enabled on this machine, specify the box that 
is created on this machine.

Proof and printing

% When a print job is sent, this machine stops printing temporarily after 
part of the document has been printed. The remaining print job is 
stored in this machine as a print job. When printing multiple copies, you 
can print the remaining part of the print job after checking the print re-
sults.

2
Note 

To print the document, specify the document in the Job mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print job 
management” on page 10-104.
C300 6-12



Setting up the PostScript driver (Windows) 6
Specifying user authentication settings

If user authentication settings have been specified on this machine, you must 
enter a user name and password.

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the “User Authentication” 
check box selected, the job is deleted without being authenticated by this 
machine.

When the user authentication settings are specified on this machine, the au-
thentication operation restriction function is in mode 2, and the authentica-
tion information is not entered correctly, the applicable user is locked and 
cannot be accessed.

1 Click the Setup tab.

2 Click the User Authentication/Account Track button.

3 Select the “User Authentication” check box, and then enter the user 
name and password.
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2
Note 

If this machine has been set to permit public users, the machine can be 
used without a user name and password.

If printing is not allowed, printing cannot be performed even when used 
by a registered user.

For user authentication settings, consult the administrator of this ma-
chine.
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Specifying account track settings

If account track settings have been specified on this machine, you must en-
ter a department name and password.

If a print job is sent using a department name or password that is not a reg-
istered account or if a job is sent without the “Track Account” check box se-
lected, the job is deleted without being authenticated by this machine.

When the account authentication settings are specified on this machine, the 
authentication operation restriction function is in mode 2, and the authenti-
cation information is not entered correctly, the applicable account is locked 
and cannot be accessed.

1 Click the Setup tab.

2 Click the User Authentication/Account Track button.

3 Select the “Account Track” check box, and then enter the department 
name and password.

2
Note 

If printing is not allowed, printing cannot be performed even when used 
by a registered account.

For the account track details, consult the administrator of this machine.
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6.3 Specifying the Layout tab settings

Printing multiple pages on one page (N in 1)

You can print multiple document pages on one page. You can also specify 
the “Booklet” setting to fold the printouts in two to make a booklet.

The booklet printing function is available only when the optional ADU is in-
stalled.

1 Click the Layout tab.

2 From the “Combination” drop-down list, select the number of pages to 
be printed on one page.
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To change the border line and printing order settings, click the [Com-
bination Details] button, and then change the settings in the dialog box 
that appears.

2
Note 

When printing a job that contains pages of different sizes and orienta-
tions, images may be missing or overlapping when the document is print-
ed.
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Duplex printing

You can print a document onto both sides of a page. This comes in handy 
when you want to bind multiple-page documents.

1 Click the Layout tab.

2 From the “Double Sides” drop-down list, select “Double-Sided”.

2
Note 

The binding orientation can be specified from the “Binding Position” 
drop-down list.

2
Note 

The duplex printing function is available only when the optional ADU is 
installed.

Setting the file margin

File margins are added to the document before it is printed.

1 Click the Layout tab.

2 From the “Binding Position” drop-down list, select the position of the 
binding margin.

Stapling

Multiple-page documents can be stapled.

The staple function is available only when optional finisher is installed.

1 Click the Layout tab.

2 From the “Staple” drop-down list, specify the number of staples and 
the stapling position.

2
Note 

Depending on the selected Binding Position setting, different stapling po-
sitions are available.
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Fold & Staple

You can specify to center staple and fold a printed document.

1 Click the Layout tab.

2 From the drop-down list, specify the folding condition.

You can specify “Fold & Staple” to fold and staple a document, “Center 
Staple” to staple a document in the center, or “Fold” to fold a docu-
ment in half.

2
Note 

The Fold & Staple function is available only when saddle stitcher SD-503 
is installed on optional finisher FS-514.

Hole punching

Holes can be punched into the printed document.

The hole punch function is available only when optional finishers FS-514 and 
punch kit PK-510 are installed.

1 Click the Layout tab.

2 From the “Hole-Punch” drop-down list, select the number of punched 
holes.

2
Note 

Depending on the selected Binding Position setting, different hole-
punching positions are available.
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6.4 Specifying the Per Page Setting tab settings

Printing documents with a front cover/back cover

1 Click the Per Page Setting tab.

2 From the “Front Cover Page” and “Back Cover Page” drop-down lists, 
select the desired printing settings.

To print on the front cover and back cover, select “Printed”. To only 
add a blank page, select “Blank”.

3 Select the input tray that contains the loaded paper for the front cover 
and back cover.
C300 6-20



Setting up the PostScript driver (Windows) 6
6.5 Specifying the Watermark tab settings

Printing a watermark

You can print specific text in the background as a watermark.

1 Click the Watermark tab.

2 From the drop-down list, select the watermark that you want to print.

3 Specify settings for the following:

Transparent: The watermark is transparent.
1st Page Only: Prints the watermark only on the first page.
Repeat: Prints several watermarks on one page.

2
Note 

If “Booklet” was selected in the “Combination” drop-down list, the water-
mark is not printed.
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Editing a watermark

You can change the fonts and position of the watermark and you can register 
a new one.

1 Click the Watermark tab.

2 To create a watermark, click the [Add] button.

– To change a watermark, select the watermark to be changed, and 
then click the [Edit] button.

3 Specify settings for the following:

Watermark Name: Specifies the watermark name being registered.
Watermark Text: Specifies the watermark text.
Font Name, Size, Style, Angle, Color, and Frame: Specifies the font, 
font size, style, text angle, color, and frame of the watermark.
Position: Specifies the watermark position with the horizontal and ver-
tical scroll bars.
Sharing: Specifies whether to share the watermark with other users.

2
Note 

Only the administrator can select a setting under “Sharing”.
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6.6 Specifying the Quality tab settings

Specifying settings

1 Click the Quality tab.

2 Specify settings for the following:

– Original Image Type
Specifies the contents of the original document. Prints with a qual-
ity suitable for the original document.
Document: Prints with a quality suitable for documents with many 
characters.
Photo: Prints with a quality suitable for photos.
DTP: Prints with a quality suitable for documents produced using 
DTP.
Web: Appropriate for printing web pages. Smoothly reproduces 
low resolution images.
CAD: Appropriate for originals composed of fine lines. Reproduces 
images with high resolution.

– Select Color
Color: Prints in color.
Grayscale: Prints in grayscale.
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– Quality Adjustment
Detailed: Separately adjusts the quality of each item (text, photos, 
and charts) in the document.

– Glossy Mode 
Prints using a gloss finish.

Font settings

You can replace the TrueType fonts used in Windows with the printer fonts 
of this machine.

1 Click the [Font Settings] button.

2 Specify settings for the following:

Download Font Format: Select the TrueType font type to download 
when downloading the TrueType fonts and not using the printer fonts.
User Printer Fonts: Select to enable the substitution setting of the print-
er fonts. If enabled, the TrueType fonts to be substituted are not down-
loaded to the printer.

2
Note 

Using the printer fonts will shorten the printing time, however, there may 
be a difference in the screen display and the print results.

When using TrueType fonts, select from the “Download Font Format” 
drop-down list the font type to be downloaded to the printer.

Specify the font replacement list from the Device Settings tab.
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6.7 Specifying the Option tab settings

You can enable the options installed on this machine to be used from the 
printer driver by specifying whether the models or options are available.

2
Note 

If the installed options are not set from the Option tab, the option function 
cannot be used with the printer driver. When installing options, be sure to 
make the proper settings.

Specifying settings

1 For Windows 2000/NT 4.0, click the [Start] button, point to “Settings”, 
and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click 
“Printers and Faxes”.

– If “Printers and Faxes” does not appear in the Start menu, open the 
Control Panel from the Start menu, select “Printers and Other Hard-
ware”, and then select “Printers and Faxes”.
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2 Right-click the printer icon, and then click “Properties”.

3 Click the Option tab.

4 Select “Model” from the list, and then select the model to be used from 
the “Setting” drop-down list.

5 Select the option, and then specify the installation status from the 
drop-down list below.
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2
Note 

The installed option can be automatically registered in the “Option” list by 
clicking the [Gather Option Information] button when connected to this 
machine. 

The [Gather Option Information] button can only be used when the SNMP 
setting is enabled on this machine and the SNMP v1/v2c (IP) setting 
check box is selected. 

When the Mail Bin Kit is installed, you can assign output tray 1 and output 
tray 2 as mail bins.

To assign the output destination of the mail bins, select “Bin Setting” 
from “Administrator Setting” - “System Setting” - “Output Setting” on the 
control panel.

If “Printer” is displayed when specifying the output destination in the 
printer driver, the mail bin that is selected is shown in the figure.
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6.8 Saving the driver settings

For PostScript drivers, you can save the setting values of the changed driver 
and recall them as necessary. 

Saving the driver settings

1 Change the driver settings from the Setup tab and the Layout tab.

2 Click the [Save] button.
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3 Enter the file name in the “Name” text box.

4 Enter a message in the “Comment” text box as necessary.

5 Specify whether to share the driver settings being saved with other us-
ers.

6 Click the [OK] button.

The settings are registered in a library.

2
Note 

The file extension is “.ksf”.

You can save up to 25 items.

Only the administrator can select a setting under “Sharing”.

Restore the settings

% Select the settings to restore from the “Easy Set” drop-down list on the 
Printing Preferences dialog box.
The setting values are recalled, and the Printing Preferences dialog box 
appears again.
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Changing the settings

1 On the Printing Preferences dialog box, click the [Edit] button.

2 From the list, select the file that you want to change, and then change 
the setting. To delete the file, click the [Delete] button.

3 Click the [Options] button, check the settings to recall, and then click 
the [OK] button.

4 Click the [OK] button.
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7 Setting up the PPD driver (Windows)

7.1 Settings

Paper tab

Item Function

Paper size Specifies the paper size.

Layout Specifies the number of pages printed on one page.

Orientation Specifies the orientation.

Rotated Rotates the paper.

Paper source Selects the input tray.

Copies Specifies the number of copies to print.

More Options Specifies the paper type and output device.
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Graphics tab

Device Options tab

To specify the following printer-specific options, right-click the printer icon in 
the Printers window, and then click “Properties” in the menu that appeared.

Item Function

Resolution Specifies the print resolution.

Color Control Specifies whether to adjust the color to that on the screen.

Halftoning Specifies the halftone number of lines and the pattern angle.

Special Prints a negative or mirror image.

Scaling Specifies the enlargement and reduction ratio.

Item Function

Collated Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each set.

Binding Position Specifies the binding position.

Duplex Specifies duplex printing.

Combination Specifies booklet printing.

Staple Performs stapling.

Hole Punch Performs hole punching.

Fold & Staple Performs folding.

Front Cover Page Attaches a front cover page.

Paper Tray 
(Front Cover Page) 

Selects the input tray for the front cover.

Back Cover Page Attaches a back cover page.

Paper Tray 
(Back Cover Page) 

Selects the input tray for the back cover.

Transparency Interleave Inserts interleaves between overhead projector transparencies.

Paper Tray (Transparen-
cy Interleave) 

Selects the input tray for the transparency interleaves.

Wait Mode Stops printing temporarily after part of the document has been print-
ed so that the proof print can be checked.

Select Color Specifies whether to print in color or grayscale.

Glossy Mode Prints using a gloss finish.

Original Image Type Prints with a quality suitable for the original document.

Color Matching (Text) Adjusts the color quality of the text in a document.

Pure Black (Text) Specifies whether to enable grayscale of the text in a document.

Screen (Text) Specifies screening of the text in a document.
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You can specify the following options by right-clicking the printer icon in the 
Printers window, then clicking “Properties”.

PostScript tab

Fonts tab

Color Matching (Photo) Adjusts the color quality of photos in a document.

Pure Black (Photo) Specifies whether to enable grayscale of photos in a document.

Screen (Photo) Specifies screening of photos in a document.

Smoothing (Photo) Specifies smoothing of photos in a document.

Color Settings (Graphic) Adjusts the color quality of a chart and graph in a document to the 
text or photo settings.

Smoothing (Graphic) Adjusts the smoothing process of a chart and graph in a document 
to the text or photo settings.

Item Function

Available printer memory Specifies the memory installed on this machine.

Installable options Specifies the options installed on this machine.

Item Function

PostScript output format Specifies the PostScript file output method.

PostScript header Specifies whether to transmit header information to the printer.

Print PostScript error in-
formation

Specifies whether to print PostScript error reports.

PostScript timeout value Specifies the time for a timeout.

Item Function

Send TrueType fonts to 
the printer according to 
the font Substitution Ta-
ble

Prints the font specified in the Font Substitution Table with the print-
er fonts.
The Font Substitution Table can be specified by clicking the [Edit the 
Table] button.

Always use built-in print-
er fonts instead of Tru-
eType fonts

Prints all fonts with printer fonts.

Always use TrueType 
fonts

The printer fonts are not substituted.

Send Fonts As Specifies the font transmission method.

Item Function
C300 7-3



Setting up the PPD driver (Windows) 7
7.2 Specifying the Paper tab settings

You can specify the orientation and number of pages to be printed on one 
page when printing.

Specifying settings

1 Click the Paper tab.

2 Specify settings for the following:

Paper size: Specifies the paper size.
Layout: Specifies printing multiple pages on one page (N in 1 printing).
Orientation: Specifies the orientation
Rotated: Rotates the paper.
Paper source: Selects the input tray.
Copies: Specifies the number of copies to print.
More Options: Specifies the paper type and output device.
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7.3 Specifying the Device Options tab settings

You can specify advanced functions such as the finisher function and color 
adjustments from the Device Options tab.

Specifying setting

1 Click the Device Options tab.

2 Select a function, and then select the setting from the “Change setting 
for” drop-down list.

2
Note 

For the items and functions that can be specified, refer to “Settings” on 
page 7-1.
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2
Note 

The duplex printing function is available only when the optional ADU is 
installed.

The staple function is available only when the optional finisher FS-514 is 
installed.

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.

The Fold & Staple function is available only when saddle stitcher SD-503 
is installed on optional finisher FS-514.
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7.4 Specifying the options

You can specify the options installed on this machine so that they can be 
used from the printer driver.

If the installed options are not set from the Device Options tab, the option 
function cannot be used with the printer driver. When installing options, be 
sure to make the proper settings.

Specifying settings

1 For Windows 98SE/Me, click the [Start] button, point to “Settings”, and 
then click “Printers”.

2 Right-click the printer icon, and then click “Properties”.

3 Click the Device Options tab.

4 Select a function, and then select the setting from the “Change setting 
for” drop-down list.

2
Note 

For the items and functions that can be specified, refer to “Settings” on 
page 7-1.
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8 Setting up the PPD driver (Mac OS 9.2)

8.1 Settings

The functions of this machine can be specified on the Paper Setup and Print 
dialog boxes displayed from an application.

The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their defaults.

Page Setup dialog box
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Page Setup items

2
Note 

Depending on the application, “Page Setup” may be displayed as “Paper 
Setup”. In addition, you may have to select “Paper Setup”—“Options” 
from the “File” menu.

The dialog boxes differ depending on the application.

Menu Item Function

Page Attributes Paper Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

PostScript Options Flip Horizontal Prints the image flipped horizontally.

Flip Vertical Prints the image flipped vertically.

Invert Image Prints a negative image.

Substitute Fonts Replaces some fonts with printer fonts.

Smooth Text Smooths text data.

Smooth Graphics Smooths graphic data.

Precision Bitmap 
Alignment

Corrects jagged graphic images.

Unlimited Download-
able Fonts

Does not limit downloading screen fonts.

Custom Page Sizes Paper Size Specifies any paper size.

Margins Specifies the paper margins.

Custom Page Size 
Name

Enters the registered name for the specified paper 
size and margin after the [OK] button is clicked.

Units Selects the specified unit.
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Print dialog box

Print item

Menu Item Function

General Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.

Paper Source Selects the input tray.

Color Matching Print Color Specifies the color for printing.

Intent Selects the matching method.

Printer Profile Specifies the color adjustment profile of the out-
put device.

Background Print-
ing

Print in Specifies background printing.

Print Time Specifies the priority level and print time.

Save as File Format Specifies the output format of the PostScript 
file.

PostScript Level Specifies the PostScript level.

Data Format Specifies the format to save a document.

Font Inclusion Specifies whether to include the font data on a 
file.

Font Settings Font Documentation Adds information to the font key.

Font Downloading Specifies the conditions to download fonts.
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Layout Pages per sheet Specifies the number of pages to print on one 
page.

Layout direction Specifies the page order for printing multiple 
pages on one page.

Border Specifies the borders around pages.

Job Logging If there is a PostScript 
error

Specifies the PostScript error report conditions.

Job Documentation Specifies the conditions for the operation record 
to be saved.

Job Documentation 
Folder

Specifies the folder to which the operation 
record is to be saved.

Cover Page Print Cover Page Attaches a cover.

Cover Page Paper 
Source

Selects the cover input tray.

Finishing Options 1 Offset Specifies offset.

Output Tray Selects the output tray.

Binding Position Selects the binding position.

Duplex Performs duplex printing.

Combination Selects booklet printing.

Staple Performs stapling.

Punch Performs hole punching.

Finishing Options 2 Fold & Staple Performs folding.

Front Cover Page Attaches a front cover page.

Paper Tray 
(Front Cover Page)

Selects the input tray for the front cover.

Back Cover Page Attaches a back cover page.

Paper Tray 
(Back Cover Page)

Selects the input tray for the back cover.

Transparency Inter-
leave

Inserts interleaves between overhead projector 
transparencies.

Paper Tray (Transpar-
ency Interleave)

Selects the input tray for the transparency inter-
leaves.

Menu Item Function
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2
Note 

The dialog boxes differ depending on the application.

Finishing Options 3 Wait Mode Stops printing temporarily after part of the doc-
ument has been printed so that the proof print 
can be checked.

Resolution Specifies the print resolution.

Select Color Specifies whether to print in color or grayscale.

Glossy Mode Prints using a gloss finish.

Original Image Type Prints with a quality suitable for the original doc-
ument.

Color Matching (Text) Adjusts the color quality of the text in a docu-
ment.

Pure Black (Text) Specifies whether to enable grayscale of the text 
in a document.

Finishing Options 4 Screen (Text) Specifies screening of the text in a document.

Color Matching 
(Photo)

Adjusts the color quality of photos in a docu-
ment.

Pure Black (Photo) Specifies whether to print the photos in a docu-
ment in grayscale.

Screen (Photo) Specifies screening of photos in a document.

Smoothing (Photo) Specifies smoothing of photos in a document.

Color Setting 
(Graphic)

Adjusts the color quality of charts and graphs in 
a document to the text or photo settings.

Smoothing (Graphic) Adjusts the smoothing process of a chart and 
graph in a document to the text or photo set-
tings.

Menu Item Function
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8.2 Page Setup

Page Attributes (basic settings)

1 Select “Paper Setup” or “Page Setup” from the “File” menu.

2 Select “Page Attributes”.

3 Specify settings for the following:

Paper: Specifies the paper size.
Orientation: Specifies the orientation.
Scale: Specifies the enlargement and reduction ratio.

2
Note 

The folding function can be selected from the screen that is displayed 
when “Layout” is selected in the Print dialog box.
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Custom Page Sizes

1 Select “Paper Setup” or “Page Setup” from the “File” menu.

2 Select “Custom Page Sizes”.

3 Click the [New] button.

4 Specify settings for the following:

Paper Size: Specifies the paper size.
Margins: Specifies the paper margins.
Custom Page Size Name: Enter the registered name for the specified 
paper size and margin, and then click the [OK] button.
Units: Selects the specified unit.

5 Click the [OK] button.

This registers the custom page settings, and allows you to select the 
paper in the screen that appears when “Page Attributes” is selected.
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PostScript Options

1 Select “Paper Setup” or “Page Setup” from the “File” menu.

2 Select “PostScript Options”.

3 Specify settings for the following:

Visual Effects: Provides “Flip Horizontal”, “Flip Vertical”, and “Invert 
Image” (negative image).
Substitute Fonts: Replaces some fonts with printer fonts.
Smooth Text: Smooths text data.
Smooth Graphics: Smooths graphic data.
Precision Bitmap Alignment: Corrects jagged graphic images.
Unlimited Downloadable Fonts: Does not limit downloading screen 
fonts.
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8.3 Printing

General (basic settings)

1 From the “File” menu, select “Print”.

2 Select “General”.

3 Specify settings for the following:

Copies: Specifies the number of copies to print.
Collated: Prints multiple copies in sets.
Pages: Specifies the print range to print.
Paper Source: Selects the input tray.
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Layout (printing multiple pages on one page)

You can specify printing multiple pages on one page of paper or duplex 
printing.

1 From the “File” menu, select “Print”.

2 Select “Layout”.

3 Specify settings for the following:

Pages per sheet: Specifies the number of pages to print on one page.
Layout direction: Specifies the document page order.
Border: Specifies the borders around pages.
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Printer specific options (Finishing Options 1 to 4)

You can specify printer-specific options. You can specify this option when 
using the staple or hole punch functions of this machine.

1 From the “File” menu, select “Print”.

2 Select “Finishing Options 1 to 4”.

3 Specify settings for the following:

Offset: Specifies offset.
Output Tray: Selects the output tray.
Binding Position: Specifies the binding position.
Duplex: Performs duplex printing.
Combination: Specifies booklet printing.
Staple: Performs stapling.
Punch: Performs hole punching.
Fold & Staple: Performs folding.
Front Cover Page: Attaches a front cover page.
Paper Tray (Front Cover Page): Selects the input tray for the front cov-
er.
Back Cover Page: Attaches a back cover page.
Paper Tray (Back Cover Page): Selects the input tray for the back cov-
er.
Transparency Interleave: Inserts interleaves between overhead projec-
tor transparencies.
Paper Tray (Transparency Interleave): Selects the input tray for the 
transparency interleaves.
Wait Mode: Stops printing temporarily after part of the document has 
been printed so that the proof print can be checked.
Resolution: Specifies the resolution.
Select Color: Specifies whether to print in color or grayscale.
Glossy Mode: Prints using a gloss finish.
Original Image Type: Prints with a quality suitable for the original doc-
ument.
Color Matching (Text): Adjusts the color quality of the text in a docu-
ment.
Pure Black (Text): Specifies whether to enable grayscale of the text in 
a document.
Screen (Text): Specifies screening of the text in a document.
Color Matching (Photo): Adjusts the color quality of photos in a docu-
ment.
Pure Black (Photo): Specifies whether to enable grayscale of photos in 
a document.
Screen (Photo): Specifies screening of photos in a document.
Smoothing (Photo): Specifies smoothing of photos in a document.
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Color Setting (Graphic): Adjusts the color quality of a chart and graph 
in a document to the text or photo settings. 
Smoothing (Graphic): Adjusts the smoothing process of a chart and 
graph in a document to the text or photo settings.

2
Note 

The duplex printing function is available only when the optional ADU is 
installed.

The staple function is available only when the optional finisher FS-514 is 
installed.

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.

The Fold & Staple function is available only when saddle stitcher SD-503 
is installed on optional finisher FS-514.
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8.4 Setting options

You can specify the options installed on this machine so that they can be 
used from the printer driver.

2
Reminder 

If the installed options on this machine are not set from the Installable Op-
tions screen, the option function cannot be used with the printer driver. 
When installing options, be sure to make the proper settings.

Specifying settings

1 On the Apple menu, click “Chooser”.

2 Select the printer name.

3 Click the [Setup] button.

4 Click the [Configure] button.

The setting screen for adding options appears.

5 Select the option that is installed on this machine from Options In-
stalled 1 and Options Installed 2.

6 Click the [OK] button.

The Chooser window appears again.

7 Close the Chooser window.
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2
Note 

The option settings are displayed automatically the first time the printer 
driver is selected. For details, refer to “Selecting a printer” on page 2-18.
C300 8-14



Setting up the PPD driver (Mac OS X) 9
9 Setting up the PPD driver (Mac OS X)

9.1 Settings

The functions of this machine can be specified on the Paper Setup and Print 
dialog boxes displayed from the application.

The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their defaults.

Page Setup dialog box

Page Setup items

Menu Item Function

Page Attributes Paper Size Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.

Custom Paper Size Paper Size
(Page Size)

Specifies any paper size.

Printer Margins Specifies the paper margins.
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2
Note 

Depending on the application, “Page Setup” may be displayed as “Paper 
Setup”. In addition, you may have to select “Paper Setup”—“Options” 
from the “File” menu.

The dialog boxes differ depending on the application.

To specify the “Custom Paper Size” settings for Mac OS 10.4, select 
“Manage Custom Sizes” from the “Paper Size” drop-down list.

Print dialog box

Print item

Menu Item Function

Copies & Pages Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.

Layout Pages per Sheet Specifies the number of pages to print on one 
page.

Layout Direction Specifies the document page order.

Border Specifies the borders around pages.

Output Options*2 Save as File Specify the output format of a file.

Format Specifies the format of the file being output.

Scheduler*1 Print Document Specifies the print time.

Priority Specifies the priority level.
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Paper Handling*1 Reverse Page 
Order (Page Order)

Prints pages in the reverse order.

Print Selects the pages for printing.

Destination paper 
size*3

Specifies the output paper size.

ColorSync*1 Color Conversion Specifies the color conversion method.

Quartz Filter Specifies the color for printing.

Cover Page*1 Print Cover Page Specifies whether to attach a cover page.

Cover Page Type Selects to print “Confidential” or other comments 
on the cover page.

Billing Info Enter the user information used for the account 
calculation.

Error Handling PostScript Errors Specifies whether to print an error report when a 
PostScript error occurs.

Tray Switching Switches the paper source tray (this function can-
not be selected on this machine).

Paper Feed All pages from Selects the input tray.

First page from Selects the input tray.

Remaining from Selects the input tray.

Finishing Collate Prints multiple copies in sets.

Offset Specifies offset.

Duplex Performs duplex printing.

Output Tray Selects the output tray.

Binding Position Specifies the binding position.

Combination Specifies booklet printing.

Staple Performs stapling.

Hole-Punch Performs hole punching.

Fold & Staple Performs folding.

Menu Item Function
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Quality Resolution Specifies the resolution (this function cannot be 
selected on this machine).

Select Color Selects the color for printing.

Glossy Mode Prints using a gloss finish.

Original Image Type Prints with a quality suitable for the original docu-
ment.

Color Matching 
(Text)

Adjusts the color quality of the text in a document.

Pure Black (Text) Specifies whether to enable grayscale of the text in 
a document.

Screen (Text) Specifies screening of the text in a document.

Color Matching 
(Photo)

Adjusts the color quality of photos in a document.

Pure Black (Photo) Specifies whether to enable grayscale of photos in 
a document.

Screen (Photo) Specifies screening of photos in a document.

Smoothing (Photo) Specifies smoothing of photos in a document.

Color Setting 
(Graphic)

Adjusts the color quality of a chart and graph in a 
document to the text or photo settings.

Smoothing (Graph-
ic)

Adjusts the smoothing process of a chart and 
graph in a document to the text or photo settings.

Setup Paper Tray Selects the paper type.

Front Cover Page Attaches a front cover page.

Paper Tray (Front 
Cover Page)

Selects the input tray for the front cover.

Back Cover Page Attaches a back cover page.

Paper Tray (Back 
Cover Page)

Selects the input tray for the back cover.

Transparency Inter-
leave

Inserts interleaves between overhead projector 
transparencies.

Paper Tray (Trans-
parency Interleave)

Selects the input tray for the transparency inter-
leaves.

Security Output Method Specifies output methods, such as “Secure Print” 
and “Save in User Box”.

Secure Print Set-
tings

Specifies user ID and password for “Secure Print”.

Save in User Box 
Settings

Specifies the file name and box name for “Save in 
User Box”.

User Authentication Checks if user authentication settings have been 
applied and specifies user Name and password.

Account Track Checks if account track settings have been ap-
plied and specifies the department name and 
password.

Menu Item Function
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2
Note 

The dialog boxes differ depending on the application.

The items indicated by “*1” are displayed in Mac OS 10.3 and Mac OS 
10.4.

The items indicated by “*2” are displayed only in Mac OS 10.3.

The items indicated by “*3” are displayed only in Mac OS 10.4.
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9.2 Page Setup

Page Attributes (basic settings)

1 Select “Page Setup” or “Paper Setup” from the “File” menu.

2 Select “Page Attributes”.

3 Specify settings for the following: 

Paper Size: Specifies the paper size.
Orientation: Specifies the orientation.
Scale: Specifies the enlargement and reduction ratio.
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2
Note 

If the paper size is any size other than the custom size, select the desired 
settings after specifying the settings in Custom Paper Size.

When “W” is selected for each standard paper size in the printer driver, 
the data can be centered and printed. 
For example, if A4 size data is created and you want to center and print 
on A3 size paper, specify “A4 W” as the paper size in the printer driver 
and specify “Tray 1” or “Bypass Tray” as the paper source. 
To print, load A3 size paper in the tray (“Tray 1” or “Bypass Tray”) of this 
machine that is specified in the printer driver, and then specify the set-
tings described below from [Basic Screen (Paper)] — [Change Tray Set-
tings] — [Oversized Paper] on the control panel.
Select “A4W”.
Enter the A3 paper size (420.0 × 297.0) in [Change Size].
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Custom Paper Size

1 Select “Page Setup” or “Paper Setup” from the “File” menu.

2 For Mac OS 10.3, select “Custom Paper Size” from “Settings”. For Mac 
OS 10.4, select “Manage Custom Sizes” from the “Paper Size” drop-
down list.

3 Click the [New] (Mac OS 10.3) or [+] (Mac OS 10.4) button.

4 Enter the paper size name.

5 Specify settings for the following:

Paper Size: Specifies any paper size.
Printer Margins: Specifies the paper margins.

6 For Mac OS 10.3, click the [Save] button. For Mac OS 10.4, proceed to 
step 7.

7 Click the [OK] button.

This registers the custom paper size which allows you to select the pa-
per size in the screen that appears when “Page Attributes” is selected.
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9.3 Printing

Copies & Pages (general settings)

1 From the “File” menu, select “Print”.

2 Select “Copies & Pages”.

3 Specify settings for the following:

Copies: Specifies the number of copies to print.
Collated: Print multiple copies in sets.
Pages: Specifies the print range to print.
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Layout (printing multiple pages on one page)

You can print multiple pages on one sheet.

1 From the “File” menu, select “Print”.

2 Select “Layout”.

3 Specify settings for the following:

Pages per Sheet: Specifies the number of pages to print on one page.
Layout Direction: Specifies the document page order.
Border: Specifies the borders around pages.
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Paper Feed

You can specify the input tray for printing.

1 From the “File” menu, select “Print”.

2 Select “Paper Feed”.

3 Specify settings for the following:

All pages from: Selects the input tray to print all pages.
First page from: Selects the input tray to print the first page.
Remaining from: Selects the input tray to print from the second page.

Security

Not only can you print directly, but you can select “Secure Print”, which re-
quires a password to print, “Save in User Box”, which saves documents in a 
box, “Proof and Print”, which prints the first set of multiple copies and tem-
porarily stops printing, “Authentication Settings”, which requires user au-
thentication, and “Account Track Settings”, which manages the number of 
printed pages.

1 From the “File” menu, select “Print”.

2 Select “Security”.

3 Specify settings for the following:

Output Method: Specifies conditions for “Secure Print” and “Save in 
User Box”.
Secure Print Settings: Enters ID and password when “Secure Print” is 
selected from the “Output Method” drop-down list. Enter the ID and 
password on this machine’s control panel when printing. (Up to 100 
documents)
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Save in User Box Settings: Enters file name and box number when 
“Save in User Box” or “Save in User Box and Print” is selected from the 
“Output Method” drop-down list.
When the power rules are enabled on this machine, specify the box that 
is created on this machine.
User Authentication: Enters the user name and password when the 
user authentication settings have been applied on this machine and 
when the check box is selected. If this machine has been set to permit 
public users, the machine can be used without a user name and pass-
word.
Account Track: Enters the department name and password when the 
account track settings have been applied on this machine and when 
the check box is selected.
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2
Note 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the “User Authentica-
tion” check box selected, the job is deleted without being authenticated 
by this machine.

If a print job is sent using a department name or password that is not a 
registered account or if a job is sent without the “Track Account” check 
box selected, the job is deleted without being authenticated by this ma-
chine.

When the user authentication or account authentication settings are 
specified on this machine, the authentication operation restriction func-
tion is in mode 2, and the authentication information is not entered cor-
rectly, the applicable user or account is locked and cannot be accessed.

If this machine has been set to permit public users, the machine can be 
used without a user name and password.

If printing is not allowed, printing cannot be performed even when used 
by a registered user or registered account.

For the user authentication and account track details, consult the admin-
istrator of this machine.

Print the “Proof and Print” and “Secure Print” documents from the con-
trol panel of this machine. For details, refer to “Print job management” on 
page 10-104.

For details on the box functions of this machine, refer to the User’s Guide 
[Box Operations].

When password rules are enabled on this machine, the passwords that 
can be used for secured printing are limited and the jobs are deleted 
when a password that does not comply with the password rule is en-
tered.

For the password rules, refer to User’s Guide [Copy Operations].
C300 9-13



Setting up the PPD driver (Mac OS X) 9
Finishing

You can specify these options when using the staple or hole punch finisher 
functions of this machine.

1 From the “File” menu, select “Print”.

2 Select “Finishing”.

3 Specify settings for the following:

Collate: Prints multiple copies in sets.
Offset: Specifies offset.
Duplex: Performs duplex printing.
Output Tray: Selects the output tray.
Binding Position: Specifies the binding position.
Combination: Specifies booklet printing.
Staple: Performs stapling.
Hole-Punch: Performs hole punching.
Fold & Staple: Performs folding. 
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2
Note 

The duplex printing and booklet printing functions are available only 
when the optional ADU is installed.

The staple function is available only when the optional finisher FS-514 is 
installed.

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.

The Fold & Staple function is available only when saddle stitcher SD-503 
is installed on optional finisher FS-514.
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Quality

1 From the “File” menu, select “Print”.

2 Select “Quality”.

3 Specify settings for the following:

Resolution: Specifies the resolution.
Select Color: Selects the color for printing.
Glossy Mode: Prints using a gloss finish.
Original Image Type: Prints with a quality suitable for the original doc-
ument.
Color Matching (Text): Adjusts the color quality of the text in a docu-
ment.
Pure Black (Text): Specifies whether to enable grayscale of the text in 
a document.
Screen (Text): Specifies screening of the text in a document.
Color Matching (Photo): Adjusts the color quality of photos in a docu-
ment.
Pure Black (Photo): Specifies whether to enable grayscale of photos in 
a document.
Screen (Photo): Specifies screening of photos in a document.
Smoothing (Photo): Specifies smoothing of photos in a document.
Color Settings (Graphic): Adjusts the color quality of a chart and graph 
in a document to the text or photo settings. 
Smoothing (Graphic): Adjusts the smoothing process of a chart and 
graph in a document to the text or photo settings.
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Setup

You can specify the cover settings.

1 From the “File” menu, select “Print”.

2 Select “Setup”.

3 Specify settings for the following:

Paper Type: Selects the paper type.
Front Cover Page: Attaches a front cover page.
Paper Tray (Front Cover Page): Selects the input tray for the front cov-
er.
Back Cover Page: Attaches a back cover page.
Paper Tray (Back Cover Page): Selects the input tray for the back cov-
er.
Transparency Interleave: Inserts interleaves between overhead projec-
tor transparencies.
Paper Tray (Transparency Interleave): Selects the input tray for the 
transparency interleaves.
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9.4 Setting options

You can specify the options installed on this machine so that they can be 
used from the printer driver.

2
Reminder 

If the installed options on this machine are not set from the Installable Op-
tions screen, the option function cannot be used with the printer driver. 
When installing options, be sure to make the proper settings.

Specifying settings

1 Open Print Center or Printer Setup Utility, located in “Applications”—
“Utilities” of “Hard Disk” and specify the printer model.

2 From the “Printer” menu, select “Show Info”. 

The “Printer Info” dialog box appears.

3 Select “Installable Options”.

4 Select the option that is installed on this machine.

5 Click the [Apply Changes] button or click [ ] to close the Printer info 
dialog box.
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9.5 Saving the driver settings

For Mac OS X drivers, you can save the setting values of the changed driver 
and recall them as necessary.

Saving the driver settings

1 Change the driver settings in “Copies & Pages” and “Layout”.

2 From “Presets”, click “Save As”.

3 Enter the “Save Preset As”.

4 Click the “OK” button.

The setting are registered in the preset settings.

Restore the settings

% Select “Presets” from the “Print” dialog box to recall the settings.
The settings are recalled, and the printer driver dialog box appears 
again.
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Changing the settings

1 Select “Presets” from the “Print” dialog box to change the settings.

2 Change the driver settings in “Copies & Pages” and “Layout”.

3 From “Presets”, click “Save”.

To delete, click “Delete”. To change the name, click “Rename”.
The preset settings are changed.
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10 Various settings

10.1 Print settings in Utility mode

You can change the various print settings on the control panel of this ma-
chine.

Default settings

To display the Utility Setting screen

1 Press the [Utility/Counter] key.

2 Touch [2 User Setting].

Utility/
Counter
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The User Setting screen appears.

2
Note 

In Utility mode, an item can also be selected by pressing the key in the 
keypad for the number beside the desired button. For “2 User Setting”, 
press the [2] key in the keypad.

To quit specifying the Utility mode setting, touch [Exit] in the sub display 
area or press the [Utility/Counter] key. Otherwise, cancel the Utility mode 
by touching [Close] in each screen until the screen for the Copy, Fax, 
Scan or Box mode appears.

PDL Setting

You can specify the PDL (Page Description Language) setting. (Default set-
ting: Auto)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [PDL Setting].
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4 Touch the button for the desired setting.

– Auto: Automatically switches between PCL and PS.
– PCL: Only uses PCL.
– PS: Only uses PS.

Number of Sets

You can specify the default number of copies when no setting has been 
specified from the printer driver. (Default setting: 1 set)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [Number of Sets].
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4 Press the [C] (clear) key to erase the value, and then use the keypad to 
type in the default number of copies (between 1 and 999 sets).

– If a value outside of the allowable range is specified, the message 
“Input Error” appears. Type in a value within the allowable range.

5 Touch [OK].

The default number of copies is set.
To cancel changes to the settings, touch [Cancel].

Original Direction

You can specify the default image orientation. (Default setting: Portrait)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [Original Direction].
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4 Touch the button for the desired setting.

– Portrait: The image is printed vertically on the page.
Landscape: The image is printed horizontally on the page.

Spool Setting

You can set whether or not a spool is used. (Default setting: ON)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [Spool Print Jobs in HDD before RIP].

4 Touch the button for the desired setting.

– ON: When the next job is received while processing a job, the print 
data is stored in the HDD.
OFF: The print data is not stored in the HDD.
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2
Note 

Be sure not to change the setting to “OFF”. Printing may not be possible.

Paper Size Change

You can specify whether similar paper sizes 8-1/2 × 11 and A4, and 11 × 17 
and A3 are substituted for each other when there is no paper of the size 
specified with the printer driver. (Default setting: OFF)

0 The image may be defected since printing is forced.

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [A4/A3 ← → LTR/LGR Auto Switch].
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4 Touch the button for the desired setting.

Banner Setting

You can specify whether to print banner pages (cover pages) with the sender 
of the print job and title. (Default setting: OFF)

ON: Prints banner pages.

OFF: Does not print banner pages.

1 On the User Setting screen, touch [6 Printer Setting].

– For details on displaying the User Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [1 Basic Setting].

3 Touch [ ] or [ ], and then touch [Banner Setting].
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4 Touch the button for the desired setting.

Paper Tray

You can specify the input tray to use when none has been specified with the 
printer driver. (Default setting: Auto)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [Paper Tray].
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4 Touch the button for the desired paper tray.

– To select the input tray automatically, touch [Auto].

5 Touch [OK].

– To cancel changes to the settings, touch [Cancel].
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Default Paper Size

You can specify the paper size to use when no setting has been specified 
from the printer driver. (Default setting: 8-1/2 × 11)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [Default Paper Size].

4 Touch the button for the desired setting.

– To select “8K”, “16K”, “envB5”, “envC5”, “envDL”, “envCom10”, or 
“env Monarch”, touch [Other Sizes].

5 Touch [OK].

– To cancel changes to the settings, touch [Cancel].
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2-Sided Print

You can specify the default duplex printing setting. (Default setting: OFF)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [2-Sided Print].

4 Touch the button for the desired setting.

2
Note 

The duplex printing function is available only when the optional ADU is 
installed.
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Bind Direction

You can specify the default binding position for duplex printing. (Default set-
ting: Left Bind)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [Bind Direction].

4 Touch the button for the desired setting.
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Staple

You can specify the staple settings. (Default setting: OFF)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [Staple].

4 Touch the button for the desired setting.

2
Note 

The staple function is available only when the optional finisher FS-514 is 
installed.
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Hole-Punch

You can specify the hole punching settings. (Default setting: OFF)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [ ] or [ ], and then touch [Hole-Punch].

4 Touch the button for the desired setting.

2
Note 

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.
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Banner Paper Tray

You can specify the paper tray to be used for banner page printing. (Default 
setting: Auto)

1 On the User Setting screen, touch [6 Printer Setting].

– For details on displaying the User Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [2 Paper Setting].

3 Touch [ ] or [ ], and then touch [Banner Paper Tray].

4 Touch the button for the desired setting.

Font Setting

You can specify the font to use when no setting has been specified from the 
printer driver. (Default setting: Courier)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [3 PCL Setting].
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3 Touch [1 Font Setting].

4 Touch [Internal].

– If downloaded fonts are available, [Disk] and [Soft] can also be se-
lected.

5 Touch the button for the desired setting.

– Touch [ ] or [ ] and then touch the button for the desired set-
ting.

– You can check the selected font number and font size units.

6 Touch [OK].

– To cancel changes to the settings, touch [Cancel].
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Symbol Set

You can specify the font symbol set to use when no setting has been spec-
ified from the printer driver. (Default setting: Depends on the location)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [3 PCL Setting].

3 Touch [2 Symbol Set].

4 Touch the button for the desired setting.

– Touch [ ] or [ ], and then touch the button for the desired set-
ting.

5 Touch [OK].

– To cancel changes to the settings, touch [Cancel].
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Font Size

You can specify the font size to use when no setting has been specified from 
the printer driver. (Default settings: Scalable Font – 12.00 point; Bitmap Font 
– 10.00 pitch)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [3 PCL Setting].

3 Touch [3 Font Size].

4 Press the [C] (clear) key to erase the value, and then use the keypad to 
type in the default font size (Scalable Font: between 4.00 and 999.75 
points; Bitmap Font: between 0.44 and 99.00 pitches).

– Scalable Font: Specifies the font size in points.
Bitmap font: Specifies the width of the fixed-width font in pitches.

– If a value outside of the allowable range is specified, the message 
“Input Error” appears. Type in a value within the allowable range.

5 Touch [OK].

The font size is set.
To cancel changes to the settings, touch [Cancel].
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Line/Page

You can specify the number of lines per page when test printing. (Default set-
ting: Depends on the location)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [3 PCL Setting].

3 Touch [4 Line/Page].

4 Press the [C] (clear) key to erase the value, and then use the keypad to 
type in the default number of lines (between 5 and 128 lines).

– If a value outside of the allowable range is specified, the message 
“Input Error” appears. Type in a value within the allowable range.

5 Touch [OK].

The number of lines/page is set.
To cancel changes to the settings, touch [Cancel].
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CR/LF Mapping

You can specify the data substitution method when printing text data. (De-
fault setting: OFF)

Mode 1: Substitutes CR for CR-LF.
Mode 2: Substitutes LF for CR-LF.
Mode 3: Substitutes to CR-LF.
OFF: Does not perform substitution.

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [3 PCL Setting].

3 Touch [5 CR/LF Mapping].

– Touch the button for the desired setting.

4 Touch the button for the desired setting.

5 Touch [OK].

– To cancel changes to the settings, touch [Cancel].
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PS Error Print

You can specify whether to print the error message when an error occurs 
during PS rasterization. (Default setting: OFF)

1 On the Utility Setting screen, touch [6 Printer Setting].

– For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

2 Touch [4 PS Setting].

3 Touch [PS Error Print].

4 Touch the button for the desired setting.
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Print Reports

You can output the following four types of reports. This report output method 
is explained in the PCL font list.

1 On the Utility Setting screen, touch [6 Printer Setting].

2 Touch [5 Print Reports].

3 Touch the button for the desired setting.

– Configuration Page: Outputs a list of this machine’s settings.
Demo Page: Outputs a test page.
PCL Font List: Outputs the PCL font list.
PS Font List: Outputs the PS font list.

4 Touch the button for the desired paper tray and the [Simplex/Duplex] 
button.

5 To output a report, press the [Start] key.
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10.2 Printer settings in Administrator mode

To display the Administrator Setting screen

1 Press the [Utility/Counter] key.

2 Touch [3 Administrator Setting].

3 Enter the password, and then touch [OK].

Utility/
Counter
C300 10-23



Various settings 10
4 The Administrator Setting screen appears.

!
Detail 

In Utility mode, an item can also be selected by pressing the key in the 
keypad for the number beside the desired button. For “3 Administrator 
Setting”, press the [3] key in the keypad.

For details on setting or changing the password, refer to the User’s Guide 
[Copy Operations].

!
Detail 

To quit specifying the Utility mode setting, touch [Exit] in the sub display 
area or press the [Utility/Counter] key. Otherwise, cancel the Utility mode 
by touching [Close] in each screen until the screen for the Copy, Fax, 
Scan or Box mode appears.
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To delete secure print documents

All saved secure print documents can be deleted.

1 In the Administrator Setting screen, touch [1 System Setting].

2 In the System Setting screen, touch [0 User Box Setting].

3 In the System Setting screen, touch [2 Delete Secure Print Documents].

4 To delete the secure print documents, touch [Yes].
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To specify the “Auto Delete Secure Document” parameter

The length of time for deleting a confidential document after it is saved can 
be specified.

1 In the Administrator Setting screen, touch [1 System Setting].

2 In the System Setting screen, touch [0 User Box Setting].

3 In the System Setting screen, touch [3 Auto Delete Secure Document].

4 Select the length of time until documents are deleted, and then touch 
[OK].

Print/Fax Output Settings

You can specify whether to print data after it is received or to print it simul-
taneously as it is being received.

You can specify this function for printing and for faxing. (Default settings: 
Printer – Page Print; Fax – Batch Print)

1 On the Administrator Setting screen, touch [1 System Setting].

– For details on displaying the Administrator Setting screen, refer to 
“To display the Administrator Setting screen” on page 10-23.

2 On the System Setting screen, touch [2 Output Setting].
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3 On the Output Setting screen, touch [1 Print/Fax Output Settings].

The Print/Fax Output Settings screen appears.

4 Touch [Print] or [Fax].

The buttons for the available settings appear.

5 Touch the button for the desired setting.

The print timing setting is set.

!
Detail 

If the “Administrator Security Level” parameter is set “Level 2”, users can 
also specify this setting. Touch [User Setting], [System Setting], [Output 
Setting], then [Print/Fax Output Settings] to display the Print/Fax Output 
Settings screen.

For details on the user access levels, refer to the User’s Guide [Copy Op-
erations].

2
Note 

If “Batch Print” is selected, printing starts when all the data is received 
and the print job is queued. If “Page Print” is selected, printing starts 
when the data for the first page is received and the print job is queued.
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I/F Timeout

You can set the time until a communication timeout occurs for the parallel, 
USB, or network interface. (Default setting: 60 seconds)

1 On the Administrator Setting screen, touch [7 Printer Setting].

– For details on displaying the Administrator Setting screen, refer to 
“To display the Administrator Setting screen” on page 10-23.

2 On the Printer Setting screen, touch [1 I/F Timeout].

The I/F Timeout screen appears.

3 Touch [Edit] below the setting that you are specifying.

4 Press the [C] (clear) key to erase the value, and then use the keypad to 
type in the default length of time (between 10 and 1000 seconds).

– If a value outside of the allowable range is specified, the message 
“Input Error” appears. Type in a value within the allowable range.

5 Touch [OK].

The time until a communication timeout occurs is set.
To cancel changes to the settings, touch [Cancel].
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Parallel I/F

You can specify the mode for using a parallel interface. (Default setting: ECP)

1 On the Administrator Setting screen, touch [7 Printer Setting].

– For details on displaying the Administrator Setting screen, refer to 
“To display the Administrator Setting screen” on page 10-23.

2 On the Printer Setting screen, touch [2 Parallel I/F].

The Parallel I/F screen appears.

3 Touch the button for the desired setting.

4 Touch [OK].

The parallel interface mode is set. 
To cancel changes to the settings, touch [Cancel].
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IEEE 1284/USB

You can specify whether to use the parallel port or the USB port. (Default set-
ting: USB)

1 On the Administrator Setting screen, touch [7 Printer Setting].

2 On the Printer Setting screen, touch [3 IEEE 1284/USB].

3 Touch the desired port.

2
Note 

The IEEE 1284 and USB ports cannot be used simultaneously.

After changing the setting for USB or IEEE 1284, the power must be 
turned off, then on again.

Capture Print Data

You can specify whether to allow or prohibit data capturing of a print job. 
(Default setting: Allow)

1 On the Administrator Setting screen, touch [Security Setting].

– For details on displaying the Administrator Setting screen, refer to 
“To display the Administrator Setting screen” on page 10-23.

2 On the Security Setting screen, touch [4 Security Details].

3 On the Security Details screen, touch [ ] or [ ], and then touch 
[Print Data Capture].
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The buttons for the available settings appear.

4 Touch the button for the desired setting.

The capturing a print job is either allowed or prohibited.

2
Note 

For details on capturing a print job, consult a service technician.
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10.3 Using PageScope Web Connection

PageScope Web Connection is a management utility supported by the HTTP 
server built into the printer controller.

Start up a Web browser on a computer on the network and access Page-
Scope Web Connection to easily change this machine’s settings.

2
Note 

Flash and HTML are available from View Mode in PageScope Web Con-
nection. For details, refer to “Logging In and logging out” on page 10-36.

System requirements

Accessing PageScope Web Connection

PageScope Web Connection can be accessed directly from a Web browser.

1 Start up the Web browser.

2 In the Address bar, enter the IP address for this machine, and then 
press the [Enter] key.

http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

!
Detail 

If the user authentication function is enabled, you must enter a user name 
and password. For details, refer to “Logging in to the User mode (public 
user)” on page 10-38.

For the procedure to set the IP address of this machine, refer to “Setting 
the IP address for this machine” on page 3-5.

Item System requirements

Network EthernetTCP/IP

Computer application Web Browser:
Microsoft Internet Explorer 6 or later recommended (JavaScript ena-
bled, Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when using Inter-
net Explorer 5.5.
Netscape Navigator 7.02 or later (JavaScript enabled, Cookies ena-
bled)
Macromedia® Flash® (If “Flash” is selected in View Mode, version 7.0 
or later plugin is required.)
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Page structure

The page that appears immediately after PageScope Web Connection is ac-
cessed is called the User mode page, and it is displayed when you have 
logged in as a public user.

2
Note 

By clicking the [Logout] button, you can log in as another user or admin-
istrator. For details, refer to “Logging In and logging out” on page 10-36.

The configuration of the PageScope Web Connection page is shown below.
5 6

10

8

1
2
3
4
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12
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9
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No. Item Description

1 KONICA MINOLTA logo Click the logo to jump to the following Web site (KONICA 
MINOLTA Web site). http://konicaminolta.com

2 PageScope Web 
Connection logo

Click the PageScope Web Connection logo to display the 
version information of PageScope Web Connection.

3 Login mode Displays the current login mode (public, registered user, 
Account name, administrator, box administrator).

4 [Logout] Click to log out of the current mode.

5 Status display Displays the status of this machine’s printer and scanner 
sections using icons.

6 Message display Displays the status of the problem/error and other error 
information if an error has occurred in this machine.

7 Operation page Displays the operating status of this machine.

8 Tab Displays the categories that can be controlled by 
PageScope Web Connection. The following tabs are 
displayed in User mode.
• System
• Job
• Box
• Print
• Scan

9 Help The page specified in “Online Manual URL” is displayed. 
For the setting procedure, refer to “System tab — Online 
Assistance” on page 10-73.

10 Refresh Click to renew the page that is being displayed.

11 Menus Lists the information and settings for the selected tab. The 
menus that appear vary depending on the tab that is 
selected.

12 Information and settings 
display

Displays the details of the item selected from the menu.
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Cache function of Web browsers

The newest information may not appear on the PageScope Web Connection 
page due to the cache function of the Web browser. In addition, problems 
can occur when the cache function is used.

When using PageScope Web Connection, disable the cache function of the 
Web browser.

!
Detail 

The menus and commands may vary depending on the Web browser. For 
details, refer to Help for the Web browser.

If the cache function is enabled on the Web browser and a timeout occurs 
in Administrator mode, the timeout page may appear even when Page-
Scope Web Connection is accessed again. When this happens, the ma-
chine’s control panel remains locked, and the main power of this machine 
must be turned off, then on again. To avoid such problems, disable the 
cache function.

When turning the power off, then on again, be sure to turn the sub-power 
switch off first, then the main power switch. In addition, wait at least 10 
seconds before turning the power on again; otherwise, this machine may 
not function properly.

On Internet Explorer

1 On the “Tools” menu, click “Internet Options”.

2 On the General tab, click the [Settings] button under “Temporary Inter-
net files”.

3 Select “Every visit to the page”, and then click the [OK] button.

On Netscape Navigator

1 On the “Edit” menu, click “Preferences”.

2 In the “Category” box, click “Advanced”, then “Cache”.

3 Under “Compare the page in the cache to the page on the network”, 
select “Every time I view the page”.
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Logging In and logging out

When accessing PageScope Web Connection, the login page appears when 
performing user authentication and account track on this machine and the 
page that was logged in as a public user appears when not performing user 
authentication and account track. When logging in as a different user and to 
log in as an administrator, you must log out, and then log in again.

2
Note 

If no operations are performed for a given length of time while logged in, 
a timeout automatically occurs and operations cannot be performed.

You can set the time for timeouts that occur in the User mode and Ad-
ministrator mode from [Network] – [Authentication] – [Auto Logout] in the 
Administrator mode.

Logging out

% Click the [Logout] button at the top left of the page.
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The login page appears after logging out.
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Logging in to the User mode (public user)

When not performing user authentication, log in as a public user.

1 In the login page, select [Public User].

– If necessary, select the language and the display format.
– If “Flash” is selected in the display format, the following items are 

displayed by using the Flash function.
· Status icons and images
· “System tab – Device Information – Input Tray” status
· “System tab” status

– To use the “Flash” function, Flash Player is required.
– If using screen reader software, it is recommended to select HTML.
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2 Click the [Login] button.

The page switches to the User mode page.
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Logging in to the User mode (registered user)

When performing user authentication on this machine, you must login using 
the user name and password that are registered to this machine or an exter-
nal authentication server. This section describes the procedure for logging in 
with a specified user name when performing user authentication.

1 In the login page, enter the user name and password.

– If performing account track, enter the Account name and pass-
word.

– If necessary, select the language and the display format.
– If “Flash” is selected in the display format, the following items are 

displayed by using the Flash function.
· Status icons and images
· “System tab – Device Information – Input Tray” status
· “System tab” status

– To use the “Flash” function, Flash Player is required.
– If using screen reader software, it is recommended to select HTML.
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2 Click the [Login] button.

The page switches to the User mode page.

2
Reminder 

When the user authentication or account authentication settings are 
specified on this machine, the authentication operation restriction func-
tion is in mode 2, and the authentication information is not entered cor-
rectly, the applicable user or account is locked and cannot be accessed.

2
Note 

By clicking the icon on the right of “User Name”, you can select the user 
name from a list.

If multiple domains are specified as external server authentication on this 
machine, add “@” after the user name and enter the domain name. (Ex-
ample: If the user name is “user01” and the domain name is “domain”, 
enter “user01@domain”.)
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Logging in to the Administrator mode

You can specify the system and network settings by logging in to the Admin-
istrator mode.

1 In the login page, select [Administrator], and then click the [Login] but-
ton.

– If necessary, select the language and the display format.
– If “Flash” is selected in the display format, the following items are 

displayed by using the Flash function.
· Status icons and images
· “System tab – Device Information – Input Tray” status
· “System tab” status

– To use the “Flash” function, Flash Player is required.
– If using screen reader software, it is recommended to select HTML.
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2 Enter the administrator password for this machine, and then click the 
[OK] button.

The page switches to the Administrator mode page.
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2
Note 

When logged in to the Administrator mode, the machine’s control panel 
is locked and cannot be used.

Depending on the status of this machine, you may not be able to log in 
to the Administrator mode.

User mode

The User mode provides functions for checking and operating the machine 
on a user level. You can select from five tabs (System, Job, Box, Print, or 
Scan).

2
Note 

This manual describes the printer related functions. For the box and 
scanner functions of this machine, refer to the User’s Guide [Box Opera-
tions] and User’s Guide [Network Scanner Operations].

System tab

On the System tab, information and settings concerning the system config-
uration of this machine are displayed.
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System tab — Device Information — Consumables

On the System tab, click “Device Information”, and then click “Consuma-
bles” on the sub-menu that appeared. In addition, this is the initial page that 
appears when you access http://<IP_address_for_this_machine>/ with your 
Web browser.

This page shows the consumables information of this machine.
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2
Note 

The items that are displayed may vary depending on whether options are 
installed.

Item Description

Toner (Yellow, Magenta, 
Cyan, Black)

Displays information for each item.

Imaging Unit (Yellow, 
Magenta, Cyan, Black)

Paper Dust Remover/Ozone 
Filter

Punch Dust

Staple

Saddle Staple Cartridge

Fusing Unit

Image Transfer Unit
C300 10-46



Various settings 10
System tab — Device Information — Input Tray

Click the System tab, click “Device Information”, and then click “Input Tray” 
in the sub-menu that appeared.

You can check the status of the paper trays of this machine.

2
Note 

If “HTML” is selected in View Mode when logging in, the details can be 
check by selecting each tray and clicking the [Detail] button.

Item Description

Tray Displays information for each item.

Paper Size

Paper Type

Paper Status

Paper Capacity
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System tab — Device Information — Output Tray

Click the System tab, click “Device Information”, and then click “Output 
Tray” in the sub-menu that appeared.

You can check the status of the output trays of this machine.

Item Description

Output Tray Displays the tray name and status of each installed tray.

Option Displays whether an option is installed.
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System tab — Device Information — Configuration Summary

Click the System tab, click “Device Information”, and then click “Configura-
tion Summary” in the sub-menu that appeared. This page shows the current 
system configuration and status of this machine.

Item Description

Configuration Summary Displays the configuration of the options installed on this machine.
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System tab — Device Information — HDD

Click the System tab, click “Device Information”, and then click “HDD” in the 
sub-menu that appeared.

You can check the status of the hard disk of this machine.

Item Description

Name Displays the hard disk name.

Total Displays the total size of the installed hard disk.

Used Displays the amount of space used by the system.

Remain Displays the amount of free hard disk space.
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System tab — Device Information — Interface Information

Click the System tab, click “Device Information”, and then click “Interface In-
formation” in the sub-menu that appeared.

You can check the interface information of this machine.

Item Description

Protocol Information Displays the usability status of each protocol.

Network Information Displays the network information.
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System tab — Device Information — Administrator Information

Click the System tab, click “Device Information”, and then click “Administra-
tor Information” in the sub-menu that appeared. This page shows the admin-
istrator information of this machine.

Item Description

Administrator Information Displays the administrator information.
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System tab — Meter Count

Click the System tab, and then click “Meter Count” in the menu.

You can check the counters that this machine manages.

Item Description

Total Counter Displays the total of the output counter (copies, prints, scans, and 
faxes).

Copy Counter Displays each counter.

Print Counter

Scan Counter (Displayed as Scan/Fax Counter when the optional fax kit is 
installed.)

Color Total Counter Displays the color mode counter.
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System tab — Online Assistance

Click the System tab, and then click “Online Assistance” in the menu.

You can check support information concerning the product.

Item Description

Contact Name Displays each item specified on the Online Assistance page from 
the Systems tab in the administrator mode.

Contact Information

Product Help URL

Corporate URL

Supplies and Accessories

Online Help URL
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System tab — User Authentication — User Password Change

Click the System tab, click “User Authentication”, and then click “User Pass-
word Change” in the sub-menu that appeared.

You can change the password of the user that is logged in.

2
Note 

The password cannot be changed if you have not logged in as a user.

Item Description

Current Password Enter the current password.

New Password Enter the new password. (up to 64 alphanumeric characters, ex-
cluding " +)

Retype New Password Reenter the new password for confirmation.
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System tab — User Authentication — User Information

Click the System tab, click “User Authentication”, and then click “User Infor-
mation” in the sub-menu that appeared.

The information of the user that is logged in is displayed.

2
Note 

The user information is not displayed if you have not logged in as a user.

Item Description

User Information Displays the user name.

Function Permission Displays whether each function of this machine can be used.

Output Permission (Print/
Transmission)

Displays whether the output function of this machine can be used.

Counter Information Displays the maximum value and the current counter.
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System tab — Account Track Information

Click the System tab, and then click “Account Track Information” in the 
menu.

The account track information of the user that is logged in is displayed.

2
Note 

The account track information is not displayed if the account track func-
tion is not enabled on this machine.

Job Tab

From the “Job” tab, you can check jobs managed by this machine.

Item Description

Account Track Information Displays the department name.

Output Permission (Print/
Transmission)

Displays whether the output function of this machine can be used.

Counter Information Displays the maximum value and the current counter.
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Job tab — Current Job

Click the Job tab, click “Current Job List” in the menu, and then select each 
function (print and scanning operations) by the job type. 

You can check jobs that are being printed or that are queued to be printed.

Sample print page

Item Description

Print Displays the print job list and details.

Scan Transmission Displays the scan job list and details.

Fax Transmission Displays the fax transmission job list and details.

Fax Receive Displays the fax reception job list and details.

HDD/Memory Displays the box job list and details.
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2
Note 

The job number that was assigned when the job was queued in this ma-
chine appears as the job number.

To output (for print jobs) by priority, select the job, and then click the [In-
crease Priority] button.

To check an address (for transmission jobs), select the job, and then click 
the [Display Broadcast Destination] button.

To delete a job, select the job, and then click the [Delete] button.
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Job tab — Job History

Click the Job tab, click “Job History” in the menu, and then select each func-
tion (print and scanning operations) by the job type. 

You can check completed jobs.

Sample Print Page

2
Note 

The job number that was assigned when the job was queued in this ma-
chine appears as the job number.

If “HTML” is selected in View Mode when logging in, the details can be 
check by selecting each job and clicking the [Detail] button.

Item Description

Print Displays the print job list and details.

Scan Transmission Displays the scan job list and details.

Fax Transmission Displays the fax transmission job list and details.

Fax Receive Displays the fax reception job list and details.

HDD/Memory Displays the box job list and details.
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Print tab

You can check the printer default settings and print various reports.

Print Tab — General Settings

Click the Print tab, click “General Settings” from the menu, and then select 
each setting classification (general and PCL). 

If a print job is sent whose settings are not specified, the settings specified 
here are used for printing.

Sample general settings page

Item Description

General Settings Displays information for each item.

PCL Settings

PS Settings
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Print tab — Print Reports

Click the Print tab, and then click “Print Reports” in the menu.

You can print various configuration information, the demo pages, and the 
PCL font information. Select the report that you want to print, select the pa-
per tray from the “Paper Tray” drop-down list, and then click the [Print] but-
ton.

2
Note 

When this machine is processing a job, you may not be able to output re-
ports.

Item Description

PS Font List Prints the font list that is used by PostScript.

PCL Font List Prints the font list that is used by PCL.

GDI Demo Page Prints a demo page.

Configuration Page Prints the various configuration information pages of this machine.

Paper Tray Select the paper tray for printing reports.
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Administrator mode

In Administrator mode, you can specify system settings for this machine. 
You can select from tabs (System, Job, Box, Print, Scan, or Network).

For details on logging on to Administrator mode, refer to “Logging in to the 
Administrator mode” on page 10-42.

2
Note 

This manual describes the printer related functions. For the box, scanner, 
and network functions of this machine, refer to the User’s Guide [Box Op-
erations] and User’s Guide [Network Scanner Operations].

Basic operation

1 Click a tab, and then select a item from the menu.

2 Specify settings for the displayed items. Either enter a setting directly 
or select one from the drop-down list.

3 Click the [Apply] button to apply the settings.

System tab

On the System tab, information and settings concerning the system config-
uration of this machine are displayed.
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System tab — Import/Export

You can save (export) the setting information of this machine as a file or write 
(import) the information from a file to this machine.

Specify the information to be imported or exported, and then click the [Next] 
button.

Item Description

Device Setting Specify the setting values for the user and administrator settings of 
this machine.

Transmission Log Specify the transmission log of this machine.

User Information Specify the user registration information.
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Specify the file to import or export.

2
Note 

The files exported cannot be edited.

2
Note 

The transmission log can only be exported.

Item Description

Import To import a file, specify the file name you want to import, and then 
click the [Import] button.

Export To download a file, click the [Export] button.
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System tab — Date/Time — Manual Setting

Enter the time and date for this machine.

Item Description

Year Enter the year.

Month Enter the month.

Day Enter the day.

Hour Enter the time.

Minute Enter the minutes.

Time Zone Specify the time difference from GMT.

Daylight Saving Time Specify whether the time is in daylight savings time (input range: 
1-150, unit: minutes).
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System tab — Date/Time — Time Adjustment Setting

The time and date of this machine can be set through passive acquisition 
from the NTP server.

Click the [Adjust] button to connect at the specified conditions to the NTP 
server and to set the time.

Item Description

Time Adjustment Setting Specify whether to enable automatic time acquisition by NTP.

NTP Server Address Enter the NTP server address (up to 255 characters, including - . 
only, format: “***.***.***.***” or FQDN).

Port No. Enter the NTP server port (input range: 1-65535).
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System tab — Machine Setting

You can change the machine setting.

Item Description

Device Name Specify the device name (up to 255 characters).

Device Location Specify the device location (up to 255 characters).

Administrator Name Specify the administrator name (up to 255 characters).
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System tab — Device Information

Click the System tab, click “Device Information” in the menu, and then select 
each setting (Consumables, Input Tray, etc.).

This page shows the configuration and status of this machine.

2
Note 

The item that is displayed is the same as that on the System tab in “De-
vice Information” in the User mode.
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System tab — ROM Version

Displays the ROM version.
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System tab — Meter Count

Click the System tab, and then click “Meter Count” in the menu.

You can check the counters that this machine manages.
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Item Description

Total Counter Displays the total of the output counter (copies, prints, scans, and 
faxes).

Copy Counter Displays each counter.

Print Counter

Scan Counter (Displayed 
as Scan/Fax Counter 
when the optional fax kit 
is installed.)

Color Total Counter Displays the color mode counter.

Paper Size / Type Coun-
ter

Displays the paper size and paper type counter.
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System tab — Online Assistance

You can changed the online support information. To display this information 
click the System tab in the User mode, and then click “Online Assistance”.

Item Description

Contact Name Specify the contact name (up to 63 characters).

Contact Information Specify the contact information (up to 127 characters).

Product Help URL Specify the product information Web page URL (up to 127 
characters, excluding < >).

Corporate URL Specify the manufacturer’s Web page URL (up to 127 characters, 
excluding < >).

Supplies and Accessories Specify the supply and accessory contact information (up to 127 
characters).

Online Help URL Enter the following URL (alphanumeric characters, excluding < >).
http://pagescope.com/download/webconnection/onlinehelp/
c300/help.html
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System tab — Maintenance — Network Setting Clear

You can restore the network configuration of this machine to when it was 
shipped from the factory.

To execute, click the [Clear] button.

2
Note 

If the settings are cleared after completing setup, you will not be able to 
access PageScope Web Connection until the settings are reset.

If the enhanced security mode is enabled, this menu will not be dis-
played.
C300 10-74



Various settings 10
System tab — Maintenance — Reset

Resets the printer controller.

To execute, click the [Reset] button.
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System tab — Status Notification Setting

When an error occurs in this machine, the registrant is notified.

Enter the notification time, and then click the [Apply] button.

By clicking the [Edit]  icon on the right of a notification address, you can 
specify the destination address and the notification conditions.
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2
Note 

The printer location that is mentioned in the e-mail sent by the status no-
tification function is entered in “Printer Location” from Network tab – IPP 
Setting. For “Printer Location”, refer to “Network tab — IPP Setting” on 
page 10-96.

Item Description

Notification Address Enter the notification destination e-mail address (up to 320 charac-
ters).

Tray Paper Replenish Notifies when there is no paper.

JAM Notifies when a paper jam occurs.

PM Call Notifies when there is a scheduled inspection.

Add Staple Notifies when there are no staples.

Toner Supply Notifies when there is no toner.

Finisher Tray Full Notifies that the finisher tray is full.

Service Call Notifies when there is a service call.

Job End Notifies that a job is complete (completed normally).

Punch-Hole Scraps 
Box Full

Notifies that the hole punch waste must be emptied.
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System Tab — Total Counter Report Setting

You can register the settings for notifying the total counter by e-mail and the 
notification e-mail address.

Enter each item, and then click [Apply] to specify the settings. After specify-
ing the settings, click [Send Now] to send the e-mail notification.
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System tab — User Authentication — User Registration

If performing user authentication on this machine, you can register the users 
that can log in.

You can register a user in [New Registration]. By clicking the [Edit]  icon 
on the right of a user name, you can edit the conditions of a registered user.

You can specify the user conditions by entering each item and then clicking 
the [Apply] button.

Item Description

Total Counter Report 
Setting (Device Nick-
name)

Enter the model name to be shown in the list (up to 20 alphanumeric 
characters and symbols).

Schedule Setting Specifies the conditions for the schedule to be notified. Different set-
tings can be registered for schedules 1 and 2.

Notification Address 
Setting

Enter the notification destination e-mail address (up to 320 charac-
ters). The notification schedule can be selected for the address that 
was entered.
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Item Description

User Registration Enter the user name and password.
No.: Assigned number for the user counter (up to 1000)
User Name: 1-64 characters
E-Mail Address: Up to 320 characters
User Password: Up to 64 characters, excluding " +

Function Permission Specify whether each function of this machine can be used.

Output Permission 
(Print/Transmission)

Specify whether the output function of this machine can be used.

Max. Allowance Set Specify the maximum value that can be used.
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System tab — User Authentication — Default Function Permission

You can specify the default values of the limited functions on the user regis-
tration page.
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System tab — Account Track Registration

If performing account track on this machine, you can register the account to 
be managed.

You can register an account in [New Registration]. By clicking the [Edit]  
icon on the right of the department name, you can edit the conditions of a 
registered account.
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You can specify the account conditions by entering each item and then click-
ing the [Apply] button.

Item Description

Account Track Registra-
tion

Enters the department name and password.
No.: Assigned number for the user counter (up to 1000)
Account Name: 1-8 characters, excluding " +
Password: 1-8 characters, excluding " +

Output Permission 
(Print/Transmission)

Specify whether the output function of this machine can be used.

Max. Allowance Set Specify the maximum value that can be used.
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Job tab — Job History

Click the Job tab, and then click “Job History” in the menu.

Select each function (printing and scanner operations) by the job type.

You can check completed jobs.

Print Page Example

2
Note 

The item that is displayed is the same as that on the Job tab in “Job His-
tory” in the User mode.
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Print tab

On the Print tab, information and settings concerning the connecting inter-
face and default print settings are displayed.

Print tab — Interface

You can change the interface timeout settings.

2
Note 

The items that are displayed may vary depending on whether options are 
installed.

Item Description

Parallel Timeout Enter the reception timeout for the parallel port (input range: 10—
1000).

Network Timeout Enter the reception timeout for the network (input range: 10—1000).

USB Timeout Enter the USB timeout (input range: 10—1000).

Parallel Setting Select the parallel port transmission method.
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Print tab — Default Settings — General Settings

You can specify the default setting values of the printer.

Item Description

PDL Setting Select the printer descriptive language.

Paper Tray Select the input tray.

Output Tray Select the output tray.

2-Sided Print Select whether to perform duplex printing.

Bind Direction Select the position of the binding margin.

Staple Select the staple function.

Hole-Punch Select the hole punching function.

Number of Sets Select the number of copies to print.

Default Paper Size Select the paper size.

Original Direction Select the print orientation.

Spool Print Jobs in HDD 
before RIP

Select the spool function.

Banner Setting Specify whether to perform banner page printing.

Banner Paper Tray Select the paper tray to be used for banner page printing.
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2
Note 

The staple function is available only when the optional finisher FS-514 is 
installed.

The hole punch function is available only when optional finishers FS-514 
and punch kit PK-510 are installed.

2
Note 

The items that are displayed may vary depending on whether options are 
installed.

Print tab — Default Settings — PCL Settings

You can specify the default setting values of the PCL mode.

No Matching Paper in 
Tray Setting

Selects the operation when the specified input tray does not contain 
the suitable paper.
Switch Trays (Tray Priority): Feeds paper from another paper tray.
Stop Printing (Tray Fixed): Displays a warning message without 
printing.

A4/A3 ↔ LTR/LGR Auto 
Switch

Select whether to print 8-1/2 × 11 (A4)/11 × 17 (A3) documents when 
the A4 (8-1/2 × 11)/A3 (11 × 17) paper source is selected.

Item Description
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Print tab — Default Settings — PS Settings

You can specify the default setting values of the PS mode.

Scan Tab

On the Scan tab, the settings at transmission and the information and set-
tings concerning the address book limitations are displayed.

!
Detail 

If the user is prohibited from registering recipients in the address book, 
the functions for registering recipients in the address menu will not ap-
pear in the menu.

For details on scanner registration, refer to the User’s Guide [Network 
Scanner Operations].

Item Description

Typeface Select the font.

Symbol Set Select the symbol set.

Font Size Specify the font pitch (input range: 0.44—99.00) or the font point size 
(input range: 4.00—999.75) according to the selected font.

Line/Page Enter the number of lines per page (input range: 5—128).

CR/LF Mapping Select the CR/LF operation.

Item Description

PS Error Print Specify whether to enable the printing of errors.
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Network tab

On the Network tab, information and settings concerning the network con-
nection are displayed.

Network tab — TCP/IP — TCP/IP

You can specify the TCP/IP settings.
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2
Note 

To apply any changes to settings for the Network tab, restart this ma-
chine (turn the main power off, then on again).

When turning the power off, then on again, be sure to turn the sub-power 
switch off first, then the main power switch. In addition, wait at least 10 
seconds before turning the power on again; otherwise, this machine may 
not function properly.

Item Description

TCP/IP Specify whether to enable TCP/IP.

Network Speed Select the operation speed.

IP Address Setting Method Select when using a DHCP server.

IP Address Specify the IP address of this machine (format: “***.***.***.***”, 
input range for ***: 0—255).

Subnet Mask Specify the subnet mask connecting to a network (format: 
“***.***.***.***”, input range for ***: 0—255).

Default Gateway Specify the default gateway address connecting to a network 
(format: “***.***.***.***”, input range for ***: 0—255).

Port 1 Specify the RAW port number (input range: 1—65535).

Port 2

Port 3

Port 4

Port 5

Port 6

Dynamic DNS Setting Specify whether to enable DNS.

Host Name Specify the host name (up to 63 characters).

DNS Domain Name Setting Specify the domain name (up to 254 characters including the 
characters for the host name).

DNS Server Setting Register a maximum of three DNS servers (format: “***.***.***.***”, 
input range for ***: 0—255).

SLP Setting Specify whether to enable SLP.

LPD Setting Specify whether to enable LPD.
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Network tab — TCP/IP — IP Address Filtering

You can specify the IP address filter function.

You can specify the access limitations by specifying the IP address of the 
host.

Item Description

Permit Access Specify whether to enable authorization of an IP address 
setting.

Setting Range 1—5 Enter the IP address being authorized (format: “***.***.***.***”, 
input range for ***: 0—255).

Deny Access Specify whether to enable rejection of an IP address setting.

Setting Range 1—5 Enter the IP address being rejected (format: “***.***.***.***”, 
input range for ***: 0—255).
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2
Note 

When allowing (not allowing) a single IP address, the three methods de-
scribed below can be specified.

Enter the IP address in the start address and enter 0.0.0.0 in the end ad-
dress. (For example, “192.168.11.22 – 0.0.0.0”).

Enter 0.0.0.0 in the start address and enter the IP address in the end ad-
dress. (For example, “0.0.0.0 – 192.168.11.22”).

Enter the same IP address in the start address and the end address. (For 
example, “192.168.11.22 – 192.168.11.22”).
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Network tab — NetWare — NetWare

You can specify the NetWare settings.

Item Description

IPX Setting Specify whether to enable NetWare.

Ethernet Frame Type Select the frame type.

NetWare Print Mode Select “Pserver” or “Nprinter/Rprinter” as the operation mode 
of the print server.

Print Server Name Enter the print server name (up to 63 characters, excluding / \ : 
; , * [ ] < > | + = ? .).

Print Server Password Specify the print server password (up to 63 characters).

Polling Interval Enter the print queue scan rate (input range: 1—65535 
seconds).

Bindery/NDS Setting Select from “NDS” and “NDS/Bindery Setting”.

File Server Name Enter the preferred file server name of bindery (up to 47 
characters, excluding / \ : ; , * [ ] < > | + = ? .).
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2
Reminder 

To apply any changes to the settings for “IPX Setting”, “Ethernet Frame 
Type”, “NetWare Print Mode”, “Print Server Name”, “Polling Interval”, 
“Printer Name”, and “Printer Number”, which are marked with an aster-
isk, restart this machine (turn the main power off, then on again).

When turning the power off, then on again, be sure to turn the sub-power 
switch off first, then the main power switch. In addition, wait at least 10 
seconds before turning the power on again; otherwise, this machine may 
not function properly.

NDS Context Name Enter the preferred NDS context name (up to 191 characters, 
excluding / \ : ; , * [ ] < > | + = ? .).

NDS Tree Name Enter the preferred NDS tree name (up to 63 characters, 
excluding / \ : ; , * [ ] < > | + = ? .).

Printer Name Enter the NPrinter/RPrinter printer name (up to 63 characters, 
excluding / \ : ; , * [ ] < > | + = ? .).

Printer Number Enter the NPrinter/RPrinter printer number (input range: 0—
255).

User Authentication Setting Specify whether to perform user authentication with a NetWare 
connection.

Item Description
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Network tab — NetWare — NetWare Status

“Server Name” and “Queue Name” appear as the NetWare connection sta-
tus.
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Network tab — IPP Setting

You can specify the IPP print settings.

Item Description

IPP Setting Specify whether to enable IPP printing.

Printer Name Enter the printer name (up to 127 alphanumeric characters and - 
_).

Printer Location Enter the printer location (up to 127 characters).
The printer location entered here is the setup location that is 
displayed in the status notification e-mail text that was specified 
from System tab – Status Notification Setting.

Printer Information Enter the printer information (up to 127 characters).

Printer URI Displays the URI of the printer that can be used for IPP printing.

Support Operation Specify the print operations supported by IPP. 
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2
Note 

For the status notification function, refer to “System tab — Status Notifi-
cation Setting” on page 10-76.

IPP Authentication Setting Specify the authentication method, user name, and password for 
an IPP connection.

Item Description
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Network tab — SNMP Setting

You can specify the SNMP settings.

2
Note 

If the enhanced security mode is enabled, the community name of the 
SNMP v1/v2c setting is “R0”. In addition, “Authentication OFF” cannot 
be selected in Write User Name – Security Level of SNMP v3 Setting.

Item Description

SNMP Specify whether to enable SNMP.

UDP Port Setting Specify the port number.

SNMP v1/v2c Setting Specify the read and write names for SNMP v1/v2c.

SNMP v3 Setting Specify the read and write names for SNMP v3.
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Network tab — SMB Setting — WINS Setting

You can specify SMB WINS settings.

To perform SMB printing via a router, specify the settings in “SMB Setting” 
- “Print Setting” and both WINS settings.

Item Description

WINS Specify whether to use WINS.

Auto Obtain Setting Specify whether to enable the automatic acquisition of WINS.

WINS Server Address1 Enter the WINS server address (syntax: ***.***.***.*** where the 
input range for *** is 0 to 255).

WINS Server Address2
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Network tab — SMB — Print

You can specify the SMB print settings.

2
Reminder 

To apply any changes to settings for “NetBIOS Name”, “Print Service 
Name”, or “Work Group”, restart this machine (turn the main power off, 
then on again).

When turning the power off, then on again, be sure to turn the sub-power 
switch off first, then the main power switch. In addition, wait at least 10 
seconds before turning the power on again; otherwise, this machine may 
not function properly.

Item Description

SMB Print Specify whether to enable the SMB print (Window print) service.

NetBIOS Name Enter the NetBIOS name (up to 15 characters, including - only).

Print Service Name Enter the print service name (up to 12 characters, excluding / \).

Work Group Enter the work group name (up to 15 characters, excluding " \ ; : , 
* < > | + = ?).
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Network tab — AppleTalk

You can specify the AppleTalk settings.

Item Description

AppleTalk Specify whether to enable AppleTalk.

Printer Name Enter the printer name (up to 31 alphanumeric characters, 
excluding = ~).

Zone Name Specify the zone name (up to 31 characters).

Current Zone Displays the current zone name.
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Network tab — Bonjour Setting

You can specify the Bonjour settings.

Item Description

Bonjour Specify whether to use a Bonjour/Rendezvous connection.

Bonjour Name Specify the Bonjour name that is to appear as the connected 
device name (up to 63 alphanumeric characters and symbols).
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Network tab — SSL/TLS

You can specify the SSL/TLS certificate settings.

!
Detail 

For details on Network Tab—SSL/TLS, refer to the User’s Guide [Net-
work Scanner Operations].

Network tab — Authentication

You can specify the automatic PageScope Web Connection log off time set-
tings.

!
Detail 

For details on Network Tab—Authentication, refer to the User’s Guide 
[Network Scanner Operations] and User’s Guide [Box Operations].
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10.4 Print job management

Specifying job operations

% You can specify job operations on this machine by setting a printer 
driver.

2
Note 

The three printer drivers that can be set on this machine are as follows: 
Konica Minolta PCL Printer Driver for Windows
Konica Minolta PostScript Printer Driver for Windows 2000/XP/Server 
2003
Konica Minolta PostScript PPD Printer Driver for Mac OS X

Specifying settings (for Windows)

1 Click the [Properties] button on the Print dialog box to open the printer 
driver setup dialog box.

2 Click the Setup tab (PCL or PostScript driver).

3 From the “Output Method” drop-down list, select the output method.

Print: Prints immediately.
Secure Print: Enters the ID and password on this machine’s control 
panel, then prints. (Up to 100 documents)
When the password rules are enabled on this machine, specify the 
password with 8 digits.
Save in User Box: Saves the document to be printed in a box on.
When the power rules are enabled on this machine, specify the box that 
is created on this machine.
Save in User Box and Print: Saves the document in a box and prints at 
the same time.
Proof and Print: After part of the document has been printed, this ma-
chine stops printing temporarily. Select to avoid misprinting a large vol-
ume of print jobs.
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!
Detail 

For details, refer to “Selecting the output method” on page 5-13 and 
page 6-10.
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Specifying settings (for Mac OS X)

1 From the “File” menu, select “Print”.

2 Select “Security”.

3 Specify settings for the following:

– Print: Specifies conditions for “Secure Print” and “Box Hold”.
– Secure Print: Enters ID and password when “Secure Print” is se-

lected in “Output Method”. Enter the ID and password on this ma-
chine’s control panel when printing. (Up to 100 documents)

– When the password rules are enabled on this machine, specify the 
password with 8 digits.

– Save in User Box: Enters file name and box number when “Save in 
User Box” or “Save in User Box and Print” is selected in “Output 
Method”.

– When the power rules are enabled on this machine, specify the box 
that is created on this machine.

– Proof and Print: After part of the document has been printed, this 
machine stops printing temporarily. Select to avoid misprinting a 
large volume of print jobs.
For details, refer to “Security” on page 9-11.
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Job storage

When “Output Method” in the printer driver is selected, a print document can 
be stored in this machine as a print job.

To print a stored job, you must recall the job using this machine’s control 
panel.

Recalling jobs (Proof and Print)

For details on using the keys on the control panel, refer to the User’s Guide 
[Copy Operations]. For details on the box functions of this machine, refer to 
the User’s Guide [Box Operations].

1 Touch [Job List] on this machine’s control panel.

The Print tab appears.

2 Touch [Held Jobs].
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3 Touch [Release Held Job].

The Release Held Job screen appears.

4 To check the print results, select the job whose sample copy is to be 
printed from the job list, select [Proof Print], and then touch [OK].

– Check the print results on the printed pages.

5 From the job list, select the job that you want to print.

– To change the settings of the printing conditions, continue with 
step 6.

– If you are not changing the settings of the printing conditions, skip 
to step 8.

6 Touch [Change Setting].
The Change Setting screen appears.

– If the job to be removed from the Held Job list is not displayed, 
touch [ ] or [ ] until the desired job is displayed.

– To change the settings of or cancel multiple jobs together, select 
one job, and then touch the next jobs.

– If an incorrect job was selected, touch the button for the selected 
job again to deselect it.

7 Change the printing conditions on the Change Setting screen, and then 
touch [OK].

The Release Held Job screen appears again.

8 Select [Print], and then Touch [OK].
The stored job is changed to an active job, then printed.

– To cancel printing of the job, touch [Cancel].
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Recalling jobs (Secure Print)

“Secure Print” jobs are saved in the secured document box. To print a se-
cured document, the ID and password that were specified in the printer driv-
er are required.

!
Detail 

For details on using the keys on the control panel, refer to User’s Guide 
[Copy Operations].

For details on the box functions of this machine, refer to User’s Guide 
[Box Operations].

2
Note 

Confidential documents are automatically deleted after a set length of 
time after they are registered. The default setting of this time is 24 hours, 
and the setting can be specified in the administrator mode. For details, 
refer to “To specify the “Auto Delete Secure Document” parameter” on 
page 10-26.

A printed confidential document can be deleted manually from Adminis-
trator mode. For details, refer to “To delete secure print documents” on 
page 10-25.

For details on specifying a setting for “Secure Document Access Meth-
od”, refer to the User’s Guide [Copy Operations].

When “Secure Document Access Method” is set to “Mode 1”

1 Press the [Box] key on the control panel of this machine, and then 
touch [Secure Print User Box] on the System User Box tab.
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2 Type in the ID for the confidential document, and then click [OK].

3 Type in the password for the confidential document, and then click 
[OK].

A list of received documents appears.

? Why does the desired document not appear?
% Only documents with an ID and password matching those specified 

by the printer driver are displayed.

4 Select the document to be printed, and then touch [Print].

The document information appears.

5 Press the [Start] key in the control panel.

The document is printed.
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When “Secure Document Access Method” is set to “Mode 2”

1 Press the [Box] key on the control panel of this machine, and then 
touch [Secure Print User Box] on the System User Box tab.

2 Type in the ID for the confidential document, and then touch [OK].

A list of confidential documents with the specified ID appears.

3 Select the document to be printed, and then touch [Password].

4 Type in the password for the confidential document, and then touch 
[OK].

A list of received documents appears.
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5 Select the document to be printed, and then touch [Print].

The document information appears.

6 Press the [Start] key in the control panel.

The document is printed.

2
Note 

If “Prohibit Functions when Auth. Error” in Administrator mode is set to 
“Mode 2” and an incorrect document password is entered the specified 
number of times, the selected document is locked. Contact the adminis-
trator to cancel operation restrictions.
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Printing when the User Authentication Is Specified on This Machine

When the user authentication has been specified on this machine, a user 
name and password must be entered when printing.

2
Note 

If a print job is sent using a user name or password that is not a registered 
account on this machine or if a job is sent without the “User Authentica-
tion” check box selected, the operation is not authenticated by this ma-
chine and the job is canceled.

When the user authentication settings are specified on this machine, the 
authentication operation restriction function is in mode 2, and the authen-
tication information is not entered correctly, the applicable user is locked 
and cannot be accessed.

The three printer drivers that can be set on this machine are described 
below.
Konica Minolta PCL printer driver for Windows
Konica Minolta PostScript printer driver for Windows 2000/XP/Server 
2003
PostScript PPD printer driver for Mac OS X

2
Note 

If printing is not allowed, printing cannot be performed even when used 
by a registered user.

For user authentication settings, consult the administrator of this ma-
chine.
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Specifying Settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the Print di-
alog box to display the printer driver setup dialog box.

2 Click the Setup tab.

3 Click the [User Authentication/Account Track] button.

4 Select the “User Authentication” check box, select “Recipient User”, 
and then enter the user name and password.

– If this machine has been set to permit public users, the machine can 
be used without a user name and password.

– A default password can be registered and used rather than entering 
a password for each job.

5 After specifying the settings, click the [OK] button to begin printing.

– If the entered user name is a name registered on this machine, the 
job is printed and counted as a job for the specified user.
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Specifying Settings (for Mac OS X)

1 From the “File” menu, select “Print”.

2 Select “Security”.

3 Select the “User Authentication” check box, select “Recipient User”, 
and then enter the user name and password.

– If this machine has been set to permit public users, the machine can 
be used without a user name and password.
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Printing with this machine when account track settings have been ap-

plied

When the account track settings on this machine have been specified, you 
must enter a password when printing a job.

2
Note 

If a print job is sent using a department name or password that is not a 
registered account on this machine or if a job is sent without the “Account 
Track” check box selected, the job is deleted without being authenticat-
ed by this machine.

When the account authentication settings are specified on this machine, 
the authentication operation restriction function is in mode 2, and the au-
thentication information is not entered correctly, the applicable account 
is locked and cannot be accessed.

The three printer drivers that can be set on this machine are as follows: 
Konica Minolta PCL Printer Driver for Windows
Konica Minolta PostScript Printer Driver for Windows 2000/XP/Server 
2003
Konica Minolta PostScript PPD Printer Driver for Mac OS X

2
Note 

If printing is not allowed, printing cannot be performed even when used 
by a registered account.
For the account track details, consult the administrator of this machine.
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Specifying settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the Print di-
alog box to display the Printing Preferences dialog box.

2 Click the Setup tab.

3 Click the [User Authentication/Account Track] button.

4 Select the “Account Tack” check box, and then enter the department 
name and password.

A default department name can be registered and used instead of en-
tering a department name for each job.

5 After specifying the settings, click the [OK] button to begin printing.

If the entered department name is a name registered on this machine, 
the job is printed and counted as a job for the account.
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Specifying settings (for Mac OS X)

1 From the “File” menu, select “Print”.

2 Select “Security”.

3 Select the “Account Track” check box, and then specify the depart-
ment name and password.

Job operations in PageScope Web Connection

From PageScope Web Connection, you can also check the status of jobs be-
ing performed by this machine.

For details, refer to the following pages.
- “Job tab — Current Job” on page 10-58
- “Job tab — Job History” on page 10-60
C300 10-118



Various settings 10
10.5 Printing on banner paper

Paper up to 1200 mm (47-1/4 inch) long can be loaded into the bypass tray 
and printed on using this machine with the appropriate setting specified from 
the control panel.

Loading banner paper and printing on it is referred to as “banner printing” 
throughout the manual.

Paper

Paper types

2
Note 

Feed only one sheet of paper at a time.

Printer drivers and supported operating systems

The following drivers are compatible with banner paper printing.

Paper width Paper length Paper type

210 to 297 mm 
(8-1/4 to 11-3/4 inch)

457.3 to 1200 mm 
(18 to 47-1/4 inch)

127 to 160 g/m2 (33-3/4 to 42-1/2 lb)

Page description 

language

Printer driver Supported operating systems

PCL (PCL XL) Konica Minolta 
PCL Driver

Windows NT 4.0, Windows 2000 Professional, Windows 
XP Home Edition, Windows XP Professional, and Win-
dows Server 2003

PostScript 3 Emu-
lation

Konica Minolta 
PostScript 
Driver

Windows NT 4.0, Windows 2000 Professional, Windows 
XP Home Edition, Windows XP Professional, and Win-
dows Server 2003
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Specifying printer driver settings

To specify printer driver settings

The paper sizes to be printed are preregistered as Custom Size.

1 Click the Setup tab.

2 From the “Original Size” or “Output Size” drop-down list, select “Cus-
tom Size Settings”.

The Custom Size Settings dialog box appears.

3 Specify settings for the following:

– List of Custom Sizes: Select the size for the custom size being set. 
(Konica Minolta PCL driver only)

– Custom Size Name: Input the name of the custom size being regis-
tered. (Konica Minolta PCL driver only)

– Size: Specify the width and length of the custom size according to 
the selected measurement units.

4 Click the [OK] button.

5 When printing, select the Custom Size that was registered from the 
“Original Size” and “Output Size” drop-down lists on the Setup tab.

2
Note 

For the Konica Minolta PCL driver, the custom size settings can only be 
specified from the printer driver setup dialog box, which can be displayed 
from the Printers window (for Windows XP/Server 2003,Printers and Fax-
es window).
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Printing

To print

1 Press the [Utility/Counter] key in the control panel.

2 Touch [6 Banner Printing].

3 Touch [ON], and then touch [OK].

4 Select a job to be printed from the computer, and then click “Print” on 
the “File” menu.

5 Specify the desired settings, and then click the [OK] button.

6 Open the bypass tray.

7 With the side to be printed on facing down, insert the paper as much 
as possible into the feed slot.

– Before loading the paper, check that the following message ap-
pears in the control panel.
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8 Slide the lateral guides to fit the size of paper being loaded.

– Load one sheet at a time.
– Print while supporting the loaded paper with your hands.

9 If the following screen appears, touch [Complete].
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10 When printing is finished, touch [Finish].

– To continue printing, repeat steps 7 through 9.

11 Touch [Yes].
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11 Troubleshooting

11.1 Unable to Print

This chapter explains the troubleshooting procedures for possible malfunc-
tions.

Perform the troubleshooting procedures described below if this machine 
does not print after you have sent a print job.

Symptom Probable cause Action

The message “No 
printers are connect-
ed.” or “Print error” 
appears.

The printer driver selected for 
printing is not compatible with the 
printer controller.

Check the printer name selected.

The network cable, parallel cable, 
or USB cable is disconnected.

Check that the cable is connected 
properly.

An error has occurred in this ma-
chine.

Check this machine’s control 
panel.

Available memory space is not 
sufficient.

Perform a test print to check 
whether printing is possible.

The network cable, parallel cable, 
or USB cable is disconnected.

Check that the cable is connected 
properly.

An error has occurred in this ma-
chine.

Check this machine’s control 
panel.

A postscript error ap-
pears.

Available computer memory 
space is not sufficient.

Perform a test print to check 
whether printing is possible.

There is an error in the application 
software settings.

Refer to the user’s manual of the 
application software to check the 
settings.

The file printing settings are incor-
rect.

Change the settings and try to 
print again.
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If the problem persists after all of these procedures have been performed, 
read the User’s Guide [Copy Operations].

The machine does not 
start printing although 
the print job was com-
pleted on the compu-
ter.

The printer driver selected for 
printing is not compatible with the 
printer controller.

Check the printer name selected.

The network cable, parallel cable, 
or USB cable is disconnected.

Check that the cable is connected 
properly.

An error has occurred in this ma-
chine.

Check this machine’s control 
panel.

A print job is queued in this ma-
chine, delaying printing.

Check the job order on the Active 
Jobs list of the machine’s control 
panel.

“Save in User Box” was selected 
for the print job.

Check if the print job is stored on 
the Box screen of this machine’s 
control panel.

“Secure Print” was selected for 
the print job.

Check if the print job is held on the 
Secure Print User Box screen of 
this machine’s control panel.

If the account track settings have 
been applied, an unregistered de-
partment name (or password) 
may have been entered.

Enter the correct department 
name (or password).

If the authentication settings have 
been applied, an unregistered 
user name (or password) may 
have been entered.

Enter the correct user name (or 
password).

Available computer memory 
space is not sufficient.

Perform a test print to check 
whether printing is possible.

The connection of this machine to 
the network is not yet established 
(while connecting to a network).

Consult with the network adminis-
trator.

The enhanced security mode may 
be enabled on this machine.

Specify the authentication set-
tings in the enhanced security 
mode. For details, consult with 
the network administrator.

Symptom Probable cause Action
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11.2 Unable to specify desired settings or unable to print 
as specified

Perform these troubleshooting procedures if you cannot specify the desired 
settings in the printer driver, or if the print results do not represent the set-
tings that have been specified.

2
Note 

Some of the printer driver functions cannot be combined with other func-
tions.

Symptom Probable cause Action

A printer driver setting 
cannot be selected.

Some functions cannot be com-
bined.

Do not try to select settings that 
are not available.

The “Conflicts” mes-
sage with “Unable to 
Select” or “Function 
Canceled” appears.

An incorrect combination of func-
tions has been specified.

Check the settings and specify 
the functions correctly.

Printing is not per-
formed as specified.

Incorrect settings are specified. Check each setting in the printer 
driver.

A combination of functions, al-
though possible in the printer driv-
er, is not possible with this 
machine.

The paper size, orientation, and 
other settings specified in the ap-
plication have priority over those 
specified in the printer driver.

Enter the correct settings in the 
application.

The watermark cannot 
be printed.

The watermark is not correctly 
set.

Check the watermark settings.

The watermark density is set to a 
level that is too low.

Check the density settings.

Watermarks cannot be printed in 
graphics applications.

No watermark can be printed in 
this case.

The staple function 
cannot be specified.

Stapling is not possible if “Paper 
Type” is set to “Thick” or “Trans-
parency”.

Check each setting in the printer 
driver.

The staple function requires op-
tional finisher.

Install the required optional finish-
er and enable it using the printer 
driver.

Stapling cannot be 
performed.

If are a large number of pages to 
be printed, stapling cannot be 
performed. 

Change the number of pages to 
be printed.

Stapling is not possible if the doc-
ument contains pages of different 
sizes.

Check the document.
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The stapling position 
is not as expected.

The orientation setting is not cor-
rect.

Check the stapling position in the 
printer driver setup dialog box.

The hole punch func-
tion cannot be speci-
fied.

Hole punching cannot be speci-
fied if “Booklet”, “Transparency”, 
“Thick2”, “Thick3”, or “Envelope” 
is selected.

Check each setting in the printer 
driver.

Optional finishers FS-514 and 
punch kit PK-510 are required.

Install the required optional finish-
er and enable it using the printer 
driver.

The pages are not 
punched.

Printed pages may be fed out 
without being punched if the pa-
per is loaded into the paper 
source with an incorrect orienta-
tion.

Check the orientation setting.

The hole punch posi-
tion is not as expect-
ed.

The orientation setting is not cor-
rect.

Check the punch position on the 
Layout tab of the printer driver 
setup dialog box.

The form is not printed 
properly.

Available computer memory 
space is not sufficient.

Simplify the form to reduce the 
data size.

The image is not print-
ed properly.

Available computer memory 
space is not sufficient.

Simplify the image to reduce the 
data size.

Paper is not fed from 
the specified paper 
source.

Paper will not be fed from the 
specified paper source if that pa-
per source is loaded with paper of 
a different size or orientation.

Load the paper source with paper 
of the appropriate size and orien-
tation.

The access number 
cannot be specified.

To specify access numbers, a 
hard disk must be added in the 
Option tab of the printer driver.

Add a hard disk in the Option tab 
of the printer driver.

Symptom Probable cause Action
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11.3 Error message

Message Cause and remedy

Cannot connect to the 
network.

A connection to the network could not be established.
Check if the network cable is correctly connected. In addition, check 
that the Network Setting parameters on the Administrator Setting 
screen have been correctly specified.
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12 Appendix 

12.1 Specifications

Item Specifications

Model Built-in printer controller

Power supply Common with the main body

CPU PPC750 FX 600 MHz

RAM 512 MB

Hard disk 40 GB

Interface Standard: Ethernet (10Base-T or 100Base-TX) 
Optional: USB 1.1, USB 2.0, or IEEE 1284

Frame type Ethernet 802.2
Ethernet 802.3
Ethernet II
Ethernet SNAP

Supported protocols TCP/IP
IPX/SPX
NetBEUI
AppleTalk (EtherTalk)

Print speed 30 pages/minute (color/monochrome, 8-1/2 × 11 v paper, 
and simplex) 
30 pages/minute (color/monochrome, 8-1/2 × 11 v paper, 
and duplex)

Fast print time 8.5 seconds or less (color and A4 paper) 
6.5 seconds or less (monochrome and A4 paper)

Printer language PCL5e/c Emulation 
PCL6 (XL 2.1) Emulation 
PostScript 3 Emulation (3011)

Operating environment condi-
tions

Temperature 10 to 30°C
Humidity 15—85% RH

Resolution Data processing 600 × 600 dpi (printing and fax operations) 
400 × 400 dpi (fax operations) 
200 × 200 dpi (fax operations)

Printing 600 × 1800 dpi (equivalent)

Supported paper sizes Maximum Standard Size

Printer fonts PCL Latin 80 Fonts
Postscript 3 Emulation Latin 136 Fonts

Compatible computers IBM PC or compatible, and Macintosh (PowerPC or Intel 
Processor)
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Supported 
operating 
systems

Server Windows NT 4.0 (SP6a), Windows 2000 Server, or Win-
dows Server 2003

Client Windows 98 Second Edition, Windows Me, Windows 2000, 
Windows XP, or Windows NT 4.0 (SP6a) 
MacOS 9.2 or later or MacOS X 10.2, 10.3 or 10.4

Printer driver PCL6:
• Windows 98 Second Edition or Windows Me Printer 

Driver
• Windows 2000, Windows XP, or Windows Server 2003 

Printer Driver 
• Windows NT 4.0 Printer Driver
PS3: 
• Windows 98 Second Edition or Windows Me PPD File 
• Windows NT 4.0 Printer Driver
• Windows 2000, Windows XP (Home/Professional), Win-

dows Server 2003 Printer Driver
• Windows XP Professional x64, Windows Server 2003 

x64 Printer Driver
• MacOS 9.2 PPD File
• MacOS X 10.2 Printer Driver
• MacOS X 10.3 or MacOS X 10.4 Printer Driver

Utility PageScope Web Connection 
Web browsers:
Microsoft Internet Explorer 6 or later recommended (Java-
Script enabled, Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when 
using Internet Explorer 5.5.
Netscape Navigator 7.02 or later (JavaScript enabled, 
Cookies enabled)
Macromedia® Flash® (If “Flash” is selected in View Mode, 
version 7.0 or later plugin is required.)

Item Specifications
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12.2 Configuration page
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12.3 Font list

PCL font list
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PS font list
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Demo page
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12.4 Glossary

Term Definition

10Base-T/100Base-TX/
1000Base-T

An Ethernet standard, which is a cable consisting of twisted copper 
wire pairs. The transmission speed of 10Base-T is 10 Mbps, of 
100Base-TX is 100 Mbps, and of 1000Base-T is 1000 Mbps.

AppleTalk A generic name for the protocol suite developed by Apple Computer 
for computer networking.

bit Abbreviation for Binary Digit. The smallest unit of information (data 
quantity) on a computer or printer. Displays data using 0 or 1.

BMP Abbreviation for Bitmap. A file format for saving image data which 
uses the .bmp extension. Commonly used on Windows platforms. 
You can specify the color depth from monochrome (2 values) to full 
color (16,777,216 colors). Images are not usually compressed when 
saved.

Bonjour Macintosh network technology for automatically detecting devices 
connected to the network and for specifying settings. Previously 
called “Rendezvous”, the name was changed to “Bonjour” starting 
with Mac OS X v10.4.

BOOTP Abbreviation for Bootstrap Protocol. A protocol in which a client 
computer on a TCP/IP network automatically specifies the network 
settings from the server. Currently, DHCP, which is an advanced 
protocol based on BOOTP, is mainly used.

Byte Unit of information (data quantity) on a computer or printer. Config-
ured as 1 byte equals 8 bits.

CMYK Abbreviation for Cyan, Magenta, Yellow, and Black. The colors in the 
toner and ink used for color printing can all be represented by 
changing the mixing ratio of the four colors of CMYK.

Default gateway A device, such as a computer or router, used as a “gateway” to ac-
cess computers not on the same LAN.

DHCP Abbreviation for Dynamic Host Configuration Protocol. A protocol in 
which a client computer on a TCP/IP network automatically specifies 
the network settings from the server. With collective management of 
the IP address for DHCP clients on the DHCP server, you can avoid 
duplication of an address and you can build a network easily.

DNS Abbreviation for Domain Name System. A system that acquires the 
supported IP addresses from host names in a network environment. 
DNS allows the user to access other computers over a network by 
specifying host names, instead of difficult to memorize and under-
stand IP addresses.

DPI (dpi) Abbreviation for Dots Per Inch. A resolution unit used by printers and 
scanners. Indicates how many dots per inch are represented in an 
image. The higher the value, the higher the resolution.

FTP Abbreviation for File Transfer Protocol. A protocol for transferring 
files over the Internet or an intranet on the TCP/IP network.

HTTP Abbreviation for HyperText Transfer Protocol. A protocol used to 
send and receive data between a Web server and a client (Web 
browser). Documents containing images, recordings, and video clips 
can be exchanged with the expressive form information.
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IEEE 1284 Abbreviation for Institute of Electrical and Electronic Engineers 1284. 
A parallel port standard that was developed for printers.

IPP Abbreviation for Internet Printing Protocol. A protocol that sends and 
receives print data and controls printers over the Internet on a TCP/
IP network. Data can also be sent to printers in remote areas to print 
over the Internet.

IPX A protocol used with NetWare and works at the network layer of the 
OSI reference model

IPX/SPX Abbreviation for Internetwork Packet Exchange/Sequenced Packet 
Exchange. A protocol developed by Novel, Inc. that is commonly 
used under a NetWare environment.

IP address A code (address) that is used to identify individual network devices 
over the Internet. A maximum of three digits for four numbers are 
displayed such as 192.168.1.10. IP addresses are assigned to devic-
es, including computers, which are connected to the Internet.

LAN Abbreviation for Local Area Network. A network which connects 
computers on the same floor, in the same building, or in neighboring 
buildings.

LPD Abbreviation for Line Printer Daemon. A printer protocol that uses 
TCP/IP and is platform-independent. Originally developed for BSD 
UNIX, it has become the standard printing protocol and can be used 
with any general computer.

LPR/LPD Abbreviation for Line Printer Request/Line Printer Daemon. A print-
ing method over a network in a Windows NT system or UNIX system. 
Using TCP/IP, you can output print data from Windows or Unix to a 
printer over a network.

MAC address Abbreviation for Media Access Control address. With a special ID 
number for each Ethernet card, data can be sent and received be-
tween the cards. A number consists of 48 bits. The first 24 bits con-
sist of a special number for each manufacture controlling and 
assigning IEEE. The last 24 bits consist of a number that the manu-
facturer assigns uniquely to the card.

Macromedia® Flash® Software developed by Macromedia, Inc. and used to create data 
combining vector-graphic animation and sound, and the format of 
this data file. The bidirectional content can be manipulated using a 
keyboard and a mouse. The files can be kept relatively compact, and 
they can be accessed with the Web browser plug-in.

NDPS Abbreviation for Novell Distributed Print Services. Provides a highly 
efficient printing solution in an NDS environment. By using the NDPS 
as a printer server, you can output from the desired printer, automat-
ically download the printer driver of a newly installed printer, simplify 
and automate complicated management environments related to 
printer use, and integrate management related to the network print-
er.

NDS Abbreviation for Novell Directory Services. The servers and printers 
on a network and the shared resources of the user’s information, as 
well as the user’s access authority over these items can be consoli-
dated in the hierarchy structure.

NetBIOS Abbreviation for Network Basic Input Output System. A communica-
tion interface developed by IBM.

Term Definition
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NetBEUI Abbreviation for NetBIOS Extended User Interface. A network proto-
col developed by IBM. By simply specifying the computer name, you 
can build a small-scale network.

NetWare Network operating system developed by Novell. NetWare IPX/SPX 
is used as the communication protocol.

Nprinter/Rprinter Remote printer support module for using a printer server under a 
NetWare environment. Use NetWare 3.x with Rprinter, and NetWare 
4.x with Nprinter.

OHP/OHT OHP (overhead projector) transparencies which are used for presen-
tations.

OS Abbreviation for Operating System. Basic software for controlling 
the system of a computer.

PDF Abbreviation for Portable Document Format. An electronically for-
matted document which uses the .pdf extension. Based on the Post-
Script format, you can use the free Adobe Acrobat Reader software 
to view documents.

PDL Abbreviation for Page Description Language. The language for spec-
ifying the print image per page to a printer when printing using a 
page printer.

PostScript A typical page-descriptive language developed by Adobe and is 
commonly used for high quality printing.

PPD Abbreviation for PostScript Printer Description. A file used to de-
scribe the resolution, usable paper size, and the PostScript printer 
model special information.

Proxy server A server that is installed to act as an intermediary connection be-
tween each client and different servers to effectively ensure security 
over the entire system for Internet connections.

Pserver Print server module under a NetWare environment that monitors, 
changes, pauses, restarts, or cancels a print job.

Queue name Name specified to each device that allows printing when network 
printing.

RIP Abbreviation for Raster Image Processor. Process that develops pic-
ture images from described text data using the PostScript page de-
scription language. The processor is usually integrated in the printer.

RGB Abbreviation for Red, Green, and Blue. Represents all colors by 
changing the brightness ratio of the RGB 3 colors using the primary 
colors used by the color representation in a monitor.

Samba UNIX server software that uses SMB (Server Message Block) so that 
UNIX system resources can be used from a Windows environment.

SLP Abbreviation for Service Location Protocol. A protocol capable of 
finding services over a TCP/IP network and automatically specifying 
a client.

SMB Abbreviation for Server Message Block. A protocol that shares files 
and printers over a network and which is mainly used by Microsoft 
Windows.

SMTP Abbreviation for Simple Mail Transfer Protocol. A protocol for send-
ing and forwarding e-mail.

Term Definition
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SNMP Abbreviation for Simple Network Management Protocol. A manage-
ment protocol in a network environment using TCP/IP.

TCP/IP Abbreviation for Transmission Control Protocol/Internet Protocol. 
The de facto standard protocol used by the Internet that uses IP ad-
dresses to identify each network device.

TrueType An outline font that was developed by Apple Computer and Micro-
soft. It is used as a standard by Macintosh and Microsoft Windows 
and can be used both on a display and in print.

USB Abbreviation for Universal Serial Bus. A general interface standard 
for connecting a mouse, printer, and other devices to a computer.

Outline font A font using lines and curves to display an outline of a character. 
Large-size characters can be displayed on a screen or printed with 
no jagged edges.

Uninstall To delete software installed on a computer

WINS Abbreviation for Windows Internet Naming Service. A service for re-
calling named servers for the conversion of computer names and IP 
address in a Windows environment.

Ethernet LAN transmission line standard

Print Job Print request transmitted from a computer to a printing device.

Install To install hardware, operating systems, applications, printer drivers 
on to a computer

Web browser Software such as Internet Explorer and Netscape Navigator for view-
ing Web pages.

Resolution Displays the ability to reproduce the details of images and print mat-
ter correctly.

Color matching Technology for decreasing the difference in color among different 
devices such as scanners, displays, and printers.

Brightness Brightness of a display screen

Queue name Required logical printer name for LPD/LPR printing

Shared printer A printer setup that allows the printer to be used by multiple comput-
ers connected to a server over a network.

Client A computer that uses the services provided by a server through a 
network.

Grayscale Monochrome image expressive form using the gradation information 
from black to white

Gateway Hardware and software used as the point where a network is con-
nected to a network. A gateway also changes data formats, ad-
dresses, and protocols according to the connected network.

Subnet mask The unit used to divide a TCP/IP network into small networks (sub-
networks). It is used to identify the bits in a network address that are 
higher than the IP address.

Screen font A font for displaying text and symbols on a CRT monitor.

Spool Abbreviation for Simultaneous Peripheral Operation On-Line. For 
printer output, data is not sent directly to the printer, it is temporarily 
stored in another location, then sent to the printer collectively.

Term Definition
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Driver Software that works as a bridge between a computer and a periph-
eral device.

Hard disk Large capacity storage device for storing data. The data can be 
stored even if the power is turned off.

Parallel interface Data transmission method for sending and receiving data of multiple 
signals simultaneously. IEEE 1284 is commonly used as the printer 
connection.

Peer-to-peer A network format that allows connected devices to communicate 
without using a dedicated server.

Plug-and-play Ability to automatically find and use the appropriate driver when a 
peripheral device is connected to a computer.

Printer buffer Memory domain temporarily used for data processing of a print job

Print queue A software system which queues the generated print job in the de-
vices.

Frame type Type of communication format used in a NetWare environment.
Communication is not possible if the same frame type is not used.

Preview A function that allows you to view an image before processing a print 
or scan job.

Protocol The rules that allow computers to communicate with other comput-
ers or peripheral devices

Property Attribute information
When using a printer driver, various functions can be specified in the 
file properties.
In the file properties, you can check the attribute information of the 
file.

Profile Color attribute file
The dedicated file that contains the summarized correlation of the in-
put and output of each primary color used so that the color input and 
output devices can reproduce the color.

Host name Displayed name of a device over a network.

Memory Storage device for storing data temporally. When the power is 
turned off the data may or may not be erased.

Local printer A printer connected to a parallel or USB port of a computer.

Term Definition
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